IMPORTANT:
Read this manual carefully before using your printer.
Save this manual for future reference.
LBP2900/2900i
Laser Printer
User's Guide
Manuals for the Printer

The instruction manuals for this product are arranged as follows. Read the sections that are appropriate for your goals, to let you fully utilize this product.

Guides marked with this symbol are PDF manuals included on the accompanying CD-ROM.

• Installation
• Connecting to a Computer
• Printing Methods

Getting Started Guide

• Basic Operations
• Troubleshooting

User's Guide (This Manual)

To view the manual in PDF format, Adobe Reader/Adobe Acrobat Reader is required. If Adobe Reader/Adobe Acrobat Reader is not installed on your system, please download it from the Adobe Systems Incorporated website.

* The printer illustration on the cover of this manual may differ slightly from your printer.
## How This Manual Is Organized

<table>
<thead>
<tr>
<th>Chapter 1</th>
<th>Before You Start Using This Printer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 2</td>
<td>Loading and Delivering Paper</td>
</tr>
<tr>
<td>Chapter 3</td>
<td>Setting Up the Printing Environment</td>
</tr>
<tr>
<td>Chapter 4</td>
<td>Printing a Document</td>
</tr>
<tr>
<td>Chapter 5</td>
<td>Routine Maintenance</td>
</tr>
<tr>
<td>Chapter 6</td>
<td>Troubleshooting</td>
</tr>
<tr>
<td>Chapter 7</td>
<td>Appendix</td>
</tr>
</tbody>
</table>

Considerable effort has been made to ensure that this manual is free of inaccuracies and omissions. However, as we are constantly improving our products, if you need an exact specification, please contact Canon.
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>vii</td>
</tr>
<tr>
<td>How To Use This Manual</td>
<td>vii</td>
</tr>
<tr>
<td>Conventions</td>
<td>vii</td>
</tr>
<tr>
<td>Notation for Keys and Buttons</td>
<td>viii</td>
</tr>
<tr>
<td>Screen Sheets</td>
<td>viii</td>
</tr>
<tr>
<td>Abbreviations</td>
<td>viii</td>
</tr>
<tr>
<td>Legal Notices</td>
<td>ix</td>
</tr>
<tr>
<td>Model Name</td>
<td>ix</td>
</tr>
<tr>
<td>EMC Directive (220 - 240 V model)</td>
<td>ix</td>
</tr>
<tr>
<td>Laser Safety (220 - 240 V model)</td>
<td>x</td>
</tr>
<tr>
<td>International Energy Star-Program</td>
<td>xi</td>
</tr>
<tr>
<td>WEEE Directive</td>
<td>xi</td>
</tr>
<tr>
<td>Trademarks</td>
<td>xii</td>
</tr>
<tr>
<td>Copyright</td>
<td>xii</td>
</tr>
<tr>
<td>Disclaimers</td>
<td>xii</td>
</tr>
<tr>
<td>Legal Limitations on the Usage of Your Product and the Use of Images</td>
<td>xiii</td>
</tr>
<tr>
<td>Important Safety Instructions</td>
<td>xiv</td>
</tr>
<tr>
<td>Installation</td>
<td>xv</td>
</tr>
<tr>
<td>Power Supply</td>
<td>xv</td>
</tr>
<tr>
<td>Handling</td>
<td>xvi</td>
</tr>
<tr>
<td>Maintenance and Inspections</td>
<td>xviii</td>
</tr>
<tr>
<td>Consumables</td>
<td>xix</td>
</tr>
<tr>
<td>Other</td>
<td>xix</td>
</tr>
</tbody>
</table>

## Chapter 1  Before You Start Using This Printer

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer Features</td>
<td>1-2</td>
</tr>
<tr>
<td>Component Names and Functions</td>
<td>1-4</td>
</tr>
<tr>
<td>Front View</td>
<td>1-5</td>
</tr>
<tr>
<td>Rear View</td>
<td>1-6</td>
</tr>
<tr>
<td>Inside the Printer</td>
<td>1-7</td>
</tr>
<tr>
<td>Indicators and the Paper Key</td>
<td>1-8</td>
</tr>
<tr>
<td>Connecting the Power Cord</td>
<td>1-9</td>
</tr>
<tr>
<td>Connecting to a Computer</td>
<td>1-12</td>
</tr>
<tr>
<td>Turning the Printer On and Off</td>
<td>1-15</td>
</tr>
<tr>
<td>Turning the Printer On</td>
<td>1-15</td>
</tr>
<tr>
<td>Turning the Printer Off</td>
<td>1-16</td>
</tr>
</tbody>
</table>
### Chapter 2  Loading and Delivering Paper

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Requirements</td>
<td>2-2</td>
</tr>
<tr>
<td>Usable Paper</td>
<td>2-2</td>
</tr>
<tr>
<td>Paper Sizes</td>
<td>2-2</td>
</tr>
<tr>
<td>Paper Types</td>
<td>2-3</td>
</tr>
<tr>
<td>Abbreviations of Paper Sizes</td>
<td>2-5</td>
</tr>
<tr>
<td>Printable Area</td>
<td>2-5</td>
</tr>
<tr>
<td>Paper You Cannot Use</td>
<td>2-6</td>
</tr>
<tr>
<td>Storing Blank Paper</td>
<td>2-7</td>
</tr>
<tr>
<td>Storing Printed Paper</td>
<td>2-8</td>
</tr>
<tr>
<td>Paper Sources</td>
<td>2-9</td>
</tr>
<tr>
<td>Paper Source Types</td>
<td>2-9</td>
</tr>
<tr>
<td>Paper Source Capacities</td>
<td>2-10</td>
</tr>
<tr>
<td>Paper Output</td>
<td>2-11</td>
</tr>
<tr>
<td>Output Tray Types</td>
<td>2-11</td>
</tr>
<tr>
<td>Output Tray Capacities</td>
<td>2-12</td>
</tr>
<tr>
<td>Printing on Plain Paper, Heavy Paper, Label Paper, and Transparencies</td>
<td>2-13</td>
</tr>
<tr>
<td>Loading the Paper</td>
<td>2-13</td>
</tr>
<tr>
<td>Loading Paper into the Multi-Purpose Tray</td>
<td>2-14</td>
</tr>
<tr>
<td>Loading Paper into the Manual Feed Tray</td>
<td>2-19</td>
</tr>
<tr>
<td>Selecting Printer Driver Settings and Printing</td>
<td>2-22</td>
</tr>
<tr>
<td>Printing on Index Card</td>
<td>2-26</td>
</tr>
<tr>
<td>Loading Index Cards</td>
<td>2-26</td>
</tr>
<tr>
<td>Loading Index Card into the Manual Feed Tray</td>
<td>2-26</td>
</tr>
<tr>
<td>Selecting Printer Driver Settings and Printing</td>
<td>2-29</td>
</tr>
<tr>
<td>Printing on Envelopes</td>
<td>2-33</td>
</tr>
<tr>
<td>Loading Envelopes</td>
<td>2-33</td>
</tr>
<tr>
<td>Loading Envelopes into the Multi-Purpose Tray</td>
<td>2-34</td>
</tr>
<tr>
<td>Loading Envelopes into the Manual Feed Tray</td>
<td>2-37</td>
</tr>
<tr>
<td>Selecting Printer Driver Settings and Printing</td>
<td>2-40</td>
</tr>
<tr>
<td>Printing on Custom Paper Sizes (Non-Standard Sizes)</td>
<td>2-44</td>
</tr>
<tr>
<td>Loading Custom Paper Sizes</td>
<td>2-44</td>
</tr>
<tr>
<td>Loading Custom Paper into the Multi-Purpose Tray</td>
<td>2-44</td>
</tr>
<tr>
<td>Loading Custom Paper into the Manual Feed Tray</td>
<td>2-50</td>
</tr>
<tr>
<td>Selecting Printer Driver Settings and Printing</td>
<td>2-53</td>
</tr>
</tbody>
</table>

### Chapter 3  Setting Up the Printing Environment

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>3-2</td>
</tr>
<tr>
<td>After Installing the Printer</td>
<td>3-2</td>
</tr>
<tr>
<td>Each Time You Print</td>
<td>3-2</td>
</tr>
<tr>
<td>System Requirements</td>
<td>3-3</td>
</tr>
<tr>
<td>Installing the CAPT Software</td>
<td>3-4</td>
</tr>
<tr>
<td>For Windows 98/Me</td>
<td>3-4</td>
</tr>
</tbody>
</table>
Installing from CD-ROM Setup ........................................... 3-4
Installing with Plug and Play. .......................................... 3-10
For Windows 2000 .......................................................... 3-19
Installing from CD-ROM Setup .......................................... 3-19
Installing with Plug and Play ............................................ 3-25
For Windows XP/Server 2003 ............................................ 3-31
Installing from CD-ROM Setup .......................................... 3-31
Installing with Plug and Play ............................................ 3-37

Chapter 4 Printing a Document

Printing from an Application ............................................. 4-2
Specifying Printing Preferences ......................................... 4-7
  For Windows 98/Me ..................................................... 4-7
    Opening the [Document Properties] Dialog Box from
    an Application ....................................................... 4-7
    Opening the [Printer Properties] Dialog Box from
    the [Printers] Folder ................................................ 4-9
  For Windows 2000/XP/Server 2003 ................................ 4-10
    Opening the [Document Properties] Dialog Box from
    an Application ....................................................... 4-11
    Opening the [Document Properties] Dialog Box from
    the [Printers and Faxes] or [Printers] Folder ................... 4-13
    Opening the [Printer Properties] Dialog Box from
    the [Printers and Faxes] or [Printers] Folder ................... 4-15

Canceling, Pausing and Resuming Printing .......................... 4-17

Using the Printing Functions ............................................ 4-19
  Tab Sheets in the Printer Driver ..................................... 4-19
    [Page Setup] Sheet ............................................... 4-20
    [Finishing] Sheet ................................................. 4-23
    [Paper Source] Sheet ............................................. 4-24
    [Quality] Sheet .................................................... 4-25
    [General] Sheet .................................................... 4-27
    [Details] Sheet (Windows 98/Me only) ............................ 4-27
Introduction

Thank you for purchasing the Canon LBP2900/2900i. In order to fully understand the features of this product and thus be able to use it more effectively, please be sure to fully read this instruction manual before using the product. Store this manual in a safe place after reading it.

How To Use This Manual

Conventions

The following symbols are used in this manual to explain procedures, restrictions, handling precautions, and instructions that should be observed for safety.

⚠️ WARNING Indicates warnings that, if followed incorrectly, may lead to death or serious personal injury. To use the product safely, be sure to adhere to these warnings.

⚠️ CAUTION Indicates cautions that, if followed incorrectly, may lead to personal injuries or damage to property. To use the product safely, be sure to adhere to these cautions.

🛠️ IMPORTANT Indicates important points and limitations that need to be observed. Be sure to read these carefully to avoid running into problems operating the printer.

📝 NOTE Indicates additional information related to the operation of the printer. It is recommended that you read these points.

Notation for Keys and Buttons

In this manual, the following notation is used for key and button names.

- Control panel keys: <Key icon> + (Key Name)
  Examples: ☐ (Paper Key)
- Button appearing on the computer screen: [Button Name]
  Examples: [OK] [Details]
Screen Sheets

The screen shots shown in this manual may differ slightly from the screens on your computer depending on your operating system.

The locations of buttons that you need to press during a procedure are circled with a circle as shown below.

When there is a choice of buttons that can be pressed during a procedure, all of the buttons are circled. Select the button that suits your needs.

5 Click [Install].

Abbreviations

In this manual, product names and model names are abbreviated as follows:

Microsoft® Windows® 95 operating system: Windows 95
Microsoft® Windows® 98 operating system: Windows 98
Microsoft® Windows® Millennium Edition operating system: Windows Me
Microsoft® Windows® 2000 operating system: Windows 2000
Microsoft® Windows® XP operating system: Windows XP
Microsoft® Windows® operating system: Windows
Legal Notices

Model Name

The following names may be provided for the safety regulations in each sales region of this Laser Beam Printer.

220 - 240 V model: L11121E

EMC Directive (220 - 240 V model)

"This equipment has been tested in a typical system to comply with the technical requirements of EMC Directive."

• Use of shielded cable is necessary to comply with the technical requirements of EMC Directive.

The product is in conformity with the EMC directive at nominal mains input 230 V, 50 Hz although the rated input of the product is 220 - 240 V, 50/60 Hz.

C-tick marking on the rating label means that we declare the product is in conformity with the relevant requirements at nominal mains input 230 V, 50 Hz although the rated input of the product is 220 - 240 V, 50/60 Hz.
Laser Radiation could be hazardous to the human body. For this reason, laser radiation emitted inside this printer is hermetically sealed within the protective housing and external cover. No radiation can leak from the printer in the normal operation of the product by the user.

This printer is classified as a Class 1 laser product under IEC60825-1:1993, EN60825-1:1994, and as for the U.S.A., it is classified as Class 1 under the Code of Federal Regulations, 1040.10 of Title 21.

This printer has been classified under IEC60825-1:1993, EN60825-1:1994 and conforms to the following classes:

CLASS 1 LASER PRODUCT
LASER KLASSE 1
APPAREIL A RAYONNEMENT LASER DE CLASSE 1
APPARECCHIO LASER DI CLASSE 1
PRODUCTO LASER DE CLASE 1
APARELHO A LASER DE CLASSE 1

⚠️ CAUTION

Performance of procedures other than those specified in this manual may result in hazardous radiation exposure.
As an ENERGY STAR Partner, Canon Inc. has determined that this product meets the ENERGY STAR Program for energy efficiency.

The International ENERGY STAR Office Equipment Program is an international program that promotes energy saving through the use of computers and other office equipment.

The program backs the development and dissemination of products with functions that effectively reduce energy consumption. It is an open system in which business proprietors can participate voluntarily.

The targeted products are office equipment, such as computers, displays, printers, facsimiles, and copiers. The standards and logos are uniform among participating nations.

European Union (and EEA) only.

This symbol indicates that this product is not to be disposed of with your household waste, according to the WEEE Directive (2002/96/EC) and your national law. This product should be handed over to a designated collection point, e.g., on an authorized one-for-one basis when you buy a new similar product or to an authorized collection site for recycling waste electrical and electronic equipment (EEE). Improper handling of this type of waste could have a possible negative impact on the environment and human health due to potentially hazardous substances that are generally associated with EEE. At the same time, your cooperation in the correct disposal of this product will contribute to the effective usage of natural resources. For more information about where you can drop off your waste equipment for recycling, please contact your local city office, waste authority, approved WEEE scheme or your household waste disposal service. For more information regarding return and recycling of WEEE products, please visit www.canon-europe.com/environment.

(EEA: Norway, Iceland and Liechtenstein)
Trademarks

Canon, the Canon Logo, and LBP are trademarks of Canon Inc.

Adobe® Acrobat is a trademark of Adobe Systems Incorporated.

Microsoft and Windows are trademarks of Microsoft Corporation in the U.S. and other countries.

Other product and company names herein may be the trademarks of their respective owners.

Copyright

Copyright 2005 by Canon Inc. All rights reserved.

No part of this publication may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying and recording, or by any information storage or retrieval system without the prior written permission of Canon Inc.

Disclaimers

The information in this manual is subject to change without notice.

CANON INC. MAKES NO WARRANTY OF ANY KIND WITH REGARD TO THIS MATERIAL, EITHER EXPRESS OR IMPLIED, EXCEPT AS PROVIDED HEREIN, INCLUDING WITHOUT LIMITATION, THEREOF, WARRANTIES AS TO MARKETABILITY, MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OF USE OR AGAINST INFRINGEMENT OF ANY PATENT. CANON INC. SHALL NOT BE LIABLE FOR ANY DIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY NATURE, OR LOSSES OR EXPENSES RESULTING FROM THE USE OF THIS MATERIAL.
Legal Limitations on the Usage of Your Product and the Use of Images

Using your product to scan, print or otherwise reproduce certain documents, and the use of such images as scanned, printed or otherwise reproduced by your product, may be prohibited by law and may result in criminal and/or civil liability. A non-exhaustive list of these documents is set forth below. This list is intended to be a guide only. If you are uncertain about the legality of using your product to scan, print or otherwise reproduce any particular document, and/or of the use of the images scanned, printed or otherwise reproduced, you should consult in advance with your legal advisor for guidance.

- Paper Money
- Money Orders
- Certificates of Deposit
- Postage Stamps (canceled or uncanceled)
- Identifying Badges or Insignias
- Selective Service or Draft Papers
- Checks or Drafts Issued by Governmental Agencies
- Motor Vehicle Licenses and Certificates of Title
- Travelers Checks
- Food Stamps
- Passports
- Immigration Papers
- Internal Revenue Stamps (canceled or uncanceled)
- Bonds or Other Certificates of Indebtedness
- Stock Certificates
- Copyrighted Works/Works of Art without Permission of Copyright Owner
Important Safety Instructions

Before using this product, make sure you read this section (Important Safety Instructions) thoroughly, and that you use the product correctly. The purpose of the warnings and cautions contained in this section is to prevent injuries to the user and other people, and to prevent damage to property. Make sure you adhere to these warnings and cautions. Do not perform any actions that are not explicitly written in this manual.

Installation

**WARNING**

• Do not install the printer in a location near alcohol, thinners, or other flammable substances. If an inflammable substance comes into contact with the electrical unit inside the printer it may ignite or cause an electrical shock.

• Do not put any of the following types of objects on top of this printer. If any of these items come into contact with the electrical unit inside the printer it may ignite or cause an electrical shock. If any of these objects fall into the printer, turn the printer and computer off immediately ①, and disconnect the USB cable if it is connected ②. After this, pull out the power plug ③, and contact the store where you purchased the printer.
  - Necklaces and other metal objects
  - Cups, vases, flowerpots, and other containers filled with water or liquids
CAUTION

• Do not install the printer on an unsteady platform, an uneven surface, or any other unstable location, or any location subject to vibrations. If the printer falls down or the platform tips over, someone may be injured.

• Do not install this printer in a location where a wall or other object will block the ventilation slots in the printer. Do not install the printer on a bed, sofa, thick carpet, etc. If the ventilations slots are blocked, the internal printer components will overheat, and this may cause a fire.

• Do not install the printer in any of the following locations. Doing so may cause fire or electrical shock.
  - A damp or dusty location
  - A location exposed to smoke and steam, such as next to a stove or humidifier.
  - A location exposed to rain or snow
  - A location near water faucets or water
  - A location exposed to direct sunlight
  - A location subject to high temperatures
  - A location near open flames

• When you are installing the printer, work slowly and carefully to avoid pinching your hands between the printer and the floor, or between the printer and another product. You may be injured if your hands, etc. are pinched by the printer.

• When connecting the USB cable, connect the cable correctly by following the directions in this manual. Failure to properly connect cables can damage the printer or cause electrical shocks.

• When you are carrying the printer, hold the printer correctly by following the directions in this manual. Dropping the printer may lead to personal injuries. (See "Moving the Printer," on p. 5-21.)

Power Supply

WARNING

• Do not scratch, break or modify the power cord. Do not place heavy items on the cord, pull on the cord, or bend the cord excessively. Electrical current may flow out from damaged parts of the cord, causing fire or electrical shock.

• Do not place the cord near any heating appliance. This can melt the cord insulation, causing fires or electrical shock.

• Do not plug in or unplug the electrical cord if your hands are wet. Doing so may cause an electrical shock.

• Do not connect an excessive number of appliances to a single outlet. Doing so may cause fire or electrical shock.

• Do not coil or tie knots in the electrical cord. Doing so may cause fire or electrical shock.

• Make sure the plug is fully inserted into the power outlet. If the plug is not fully inserted, fire and electrical shock may result.
• Do not use any electrical cables other than the supplied cord. Doing so may cause fire or electrical shock.

• In principle, you should not connect the printer using an extension cord or connect too many appliances to a single power outlet. However, if there is no choice but to use an extension cord or connect multiple appliances to a single power outlet, it is the responsibility of the user to take care of the following cautions. If these points are not followed correctly, a fire or electrical shock may result.
  - Do not connect one extension cord to another.
  - Make sure that the voltage of the power plug matches the voltage on the rating label (attached to the back of the printer) when you use the printer.
  - Use an extension cord that can carry an electrical current greater than the value indicated on the rating label (attached to the back of the printer).
  - When you use an extension cord, untie the cord binding, and insert the power plug completely into the extension cord outlet to ensure a firm connection between the power cord and the extension cord.
  - Periodically check that the extension cord is not overheated.

⚠️ CAUTION

• Do not use a power source with a voltage other than that indicated. Doing so may cause fire or electrical shock.

• When you unplug the power cord, make sure you hold the cord by the plug. If you pull on the cord itself, the cord may experience damage such as exposure of the core wires or an open circuit, and electrical current flowing out of the damaged section can cause fires or electrical shock.

• Whenever you pull out the power plug, make sure there are no objects around the power plug. Do not pull out the power plug in an emergency.

### Handling

⚠️ WARNING

• Do not disassemble or modify this product. This product contains high voltage and high temperature internal parts, which could cause a fire or electrical shock if tampered with.

• Electrical components can produce unexpected hazards if not handled correctly. Make sure that the power cord, cables, and internal gears and electrical components are kept out of reach of children.

• If this product emits strange noises, smoke, excess heat, or unusual smells, turn the power off immediately, and disconnect the USB cable if it is connected. Next, pull out the power plug, and contact the store where you purchased this printer. Continuing to use a faulty printer may cause fire or electrical shock.

• Do not use flammable sprays near this product. If the gas from a spray comes into contact with the electrical unit inside the printer it may ignite or cause an electrical shock.
• When you are moving the printer, always turn the printer and computer off, unplug the power plug, and remove the interface cable. If you move the printer without unplugging the cables, the electrical cord and interface cable may be damaged, causing a fire or electrical shock.

• Do not drop paper clips, staples, or any other metallic objects into the printer. Do not spill water, liquids, or flammable substances (alcohol, benzene, thinners, etc.) onto the printer. If any of these items come into contact with the electrical unit inside the printer they may ignite or cause an electrical shock. If any of these objects fall into the printer, turn the printer and computer off immediately, and disconnect the USB cable if it is connected. After this, pull out the power plug, and contact the store where you purchased the printer.

• If you are connecting or disconnecting the USB cable while the printer power plug is connected to a power outlet, make sure that you do not touch the metal parts of the connector. Doing so may cause an electrical shock.

**CAUTION**

• Do not put any heavy objects on top of this product. If a heavy object topples over or falls it can cause personal injuries.

• If you are not going to use the printer for a long period of time, such as overnight, turn the printer off for safety reasons. Furthermore, if you are not going to use the printer for a longer period of time, such as a weekend, turn the printer off and disconnect the power plug for safety.

• Keep your hands or clothing away from the roller in the output area. Even if the printer is not printing, sudden rotation of the roller may catch your hands or clothing, resulting in personal injury.

• Laser light can be harmful to the human body. The laser scanning unit in this product is sealed behind a cover, and there is virtually no risk of being exposed to the laser light if the product is operated normally. Be sure to observe the following safety precautions.
  - Do not open any of the printer covers unless directed to by this manual.
  - Do not remove the caution label attached to the cover of the laser scanner unit.

- If the laser beam escapes from the printer, exposure may cause serious damage to your eyes.
Maintenance and Inspections

⚠️ WARNING

- Turn the printer and computer off, disconnect the USB cable and remove the power plug from the wall when you are cleaning the printer. Failure to do so may cause fire or electrical shock.

- When cleaning the printing, always use a cloth dipped in plain water or water containing a mild soap solution and firmly wring the excess moisture out of the cloth before use. Do not use alcohol, benzene, thinners or any other inflammable substance. If an inflammable substance comes into contact with the electrical unit inside the printer it may ignite or cause an electrical shock.

- There is a high-voltage unit inside this product. When you are clearing paper jams or inspecting the interior of the printer, make sure that no necklaces, bracelets, or other metallic objects come into contact with the inside of the printer. If this does happen, it may cause burns or an electrical shock.

- Do not put spent toner cartridges into a fire. Any toner remaining in the toner cartridge may ignite, causing burns or fire.

- Unplug the power plug periodically and wipe away any dust or dirt that has built up around the power outlet. If the power plug is left connected for a long period of time in a dusty, humid, or smoky environment, dust that gathers around the power outlet will absorb moisture and reduce the effectiveness of the insulation, leading to fires.

⚠️ CAUTION

- Never attempt to service this printer yourself, except as explained in this manual. There are no user serviceable parts inside the printer. Adjust only those controls that are covered in the operating instructions. Improper adjustment could result in personal injury and/or damage requiring extensive repair that may not be covered under your Limited Warranty.

- The area around the fixing unit inside the printer becomes hot during use. If you are inspecting the inside of the printer while you are clearing a paper jam, etc., take care not to touch the area around the fixing unit. Doing so can cause burns.

- Be careful to avoid staining your clothes or hands with toner while you are clearing a paper jam or replacing the toner cartridge. If you do get any toner on your clothes or hands, wash it off immediately with cold water. If you rinse using hot water the toner may become fixed, creating a stain that cannot be removed.
• When you are clearing jammed paper from inside the printer, remove the paper gently so that toner that is on the jammed paper does not spray out of the printer. This could lead to toner getting in your eyes or mouth. If toner gets into your eyes or mouth, wash it out immediately with cold water and consult a doctor.
• When loading paper or removing jammed paper, take care not to cut your hands with the edges of the paper.
• When removing a used toner cartridge from the toner cartridge slot, remove the cartridge carefully to prevent the toner from scattering and entering your eyes or mouth. If the toner enters your eyes or mouth, wash them immediately with cold water and immediately consult a physician.

**Consumables**

⚠️ **WARNING**
- Do not put spent toner cartridges into a fire. The toner may ignite cause burns and fires.
- Do not store toner cartridges or paper in a location where there are open flames. Toner and paper could ignite, causing burns and fires.

⚠️ **CAUTION**
Store toner cartridges and other consumables out of reach of infants. If toner from a toner cartridge is swallowed, seek medical attention immediately.

**Other**

⚠️ **WARNING**
The toner cartridge produces a weak magnetic field. If someone who is using a pacemaker feels any unusual sensations, they should stay clear of the toner cartridge and seek medical attention immediately.
This chapter describes the major features and basic functions of this printer.

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer Features</td>
<td>1-2</td>
</tr>
<tr>
<td>Component Names and Functions</td>
<td>1-4</td>
</tr>
<tr>
<td>Front View</td>
<td>1-5</td>
</tr>
<tr>
<td>Rear View</td>
<td>1-6</td>
</tr>
<tr>
<td>Inside the Printer</td>
<td>1-7</td>
</tr>
<tr>
<td>Indicators and the Paper Key</td>
<td>1-8</td>
</tr>
<tr>
<td>Connecting the Power Cord</td>
<td>1-9</td>
</tr>
<tr>
<td>Connecting to a Computer</td>
<td>1-12</td>
</tr>
<tr>
<td>Turning the Printer On and Off</td>
<td>1-15</td>
</tr>
<tr>
<td>Turning the Printer On</td>
<td>1-15</td>
</tr>
<tr>
<td>Turning the Printer Off</td>
<td>1-16</td>
</tr>
</tbody>
</table>
Printer Features

■ High Performance Printing System "CAPT"
The LBP2900/2900i is equipped with the latest CAPT (Canon Advanced Printing Technology) software that supports Windows OS. This system allows the data processing that is conventionally handled by the printer during printing to be batch processed by the computer, delivering high-speed printing that utilizes the full power of the computer. On top of this, the time taken until the computer is released has also been reduced, and printer information, such as paper out during printing, is displayed on the computer screen.

■ USB 2.0 High Speed Installed as Standard
The LBP2900/2900i is capable of high transmission speeds of up to 480 Mbps through an interface that features support for USB 2.0 High Speed.

■ High Speed Printing and Super High Quality Printing
Deliver the high printing speed of 12 pages per minute (LBP2900)/11 pages per minute (LBP2900i). Relieves the stress of waiting for a print job to finish. This printer is fitted with a 600dpi laser printer engine. A stunningly high resolution of 2400 effective dpi x 600 dpi is made possible through the Automatic Image Refinement which is unique to Canon. Furthermore, because the grayscale makes use of a dithering pattern, photographs and graphics can be printed with beautifully subtle reproduction.

■ Support for a Wide Variety of Networks
When used as a network printer, the printer status can be displayed on both the client and server computers. Job control can also be performed from either computer.

■ Support for Various Types of Media
The LBP2900/2900i supports plain paper, Index Card, envelopes (Envelope C5, Envelope COM10, Envelope DL, Envelope Monarch), label paper, transparencies and a variety of other paper. In addition, even though this is an A4 printer, A3 and B4 size documents can be printed reduced onto A4 paper using reduction mode. You can also print onto non-standard custom paper sizes.

■ Low Power Consumption and Quick Startup
The revolutionary On-Demand Fixing Technology, which is exclusive to Canon, delivers both energy savings and quick startup. This technology means that the fixing heater is only heated up momentarily during printing, and so no time is needed to warm the printer up. As a result, you can always start printing directly from standby mode without any delay. Furthermore, the energy saving design delivers an average energy consumption in standby mode of a mere 2W.
■ Compact and Silent Design
The compact design of the main printer body means that it can be used in the tiny spaces in the home or office.

The noise-reducing design delivers quiet operation even during printing. Because the printer is silent in standby mode, you can use it even in the middle of the night, without having to be concerned about those around you.

■ Simple Maintenance and Printer Status Window
The toner cartridges made for this printer (Canon genuine part) are designed as a single part containing both toner and the light sensitive drum, so that they can be easily replaced.

The Printer Status Window that is displayed during printing makes it easy to tell exactly what the printer is doing through the use of graphical and audio cues, improving the overall usability of the printer.
This section describes the names and functions of each component of the printer so that you can use the printer properly and make full use of all of the printer's features.

⚠️ CAUTION
Do not install this printer in a location where a wall or other object will block the ventilation slots in the printer. If the ventilations slots are blocked, the internal printer components will overheat, and this may cause a fire.

📝 NOTE
Consult the store where you purchased this product in the event that any of the parts are broken.
Front View

① Top Cover
This cover needs to be opened to replace the toner cartridge or to clear paper jams. (See p. 5-3, p. 6-6)

② Output Tray
Assists in the collection of printed paper.

③ Paper Guides
These can be adjusted to match the width of the paper, allowing the paper to feed straight.

④ Small Paper Guide
When you are loading small sized custom paper sizes, this should be attached to the rear paper guide.

⑤ Rear Paper Guide
Adjust this to suit the loaded paper to keep the rear edge of the paper aligned.

⑥ Multi-Purpose Tray
This tray can hold up to a maximum of 150 sheets of plain paper (64 g/m²). (See p. 2-9)

⑦ Manual Feed Tray
This paper source is for use when you are printing on paper fed manually one sheet at a time. (See p. 2-9)
Rear View

① Ventilation Slots
These are ventilation slots for cooling the internal parts of the printer. Do not block or obstruct the ventilation slots.

② Power Switch
This switch turns the printer on and off. (See p. 1-15)

③ Power Socket
Connect the supplied power cord to this socket. (See p. 1-9)

④ Rating Label
This also shows the electrical current rating and average electrical current consumption.

⑤ USB Connector
The USB cable plugs into this connector. This is used to connect the printer to the USB port on a computer, etc. (See p. 1-13)

⑥ USB Cover
Open this cover when you are connecting or disconnecting the USB cable.
Inside the Printer

1 Toner Cartridge Guide
When you install the toner cartridge, make sure that the protrusions on the edges of the cartridge align with this guide while you push the cartridge in. (See p. 5-6)

2 Transfer Roller
This is a very important part of the printer that transfers toner onto the paper during printing.
Indicators and the Paper Key

1 Power Indicator
This light turns on when the power is on.

2 Paper Indicator / Paper Key
This flashes when the printer runs out of paper or when the paper does not feed properly. After refilling a paper tray, press this key to restart printing.
Connecting the Power Cord

This section explains how to connect the power cord to the printer. Refer to "Important Safety Instructions," on p. xiv before connecting the printer.

**Connecting the Power Cord**

**WARNING**

- Do not scratch, break or modify the power cord. Do not place heavy items on the cord, pull on the cord, or bend the cord excessively. Electrical current may flow out from damaged parts of the cord, causing fire or electrical shock.
- Do not place the cord near any heating appliance. This can melt the cord insulation, causing fires or electrical shock.
- Do not plug in or unplug the electrical cord if your hands are wet. Doing so may cause an electrical shock.
- Do not connect an excessive number of appliances to a single outlet. Doing so may cause fire or electrical shock.
- Do not coil or tie knots in the electrical cord. Doing so may cause fire or electrical shock.
- Make sure the plug is fully inserted into the power outlet. If the plug is not fully inserted, fire and electrical shock may result.
- Do not use any electrical cables other than the supplied cord. Doing so may cause fire or electrical shock.

- In principle, you should not connect the printer using an extension cord or connect too many appliances to a single power outlet. However, if there is no choice but to use an extension cord or connect multiple appliances to a single power outlet, it is the responsibility of the user to take care of the following cautions. If these cautions are not followed correctly, a fire or electrical shock may result.
  - Do not connect one extension cord to another.
  - Make sure that the voltage of the power plug matches the voltage on the rating label (attached to the back of the printer) when you use the printer.
  - Use an extension cord that can carry an electrical current greater than the value indicated on the rating label (attached to the back of the printer).
  - When you use an extension cord, untie the cord binding, and insert the power plug completely into the extension cord outlet to ensure a firm connection between the power cord and the extension cord.
  - Periodically check that the extension cord is not overheated.
CAUTION

• Do not use a power source with a voltage other than that indicated. Doing so may cause fire or electrical shock.
• When you unplug the power cord, make sure you hold the cord by the plug. If you pull on the cord itself, the cord may experience damage such as exposure of the core wires or an open circuit, and electrical current flowing out of the damaged section can cause fires or electrical shock.
• Whenever you pull out the power plug, make sure there are no objects around the power plug. Do not pull out the power plug in an emergency.

IMPORTANT

• Do not plug the power cord into the auxiliary outlet on a computer.
• One AC power outlet should be used exclusively for the printer.
• Do not connect this printer to an uninterruptible power supply. The printer may malfunction when a power outage occurs, and there is a risk of damaging the printer.

1 Make sure that the power switch of the printer is turned off.

The printer is off when the "○" side of the power switch is pressed in.

2 Plug the supplied power cord securely into the power socket.
3 Plug the power plug into the AC power outlet.
Connecting to a Computer

This section describes how to connect the printer to a computer. This printer is fitted with a USB connector as standard, and can be connected to a computer using a USB cable. Connect the printer to a computer equipped with a USB port using a USB cable.

WARNING
• If you are connecting or disconnecting the USB cable while the printer power plug is connected to a power outlet, make sure that you do not touch the metal parts of the connector. Doing so may cause an electrical shock.
• Do not pull out the USB cable while the computer or printer are turned on. Doing so may damage the printer.

IMPORTANT
This printer uses bidirectional communication. Operation of the printer when connected via unidirectional communication equipment has not been tested. As a result, Canon cannot guarantee printer operation when the printer is connected using unidirectional print servers, USB hubs and switching devices.

NOTE
• The USB interface of the printer depends on the OS of the computer it is connected to as follows. For further details, please inquire at the store where you purchased the printer.
  - Windows 98/Me: USB Full-Speed (USB1.1 equivalent)
  - Windows 2000/XP/Server 2003: USB 2.0 Hi-Speed/USB Full-Speed (USB1.1 equivalent)
• When you connect this printer to a computer via a USB cable, use a computer where the USB port has been guaranteed to operate correctly by the manufacturer.
• A USB cable is supplied with this printer only within countries and regions of Asia. In other countries and regions, prepare according to the specifications of your computer.

1 Make sure that the computer and printer are turned off at the power.
2 Open the USB cover.

3 Connect the B-type (square) end of the USB cable to the USB connector on the rear side of the printer, and close the USB cover.
4 Connect the A-type (flat) end of the USB cable to the USB port on the computer.

NOTE
If you are not sure about the USB cable that is supported by your computer, contact the store where you purchased the computer.
Turning the Printer On and Off

The printer can be turned on and off using the power switch on the left side of the printer body. To avoid running into unexpected problems, be sure to correctly memorize this procedure.

Turning the Printer On

To begin using the printer, press the "|" side of the power switch to turn the printer on. After performing a self-diagnostic check, the printer is ready to print.

IMPORTANT

- Do not turn the printer on again immediately after turning the printer off. If you want to turn the printer on again after turning it off, wait at least 10 seconds after turning the printer off before turning it on again.
- Refer to "Troubleshooting," on p. 6-1 if the printer does not operate properly, or an error message appears in the Printer Status Window.
- When you turn the printer on for the first time after installing it, a single sheet of white paper may be ejected from the printer. This is not a malfunction.

1 Press the "|" side of the power switch to turn the printer on.
The printer Power Indicator turns on and the printer runs a self-diagnostic test. If there are no errors in the self-diagnostic test, the printer is ready to print.

**Turning the Printer Off**

Use the following procedure to turn the printer off.

**IMPORTANT**
- If the printer is used on a network, make sure that it is not printing data from another computer before turning the power off.
- When the printer is turned off, any remaining print data in the printer's memory is erased. If you need the print data, wait for the printer to finish printing before turning the power off.
- Do not turn the printer off under any of the following circumstances:
  - While printing
  - While running a self-diagnostic test immediately after turning the printer on

1. **Press the "○" side of the power switch to turn the printer off.**

**IMPORTANT**
When the "○" side of the power switch is pressed in, the power consumption of the printer is 0 W.
Loading and Delivering Paper

This chapter describes the types of paper that can be used with this printer, and how the paper is loaded and delivered.

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Requirements</td>
<td>2-2</td>
</tr>
<tr>
<td>Usable Paper</td>
<td>2-2</td>
</tr>
<tr>
<td>Printable Area</td>
<td>2-5</td>
</tr>
<tr>
<td>Paper You Cannot Use</td>
<td>2-6</td>
</tr>
<tr>
<td>Storing Blank Paper</td>
<td>2-7</td>
</tr>
<tr>
<td>Storing Printed Paper</td>
<td>2-8</td>
</tr>
<tr>
<td>Paper Sources</td>
<td>2-9</td>
</tr>
<tr>
<td>Paper Source Types</td>
<td>2-9</td>
</tr>
<tr>
<td>Paper Source Capacities</td>
<td>2-10</td>
</tr>
<tr>
<td>Paper Output</td>
<td>2-11</td>
</tr>
<tr>
<td>Output Tray Types</td>
<td>2-11</td>
</tr>
<tr>
<td>Output Tray Capacities</td>
<td>2-12</td>
</tr>
<tr>
<td>Printing on Plain Paper, Heavy Paper, Label Paper, and Transparencies.</td>
<td>2-13</td>
</tr>
<tr>
<td>Loading the Paper</td>
<td>2-13</td>
</tr>
<tr>
<td>Selecting Printer Driver Settings and Printing</td>
<td>2-22</td>
</tr>
<tr>
<td>Printing on Index Card</td>
<td>2-26</td>
</tr>
<tr>
<td>Loading Index Cards</td>
<td>2-26</td>
</tr>
<tr>
<td>Selecting Printer Driver Settings and Printing</td>
<td>2-29</td>
</tr>
<tr>
<td>Printing on Envelopes</td>
<td>2-33</td>
</tr>
<tr>
<td>Loading Envelopes</td>
<td>2-33</td>
</tr>
<tr>
<td>Selecting Printer Driver Settings and Printing</td>
<td>2-40</td>
</tr>
<tr>
<td>Printing on Custom Paper Sizes (Non-Standard Sizes)</td>
<td>2-44</td>
</tr>
<tr>
<td>Loading Custom Paper Sizes</td>
<td>2-44</td>
</tr>
<tr>
<td>Selecting Printer Driver Settings and Printing</td>
<td>2-53</td>
</tr>
</tbody>
</table>
Usable Paper

To get the most out of the features of this printer, you should use the right kind of paper. If you use poor quality paper, the printing quality will deteriorate and the paper will jam easily.

**IMPORTANT**
- A safety feature that prevents printer damage due to overheating, etc. may be activated in the following circumstances, causing the printing speed to drop.
  - When printing continuously on B5, A5 or Executive size paper, the printing speed may drop to 3.9 ppm.
- Use the paper capacity for each type of paper as a guide to the number of sheets of paper that can be printed continuously.

**Paper Sizes**

You can use the following paper sizes with this printer. The symbol ○ indicates paper that can be loaded, and × indicates paper that cannot be loaded.

<table>
<thead>
<tr>
<th>Paper Size</th>
<th>Paper Source</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Multi-Purpose Tray</td>
</tr>
<tr>
<td>A4</td>
<td>○</td>
</tr>
<tr>
<td>B5</td>
<td>○</td>
</tr>
<tr>
<td>A5</td>
<td>○</td>
</tr>
<tr>
<td>Legal</td>
<td>○</td>
</tr>
<tr>
<td>Letter</td>
<td>○</td>
</tr>
<tr>
<td>Executive</td>
<td>○</td>
</tr>
<tr>
<td>Custom Paper Size</td>
<td>○</td>
</tr>
<tr>
<td>Width: 76.2 mm to 215.9 mm</td>
<td></td>
</tr>
<tr>
<td>Length: 127.0 mm to 355.6 mm</td>
<td></td>
</tr>
<tr>
<td>Envelope DL 110.0 mm x 220.0 mm</td>
<td>○</td>
</tr>
<tr>
<td>Envelope COM10 105.0 mm x 241.0 mm</td>
<td>○</td>
</tr>
<tr>
<td>Envelope C5 162.0 mm x 229.0 mm</td>
<td>○</td>
</tr>
<tr>
<td>Envelope Monarch 98.4 mm x 190.5 mm</td>
<td>○</td>
</tr>
<tr>
<td>Index Card 76.2 mm x 127.0 mm</td>
<td>×</td>
</tr>
</tbody>
</table>
**Paper Types**

You can use the following types of paper with this printer. The symbol  ○ indicates paper that can be loaded, and  × indicates paper that cannot be loaded.

<table>
<thead>
<tr>
<th>Paper Type</th>
<th>Printer Driver Setting</th>
<th>Paper Source</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Multi-Purpose Tray</td>
</tr>
<tr>
<td>Plain Paper (64 to 90 g/m²)</td>
<td>[Plain Paper], [Plain Paper L]*1</td>
<td>○</td>
</tr>
<tr>
<td>Heavy Paper (91 to 163 g/m²)</td>
<td>[Heavy Paper], [Heavy Paper H]*2</td>
<td>○</td>
</tr>
<tr>
<td>Transparencies</td>
<td>[Transparency]</td>
<td>○</td>
</tr>
<tr>
<td>Label Paper</td>
<td>[Plain Paper]*3</td>
<td>○</td>
</tr>
<tr>
<td>Index Card</td>
<td>*4</td>
<td>×</td>
</tr>
<tr>
<td>Envelopes</td>
<td>*4</td>
<td>○</td>
</tr>
</tbody>
</table>

*1 If the paper curls excessively when printed using the [Plain Paper] setting, select [Plain Paper L].
*2 If you want to get improved fixing properties over the results of printing using the [Heavy Paper] setting, select [Heavy Paper H].
*3 When you are printing on label paper, set the paper type setting to [Plain Paper].
*4 When printing Index Card or envelopes, the printer automatically selects the appropriate printing mode when you select the paper size. You can change the paper size using the [Output Size] setting on the [Page Setup] sheet.

**Plain Paper**

This printer can print on plain paper with width in the range of 76.2 to 215.9 mm, length in the range of 127.0 to 355.6 mm, and weight in the range of 64 to 90 g/m² including the standard paper sizes: A4, B5, A5, Legal, Letter, and Executive.

**Heavy Paper**

This printer can print on heavy paper with width in the range of 76.2 to 215.9 mm, length in the range of 127.0 to 355.6 mm, and weight in the range of 91 to 163 g/m² including the standard paper sizes: A4, B5, A5, Legal, Letter, and Executive.

**Transparencies**

This printer can print on A4 and Letter size transparencies.

**IMPORTANT**

Thoroughly fan through each sheet before loading transparencies as they easily stick to each other.

**Label Paper**

This printer can print on A4 and Letter size label paper.
**IMPORTANT**

Do not use the following types of label paper with this printer. Using label paper that meets any of these conditions may result in paper jams that are difficult to clear or may cause damage to the printer.
- Peeling labels or partly used labels
- Labels that peel off from the backing sheet too easily
- Labels where the adhesive is exposed

**Index Card**

You can use index card in this printer.

**IMPORTANT**

Index card can only be loaded in the manual feed tray.

**Envelopes**

The envelopes that can be used with this printer are as follows:

- **Envelope DL**
  110.0 mm x 220.0 mm
  (4.33 inch x 8.66 inch)

- **Envelope Monarch**
  98.4 mm x 190.5 mm
  (3.88 inch x 7.50 inch)

- **Envelope COM10**
  104.9 mm x 241.3 mm
  (4.13 inch x 9.50 inch)

- **Envelope C5**
  162.0 mm x 229.0 mm
  (6.38 inch x 9.02 inch)

* Envelopes with a flap on the short edge cannot be used.

**IMPORTANT**

- The following envelopes cannot be used with this printer. Using any of these envelopes may result in paper jams that are difficult to clear or may cause damage to the printer.
  - Envelopes with fasteners or snaps
  - Envelopes with address windows
  - Envelopes with adhesive on the surface
  - Wrinkled or creased envelopes
  - Poorly manufactured envelopes in which the glued parts are uneven
  - Irregularly-shaped envelopes
- Before loading the envelopes, push down on the stack of envelopes to release any remaining air, and press down firmly along the folded edges of the envelopes.
- Do not print on the reverse side (glued side) of envelopes.
- Printing speed drops when printing on envelopes.
NOTE

When printing envelopes, the envelopes may become creased.

**Abbreviations of Paper Sizes**

The following abbreviations are used for the sizes displayed on the multi-purpose tray and manual feed tray.

<table>
<thead>
<tr>
<th>Paper Size</th>
<th>Paper Guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legal</td>
<td>LGL</td>
</tr>
<tr>
<td>Letter</td>
<td>LTR</td>
</tr>
<tr>
<td>Executive</td>
<td>EXEC</td>
</tr>
</tbody>
</table>

**Printable Area**

The printable area of this printer is as follows:

- **Plain Paper / Heavy Paper / Transparency / Label Paper**
  You can print within the following area.
### Envelopes / Index Card

Printable up to 10 mm from the edges of an envelope. You may need to adjust the printing position depending the application you are using.

(Sample: Envelope COM10)

![Diagram showing dimensions of Envelope COM10](image)

### Paper You Cannot Use

To avoid problems such as paper jams and other malfunctions, you should not use the following types of paper:

**IMPORTANT**

- Paper that jams easily
  - Paper that is too thick or too thin
  - Irregularly-shaped paper
  - Wet or moist paper
  - Torn or damaged paper
  - Rough, extremely smooth, or glossy paper
  - Paper with binding holes or perforations
  - Curled or creased paper
  - Specially coated paper (coated paper for ink jet printers, etc.)
  - Labels that peel off from the backing sheet too easily
  - Paper that has already been printed on using a copy machine or other laser printer. (The reverse side of the paper is also unusable.)
  - Paper with jagged edges
  - Wrinkled paper
  - Paper with the corners folded

- Paper where the properties change at high temperatures
  - Paper that contains ink that melts, burns, evaporates or emits harmful gases at the high temperatures (approx. 150°C or 302°F) present in the fixing unit.
  - Heat-sensitive paper
  - Treated color paper
  - Specially coated paper (coated paper for ink jet printers, etc.)
  - Paper with adhesive on the surface
• Paper that causes printer malfunctions or damages the printer
  - Carbon paper
  - Paper with staples, clips, ribbons or tapes
  - Paper that has already been printed on using a copy machine or other laser printer. (The reverse side of the paper is also unusable.)
• Paper that is difficult for the toner to fix onto
  - Paper with rough surfaces
  - Specially coated paper (coated paper for ink jet printers, etc.)
  - Paper containing thick fibers

## Storing Blank Paper

Even standard paper may deteriorate if not stored correctly. Degraded paper can cause paper feed problems and paper jams, and may reduce printing quality.

Observe the following guidelines when storing and handling paper:

ℹ️ IMPORTANT

• Store paper away from moisture since paper quality deteriorates in a moist environment.
• The paper wrapper around new paper acts to prevent dampness and drying. Leave the wrapper intact until you are ready to use the paper. You should also re-wrap the wrapper around paper that you do not use.
• Store paper on a flat surface.
• Do not store paper on the floor where water and moisture can accumulate.
• Do not store paper in a place where it will curl or be creased.
• Do not store paper vertically or store too many stacks of paper in one pile.
• Avoid direct sunlight and humid or dry places when storing paper.
• If there are extreme differences in temperature between the storage area and the place where the paper is used, leave the paper in the wrapper in the usage area for about a day to allow the paper to adjust before using it. Rapid changes in temperature and humidity can cause paper to curl or wrinkle.
Storing Printed Paper

When handling or storing documents printed using this printer, be careful of the following points:

**IMPORTANT**

- Do not store in clear folders or with other PVC materials. This can dissolve the toner, causing the paper to stick to the PVC material.
- When gluing paper, be sure to use insoluble adhesive. The use of soluble adhesives can cause the toner to dissolve. When you first use an adhesive, test it on an unneeded printout before use.
  Whenever you stack printouts, check that the documents are completely dry. If the printouts are stacked when they are not completely dry, the toner may dissolve.
- Store paper on a flat surface. If the paper becomes folded or wrinkled, the toner may peel.
- Do not store in a high temperature place. This can cause the toner to melt, making the colors bleed.
- If you are storing printouts for a long period of time (2 years or more), store them in a binder, etc. (Long-term storage can make printouts appear discolored due to discolorations in the paper.)
Paper Source Types

This printer has the following paper sources:

- **Paper Source / Capacity**
  - Manual Feed Tray: 1 sheet
  - Multi-Purpose Tray: Approx. 150 sheets (Plain paper: 64 g/m²)

**IMPORTANT**

When you are printing from the multi-purpose tray, make sure that there is no paper in the manual feed tray. If there is any paper in the manual feed tray, paper will feed from the manual feed tray because manual feed tray has priority over the multi-purpose tray.
## Paper Source Capacities

<table>
<thead>
<tr>
<th>Paper Type</th>
<th>Paper Source</th>
<th>Multi-Purpose Tray</th>
<th>Manual Feed Tray</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain Paper (64 g/m²)</td>
<td></td>
<td>Approx. 150 sheets</td>
<td>1 sheet</td>
</tr>
<tr>
<td>Heavy Paper (128 g/m²)</td>
<td></td>
<td>Approx. 60 sheets</td>
<td>1 sheet</td>
</tr>
<tr>
<td>Transparency</td>
<td></td>
<td>Approx. 100 sheets</td>
<td>1 sheet</td>
</tr>
<tr>
<td>Label Paper</td>
<td></td>
<td>Approx. 50 sheets</td>
<td>1 sheet</td>
</tr>
<tr>
<td>Index Card</td>
<td></td>
<td>-</td>
<td>1 sheet</td>
</tr>
<tr>
<td>Envelope</td>
<td></td>
<td>1 sheet</td>
<td>1 sheet</td>
</tr>
</tbody>
</table>
Output Tray Types

Pages are output to the output tray on the top of the printer with the printed side facing down. Open the output tray when you are printing to the output tray.

Close the output tray when you are not using the printer.

⚠️ CAUTION
Keep your hands or clothing away from the roller in the output area. Even if the printer is not printing, sudden rotation of the roller may catch your hands or clothing, resulting in personal injury.
**IMPORTANT**

The area around the output tray becomes very hot during printing and directly after printing. When you are collecting paper from the output tray or clearing a paper jam, be careful not to touch the area around the output tray.

**NOTE**

The output tray can hold up to approximately 100 sheets of plain paper (64 g/m²). The paper capacity varies depending on the paper type and paper size. Refer to "Output Tray Capacities," on p. 2-12 for more details.

### Output Tray Capacities

<table>
<thead>
<tr>
<th>Paper Type</th>
<th>Output Tray*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain Paper (64 g/m²)</td>
<td>Approx. 100 sheets</td>
</tr>
<tr>
<td>Heavy Paper (128 g/m²)</td>
<td>Approx. 30 sheets</td>
</tr>
<tr>
<td>Transparency</td>
<td>Approx. 10 sheets</td>
</tr>
<tr>
<td>Label Paper</td>
<td>Approx. 10 sheets</td>
</tr>
<tr>
<td>Index Card</td>
<td>Approx. 10 sheets</td>
</tr>
<tr>
<td>Envelope</td>
<td>Approx. 10 sheets</td>
</tr>
</tbody>
</table>

* Actual paper capacities vary depending on the environment where the printer is installed and the type and size of the paper you are using.
This section described how to print on plain paper, heavy paper, label paper and transparencies.

Refer to "Printing on Custom Paper Sizes (Non-Standard Sizes)," on p. 2-44 for details about printing on custom paper sizes.

**Loading the Paper**

Paper can be loaded into either the multi-purpose tray or the manual feed tray. If you are printing continuously, load paper in the multi-purpose tray.

If you are printing a single sheet with a size and type different to the paper already loaded in the multi-purpose tray, load the paper in the manual feed tray.

**IMPORTANT**

- When you are printing from the multi-purpose tray, make sure that there is no paper in the manual feed tray. If there is any paper in the manual feed tray, paper will feed from the manual feed tray because manual feed tray has priority over the multi-purpose tray.
- Do not load paper into the manual feed tray while the printer is printing from the multi-purpose tray. The paper loaded in the manual feed tray will feed into the printer, causing overlapping paper feeds and paper jams.
- Do not load paper that has jagged edges, wrinkles, or that is extremely curly. Doing so can cause paper jams and printer faults.
- Refer to "Usable Paper," on p. 2-2 for more details on the paper that can be used.
- Do not use the following types of label paper with this printer. Using label paper that meets any of these conditions may result in paper jams that are difficult to clear or may cause damage to the printer.
  - Peeling labels or partly used labels
  - Labels that peel off from the backing sheet too easily
  - Labels where the adhesive is exposed
Loading Paper into the Multi-Purpose Tray

Use the following procedure to load paper into the multi-purpose tray.

Always load paper lengthways into the multi-purpose tray.

1. Pull out the rear paper guide.

IMPORTANT

- Do not touch or pull paper out of the multi-purpose tray during printing. Doing so may cause the printer to malfunction.
- If you are refilling the multi-purpose tray when there is still paper in the tray, take out the remaining paper and align it properly with the new paper before loading it into the tray.
- Use the paper capacity for each type of paper as a guide to the number of sheets of paper that can be printed continuously.
2. Push the side paper guides out a little wider than the actual width of the paper.

3. Before loading transparencies or labels, fan them in small batches and align the edges.

**CAUTION**

Be careful not to cut your hands with the edges of transparencies or label paper.

**IMPORTANT**

- Make sure you thoroughly fan through transparencies and label paper before loading them. If you do not sufficiently fan the sheets, multiple sheets will feed at once causing paper jams.
- When fanning or aligning the transparencies, try to hold the edges to avoid touching the printing surface.
- Take care not to mark or stain the printing surface of the transparencies with fingerprints, dust, or oil. Doing so may reduce the printing quality.
4 Gently load the paper with the printing side facing up until it touches the back of the tray.

Make sure that the paper passes under the paper limit guides.

CAUTION

When loading paper, take care not to cut your hands with the edges of the paper.

IMPORTANT

- The number of sheets of paper that can be loaded in the multi-purpose tray is as follows. Check that there is sufficient clear space between the paper limit guides and the paper. If there is no free space, slightly reduce the amount of paper.
  - Plain Paper: Approx. 150 sheets (64 g/m²)
  - Heavy Paper: Approx. 60 sheets (128 g/m²)
  - Transparency: Approx. 100 sheets
  - Label Paper: Approx. 50 sheets

- If you use paper that has been poorly cut, the paper may have a tendency to double-feed. In this case, thoroughly line up the edges of the paper on a flat surface before loading it.

Load the paper so that it is straight.
• If the rear edge of the paper stack is not properly aligned, it may result in misfeeds or paper jams.
• If the paper is curled or folded at the corners, flatten it out before loading.

**NOTE**
To print on letterhead paper or paper with a logo already printed on it, load the paper so that the printed side is facing up and the top of the paper is at the far end.

5. **Slide the paper guides to fit both sides of the stack.**
**IMPORTANT**

Always make sure the paper guides match the width of the paper. If the paper guides are too loose or too tight, the paper will not feed properly and this will cause paper jams.

Adjust the rear paper guide to match the paper.

**IMPORTANT**

If you run out of paper and then refill the paper tray, the Paper Indicator will flash. Press the (Paper Key) to resume printing.
Loading Paper into the Manual Feed Tray

Use the following procedure to load paper into the manual feed tray.

Always load paper lengthways into the manual feed tray.

**IMPORTANT**
- You can only load a single sheet of paper in the manual feed tray.
- You cannot print from the manual feed tray if the printer settings are set to multiple copies or multiple pages. If you start a print job set for multiple copies or multiple pages, the second and subsequent sheets will feed from the multi-purpose tray regardless of the paper size and paper type.
- Do not touch or pull paper out of the manual feed tray during printing. Doing so may cause the printer to malfunction.

1. **Push the side paper guides out a little wider than the actual width of the paper.**
2 Gently load the paper with the printing side facing up until it touches the back of the tray.

Make sure that the paper passes under the paper limit guides.

⚠️ CAUTION
When loading paper, take care not to cut your hands with the edges of the paper.

⚠️ IMPORTANT
• Load the paper so that it is straight.
• If the paper is curled or folded at the corners, flatten it out before loading.
NOTE

To print on letterhead paper or paper with a logo already printed on it, load the paper so that the printed side is facing up and the top of the paper is at the far end.

3 Slide the paper guides to fit both sides of the stack.
IMPORTANT
• If you run out of paper and then refill the paper tray, the Paper Indicator will flash. Press the \(\text{Paper Key}\) to resume printing.
• Always make sure the paper guides match the width of the paper. If the paper guides are too loose or too tight, the paper will not feed properly and this will cause paper jams.

Selecting Printer Driver Settings and Printing

This section describes how to change the printer driver settings.

1 Select [Print] from the [File] menu in the application. Select the name of your printer from the [Name] or [Printer Name] field and click [Properties].

![Properties dialog box](image)

The [Properties] dialog box for the printer is displayed.
2 Display the [Page Setup] sheet, then set the [Page Size] setting to the size of the document that you created in the application.

![Page Setup Sheet](image)

3 Set the [Output Size] setting to the size of the paper loaded in the printer as needed.

Select [A4] or [Letter] if you are printing transparencies or labels.

Leave the setting set to [Match Page Size] when the page size and the size of the paper loaded in the multi-purpose tray are the same, since there is no need to change the setting.

![Output Size Setting](image)
**IMPORTANT**

If the [Page Size] and [Output Size] settings are different, the printer produces an enlarged or reduced print automatically.

4 **Display the [Paper Source] sheet, and set the [Paper Type] to the type of paper loaded in the printer.**


![Image of Printer Properties](image)

**NOTE**

- If the paper curls excessively when you are printing on plain paper (64 to 90g/m²) with the [Paper Type] setting set to [Plain Paper], try setting the [Paper Type] setting to [Plain Paper L].
- If you want to get improved fixing properties over the results of printing using the [Heavy Paper] setting, select [Heavy Paper H].
5 Click [OK] to close the Properties dialog box.

6 Click [OK] to start printing.
This section describes how to print on index cards.

## Loading Index Cards

You can only load index cards in the manual feed tray.

### Loading Index Card into the Manual Feed Tray

Use the following procedure to load an index card into the manual feed tray.

Always load index cards lengthways into the manual feed tray.

### IMPORTANT

- You can only load a single sheet of index card in the manual feed tray.
- You cannot print from the manual feed tray if the printer settings are set to multiple copies or multiple pages. If you start a print job set for multiple copies or multiple pages, the second and subsequent sheets will feed from the multi-purpose tray regardless of the paper size and paper type.
- Do not touch or pull the index card out of the manual feed tray during printing. Doing so may cause the printer to malfunction.

1. Push the side paper guides out a little wider than the actual width of the paper.
2 Gently load the index card with the printing side facing up until it touches the back of the tray.

Make sure that the index card passes beneath the paper limit guides.

⚠️ CAUTION
When loading index card, take care not to cut your hands with the edges of the paper.

⚠️ IMPORTANT
• If the index card is warped, make sure you fix the warp before loading the card.
• Load the index card so that it is straight.
• If the rear edge of the index card is not properly aligned, it may result in misfeeds or paper jams.
• If the leading edge of the index card is curled or folded at the corners, flatten it out before loading.
NOTE

To print on index card with a logo already printed on it, load the index card so that the printed side is facing up and the top of the index card is at the far end.

3 Slide the paper guides to fit both sides of the index card.
**IMPORTANT**

- If you run out of index card and then refill the paper tray, the Paper Indicator will flash. Press the \(\bigcirc\) (Paper Key) to resume printing.
- Always make sure the paper guides match the width of the index card. If the paper guides are too loose or too tight, the index card will not feed properly and this will cause paper jams.

### Selecting Printer Driver Settings and Printing

This section describes how to set the printer driver settings.

1. Select [Print] from the [File] menu in the application. Select the name of your printer from the [Name] or [Printer Name] field and click [Properties].

![Properties dialog box]

The [Properties] dialog box for the printer is displayed.
2 Display the [Page Setup] sheet, then set the [Page Size] setting to the size of the document that you created in the application.

![Page Setup dialog box]

**NOTE**

When you set the page size to [Index Card], the following message is displayed and the paper type is automatically changed.

![Error message]

---

**Printing on Index Card**

2-30
3 Set the [Output Size] setting to [Index Card] as necessary.

Leave the setting set to [Match Page Size] when the page size and the size of the paper loaded in the multi-purpose tray are the same, since there is no need to change the setting.

![Properties dialog box]

![Properties dialog box]

**IMPORTANT**

If the [Page Size] and [Output Size] settings are different, the printer produces an enlarged or reduced print automatically.

4 Click [OK] to close the Properties dialog box.
5 Click [OK] to start printing.
This section describes how to print to envelopes.

**Loading Envelopes**

Envelopes can be loaded into either the multi-purpose tray or the manual feed tray. You can only load one envelope at a time, regardless of whether you use the multi-purpose tray or the manual feed tray.

If you are printing a single sheet of paper that is different from the paper already loaded in the multi-purpose tray, load the paper in the manual feed tray.

**IMPORTANT**

- When you are printing from the multi-purpose tray, make sure that there is no paper in the manual feed tray. If there is any paper in the manual feed tray, paper will feed from the manual feed tray because manual feed tray has priority over the multi-purpose tray.
- Do not load paper into the manual feed tray while the printer is printing from the multi-purpose tray. The paper loaded in the manual feed tray will feed into the printer, causing overlapping paper feeds and paper jams.
- Printing speed drops when printing on envelopes.
- The envelopes that can be used with this printer are as follows:

<table>
<thead>
<tr>
<th>Envelope Type</th>
<th>Dimensions</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>Envelope DL</td>
<td>110.0 mm x 220.0 mm</td>
<td><img src="image1.jpg" alt="Envelopes" /></td>
</tr>
<tr>
<td>Envelope Monarch</td>
<td>98.4 mm x 190.5 mm</td>
<td><img src="image2.jpg" alt="Envelopes" /></td>
</tr>
<tr>
<td>Envelope COM10</td>
<td>104.9 mm x 241.3 mm</td>
<td><img src="image3.jpg" alt="Envelopes" /></td>
</tr>
<tr>
<td>Envelope C5</td>
<td>162.0 mm x 229.0 mm</td>
<td><img src="image4.jpg" alt="Envelopes" /></td>
</tr>
</tbody>
</table>

* Envelopes with a flap on the short edge cannot be used.
The following envelopes cannot be used with this printer. Using any of these envelopes may result in paper jams that are difficult to clear or may cause damage to the printer.

- Envelopes with fasteners or snaps
- Envelopes with address windows
- Envelopes with adhesive on the surface
- Wrinkled or creased envelopes
- Poorly manufactured envelopes in which the glued parts are uneven
- Irregularly-shaped envelopes

Before loading the envelopes, push down on the stack of envelopes to release any remaining air, and press down firmly along the folded edges of the envelopes.

Do not print on the reverse side (glued side) of envelopes.

NOTE
When printing envelopes, the envelopes may become creased.

Loading Envelopes into the Multi-Purpose Tray
Use the following procedure to load envelopes into the multi-purpose tray.

Always load envelopes lengthways into the multi-purpose tray.

IMPORTANT
- You can only load a single envelope in the manual feed tray.
- Do not touch or pull envelopes out of the multi-purpose tray during printing. Doing so may cause the printer to malfunction.

1. Pull out the rear paper guide.
2 Push the side paper guides out a little wider than the actual width of the paper.

3 Load the envelopes with the printing surface facing up and the flaps closed and on the left side, then gently insert them all the way to the back of the tray.

Make sure that the envelopes passes under the paper limit guides.

**CAUTION**

When loading envelopes, be careful not to cut your hands with the edges of the envelopes.

**IMPORTANT**

- You cannot print on the reverse side (glued side) of envelopes.
- Load the stack of envelopes straight.
- If the leading edges of the envelopes are curled or folded at the corners, flatten them out before loading.
NOTE
When you are printing on envelopes, load the envelopes with the paper surface (the side you want to print on) facing up, and the envelope flap on the left side.

4 Slide the paper guides to meet both sides of the envelopes.

IMPORTANT
Always make sure the paper guides match the width of the paper. If the paper guides are too loose or too tight, the paper will not feed properly and this will cause paper jams.
5 Adjust the rear paper guide to match the envelopes.

**IMPORTANT**
If you run out of envelopes and then refill the paper tray, the Paper Indicator will flash. Press the (Paper Key) to resume printing.

**Loading Envelopes into the Manual Feed Tray**
Use the following procedure to load envelopes into the manual feed tray.
Always load envelopes lengthways into the manual feed tray.

**IMPORTANT**
- You can only load a single envelope in the manual feed tray.
- You cannot print from the manual feed tray if the printer settings are set to multiple copies or multiple pages. If you start a print job set for multiple copies or multiple pages, the second and subsequent sheets will feed from the multi-purpose tray regardless of the paper size and paper type.
- Do not touch or pull envelopes out of the manual feed tray during printing. Doing so may cause the printer to malfunction.
1 Push the side paper guides out a little wider than the actual width of the paper.

2 Load the envelope with the printing surface facing up and the flaps closed and on the left side, then gently insert them all the way to the back of the tray.

Be sure that the envelope passes beneath the paper limit guides.

⚠️ CAUTION
When loading envelope, be careful not to cut your hands with the edges of the envelope.

⚠️ IMPORTANT
- You cannot print on the reverse side (glued side) of envelope.
- Load the envelope straight.
- If the leading edge of the envelope is curled or folded at the corners, flatten it out before loading.
NOTE
When you are printing on envelopes, load the envelopes with the paper surface (the side you want to print on) facing up, and the envelope flap on the left side.

3 Slide the paper guides to meet both sides of the envelope.

IMPORTANT
• If you run out of envelopes and then refill the paper tray, the Paper Indicator will flash. Press the Paper Key to resume printing.
• Always make sure the paper guides match the width of the envelope. If the paper guides are too loose or too tight, the envelope will not feed properly and this will cause paper jams.
1 Select [Print] from the [File] menu in the application. Select the name of your printer from the [Name] or [Printer Name] field and click [Properties].

The [Properties] dialog box for the printer is displayed.
2 Display the [Page Setup] sheet, then set the [Page Size] setting to the size of the document that you created in the application.

NOTE
If you set the page size to any of [Envelope DL], [Envelope COM10], [Envelope C5], or [Envelope Monarch], the following message appears and the appropriate paper type is automatically selected.
3 Set the [Output Size] setting to the size of the paper loaded in the printer as needed.

Leave the setting set to [Match Page Size] when the page size and the size of the paper loaded in the multi-purpose tray are the same, since there is no need to change the setting.

**IMPORTANT**

If the [Page Size] and [Output Size] settings are different, the printer produces an enlarged or reduced print automatically.

4 Click [OK] to close the Properties dialog box.
5 Click [OK] to start printing.
Loading Custom Paper Sizes

Custom paper sizes can be loaded into either the multi-purpose tray or the manual feed tray. If you are printing continuously, load paper in the multi-purpose tray.

If you are printing a single sheet of paper that is different from the paper already loaded in the multi-purpose tray, load the paper in the manual feed tray.

You can load custom paper sizes of width 76.2 mm to 215.9 mm and length 127.0 mm to 355.6 mm.

**IMPORTANT**
- When you are printing from the multi-purpose tray, make sure that there is no paper in the manual feed tray. If there is any paper in the manual feed tray, paper will feed from the manual feed tray because manual feed tray has priority over the multi-purpose tray.
- Do not load paper into the manual feed tray while the printer is printing from the multi-purpose tray. The paper loaded in the manual feed tray will feed into the printer, causing overlapping paper feeds and paper jams.
- Do not load paper that has jagged edges, wrinkles, or that is extremely curly. Doing so can cause paper jams and printer faults.
- Refer to "Usable Paper," on p. 2-2 for more details on the paper that can be used.

**Loading Custom Paper into the Multi-Purpose Tray**

Use the following procedure to load custom paper into the multi-purpose tray.

Always load paper lengthways into the multi-purpose tray.
IMPORTANT

• Do not touch or pull paper out of the multi-purpose tray during printing. Doing so may cause the printer to malfunction.

• If you are refilling the multi-purpose tray when there is still paper in the tray, take out the remaining paper and align it properly with the new paper before loading it into the tray.

• Use the paper capacity for each type of paper as a guide to the number of sheets of paper that can be printed continuously.

1 Pull out the rear paper guide.

2 Push the side paper guides out a little wider than the actual width of the paper.
3 Gently load the paper with the printing side facing up until it touches the back of the tray.

Make sure that the paper passes under the paper limit guides.

![Paper Limit Guide](image)

**CAUTION**

When loading paper, take care not to cut your hands with the edges of the paper.

**IMPORTANT**

- The number of sheets that can be loaded in the multi-purpose tray is as follows. Check that there is sufficient clear space between the paper limit guides and the paper. If there is no free space, slightly reduce the number of envelopes.
  - Plain Paper :Approx. 150 sheets (64 g/m²)
  - Heavy Paper :Approx. 60 sheets (128 g/m²)
- If you use paper that has been poorly cut, the paper may have a tendency to double-feed. In this case, thoroughly line up the edges of the paper on a flat surface before loading it.

![Thoroughly fan in small batches.](image)

![Stand the paper on a flat surface and gently tap it a few times to align the edges.](image)

- Load the paper so that it is straight.
- If the rear edge of the paper stack is not properly aligned, it may result in misfeeds or paper jams.
• If the paper is curled or folded at the corners, flatten it out before loading.

NOTE
To print on letterhead paper or paper with a logo already printed on it, load the paper so that the printed side is facing up and the top of the paper is at the far end.

4 Slide the paper guides to fit both sides of the stack.
**IMPORTANT**
Always make sure the paper guides match the width of the paper. If the paper guides are too loose or too tight, the paper will not feed properly and this will cause paper jams.

5 Adjust the rear paper guide to match the paper.

- If the custom paper that you are using is over 190 mm in length:
  - Adjust the rear paper guide to match the paper.

**IMPORTANT**
If you run out of paper and then refill the paper tray, the Paper Indicator will flash. Press the (Paper Key) to resume printing.
● If the custom paper that you are using is less than 190 mm in length:
   - Move the rear paper guide to the position shown in the diagram.
   - Remove the small paper guide from the multi-purpose tray.
   - Insert the small paper guide from directly above, as shown in the diagram, then fold it towards the back.
Slide the rear paper guide to align the small paper guide with the paper.

- IMPORTANT
  If you run out of paper and then refill the paper tray, the Paper Indicator will flash. Press the (Paper Key) to resume printing.

**Loading Custom Paper into the Manual Feed Tray**

Use the following procedure to load custom paper into the manual feed tray.

Always load custom paper lengthways into the manual feed tray.

- IMPORTANT
  - You can only load a single sheet of paper in the manual feed tray.
  - You cannot print from the manual feed tray if the printer settings are set to multiple copies or multiple pages. If you start a print job set for multiple copies or multiple pages, the second and subsequent sheets will feed from the multi-purpose tray regardless of the paper size and paper type.
  - Do not touch or pull paper out of the manual feed tray during printing. Doing so may cause the printer to malfunction.
1 Push the side paper guides out a little wider than the actual width of the paper.

2 Gently load the paper with the printing side facing up until it touches the back of the tray.

Make sure that the paper passes under the paper limit guides.

**CAUTION**

When loading paper, take care not to cut your hands with the edges of the paper.

**IMPORTANT**

- Load the paper so that it is straight.
- If the paper is curled or folded at the corners, flatten it out before loading.
**NOTE**

To print on letterhead paper or paper with a logo already printed on it, load the paper so that the printed side is facing up and the top of the paper is at the far end.

3 Slide the paper guides to fit both sides of the paper.
IMPORTANT

• If you run out of paper and then refill the paper tray, the Paper Indicator will flash. Press the (Paper Key) to resume printing.

• Always make sure the paper guides match the width of the paper. If the paper guides are too loose or too tight, the paper will not feed properly and this will cause paper jams.

Selecting Printer Driver Settings and Printing

This section describes how to set the printer driver settings.

1 Select [Print] from the [File] menu in the application. Select the name of your printer from the [Name] or [Printer Name] field and click [Properties].

The [Properties] dialog box for the printer is displayed.
2 Display the [Page Setup] sheet, then set the [Page Size] setting to the size of the document that you created in the application.

![Page Setup Sheet](image)

**NOTE**
- When you are using a custom paper size, you need to register the size of the custom paper in advance. Refer to “Specifying a Custom Paper Size (Non-Standard Paper),” on p. 4-39 for information on how to register a custom paper size.
- When you set the page size to [Index Card], the following message is displayed and the paper type is automatically changed.

![Conflict Information](image)
3 Set the [Output Size] setting to the name (paper size) of the custom paper loaded in the printer as needed.

Leave the setting set to [Match Page Size] when the page size and the size of the paper loaded in the multi-purpose tray (the name of the custom paper size) are the same, since there is no need to change the setting.

IMPORTANT
If the [Page Size] and [Output Size] settings are different, the printer produces an enlarged or reduced print automatically.

4 Click [OK] to close the Properties dialog box.
5 Click [OK] to start printing.
This chapter describes the procedure for installing the printer driver on a computer and specifying the settings for printing from a network computer by sharing the printer on the network.

Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-2
    After Installing the Printer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-2
    Each Time You Print . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-2
    System Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-3

Installing the CAPT Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-4
    For Windows 98/Me . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-4
    For Windows 2000 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-19
    For Windows XP/Server 2003 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-31

After Completing Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-42

Printing a Test Page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-44

Printing from a Network Computer using a Shared Printer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-47
    Configuring the Print Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-48
    Installing the Client . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-59

Uninstalling the CAPT software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-72
Introduction

After Installing the Printer

The following shows the tasks that should be performed after installing the printer:

■ Installing the Printer Driver (See p. 3-4)
   The printer driver is a piece of software that is needed when you are printing from application software. Settings related to printing can be configured using the printer driver.

■ Using a computer to share the printer on a network (See p. 3-47)
   If you share this printer on a network and use it from a computer on the network, you must specify the settings for the computer and install the printer driver on the client computers.

Each Time You Print

The following shows the tasks that should be performed each time you print:

■ Specifying print settings
   The printer paper size, page size, number of copies, etc. are configured using the printer driver. If these settings are not configured correctly, you will not be able to achieve the expected results.

■ Printing
   Select the printing option from the menu of the application software you are using. As the method for printing varies depending on the application, refer to the individual users manuals of each application.
System Requirements

In order to use the printer driver, your computer system needs to meet the following requirements:

■ Operating System
  • Microsoft Windows 98
  • Microsoft Windows Me
  • Microsoft Windows 2000 Server/Professional
  • Microsoft Windows XP Professional/Home Edition
  • Microsoft Windows Server 2003 (32-bit processor version only)

- Operating Environment

<table>
<thead>
<tr>
<th></th>
<th>Windows 98/Me</th>
<th>Windows 2000/XP/Server 2003</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CPU</strong></td>
<td>Pentium II 300MHz or higher</td>
<td>Pentium II 300MHz or higher</td>
</tr>
<tr>
<td><strong>Memory (RAM)</strong></td>
<td>64MB or more</td>
<td>128MB or more</td>
</tr>
<tr>
<td><strong>Hard Disk</strong></td>
<td>30MB or more</td>
<td>Windows 2000: 60MB or more</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Windows XP/Server 2003: 70MB or more</td>
</tr>
</tbody>
</table>

* As the actual amount of memory that is available for use differs depending on the configuration of your computer system and the application you are using, printing cannot be guaranteed in all cases in the above environments.

- Recommended Environment

<table>
<thead>
<tr>
<th></th>
<th>Windows 98/Me</th>
<th>Windows 2000/XP/Server 2003</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CPU</strong></td>
<td>Pentium III 600MHz or higher</td>
<td>Pentium III 600MHz or higher</td>
</tr>
<tr>
<td><strong>Memory (RAM)</strong></td>
<td>128MB or more</td>
<td>256MB or more</td>
</tr>
</tbody>
</table>

■ Interface
  • USB: USB 2.0 High-Speed (Windows 2000/XP/Server 2003 only), USB Full-Speed (USB 1.1 equivalent)

**NOTE**
  • If you want to use the sounds from the printer driver, a PC synthesizer (and the PCM synthesizer driver) needs to be installed in your computer. Do not use the PC speaker driver (speaker.drv).
  • This printer uses bidirectional communication. Operation of the printer when connected via unidirectional communication equipment has not been tested. As a result, Canon cannot guarantee printer operation when the printer is connected using unidirectional print servers, USB hubs and switching devices.
Installing the CAPT Software

This section describes the procedure for installing the CAPT software on a computer that is connected directly to the printer using a USB cable.

• For Windows 98/Me (See p. 3-4)
• For Windows 2000 (See p. 3-19)
• For Windows XP/Server 2003 (See p. 3-31)

IMPORTANT

• The CAPT software is required for printing using this printer. Make sure that you install it.
• If there is not enough free space remaining on the hard disk, the message appears during the installation. Abort the installation and create more space on the disk before beginning the installation again.

NOTE

• For details on the procedure for installing this software when the printer is shared on the network from one computer and you are printing from another computer over the network, see "Printing from a Network Computer using a Shared Printer," on p. 3-47.
• A USB cable is supplied with this printer only within countries and regions of Asia. In other countries and regions, prepare according to the specifications of your computer.

For Windows 98/Me

The screen shots used in this section are from Windows Me.

Installing from CD-ROM Setup

1 Make sure that the computer and printer are turned off at the power.
2 Open the USB cover.

3 Connect the B-type (square) end of the USB cable to the USB connector on the rear side of the printer, and close the USB cover.
4 Connect the A-type (flat) end of the USB cable to the USB port on the computer.

5 Turn the computer on and start up Windows 98/Me.

**IMPORTANT**
If the Plug and Play automatic setup wizard appears, click [Cancel] and install the CAPT software using the following procedure.

6 Insert the supplied "LBP2900/2900i User Software" CD-ROM into the CD-ROM drive.

If the CD-ROM is already in the drive, eject the CD-ROM and reinsert it into the drive again.

The CD-ROM Setup appears automatically.

**IMPORTANT**
If the CD-ROM Setup does not start automatically, select [Run] from the [Start] menu, enter "D:\English\CNAB4MNU.exe", and click the [OK] button. (In this case the CD-ROM drive is assumed to be assigned to "D:." The actual CD-ROM drive letter may be different depending on the computer you are using.)
7 Click [Install].

A dialog box is displayed to confirm the language.

8 Confirm the language and click [Yes].

After the preparation for installation is completed, the CAPT (Canon Advanced Printing Technology) software installer starts up, and the [Setup Wizard] dialog box appears.

9 Click [Next].

The [License Agreement] dialog box is displayed.
10 Confirm the contents of the agreement and select [I accept the terms in the license agreement], and then click [Next].

11 Confirm that there is a checkmark next to [Install Printer Driver through a USB Connection], then click [Next].

Depending on your system, a message may appear prompting you to restart your computer. If this happens, restart the computer before continuing with the installation.

12 The message [Installation cannot be stopped once it starts. Do you want to continue?] is displayed. Click [Yes].
13 After the window shown below is displayed, then turn the printer on.

Press the "I" side of the power switch to turn the printer on.

Installation of the USB class driver and the printer driver starts automatically.

NOTE
If the computer does not automatically recognize the printer, refer to "Installation Problems," on p. 6-27.
14 A window is displayed to inform you that the installation is complete. Select [Restart my computer now], then click [Exit].

Windows restarts.

This completes the installation of the USB class driver and printer driver.

**Installing with Plug and Play**

1 Make sure that the computer and printer are turned off at the power.

2 Open the USB cover.
3 Connect the B-type (square) end of the USB cable to the USB connector on the rear side of the printer, and close the USB cover.

4 Connect the A-type (flat) end of the USB cable to the USB port on the computer.
5 Press the "I" side of the power switch to turn the printer on.

6 Turn the computer on and start up Windows 98/Me.

   The [Add New Hardware Wizard] dialog box appears.

   - For Windows Me

   If the following dialog box appears, proceed to Step 7.

   ![Add New Hardware Wizard dialog box](image)

   If the following dialog box appears, proceed to Step 14.

   ![Add New Hardware Wizard dialog box](image)
● For Windows 98

If the following dialog box appears, click [Next], then proceed to Step 7.

If the following dialog box appears, click [Next], then proceed to Step 14.

7 Select [Specify the location of the driver (Advanced)], then click [Next].

For Windows 98: Select [Search for the best driver for your device. (Recommended)], then click [Next].

A dialog box is displayed that allows you to specify the search location.
8 Insert the supplied "LBP2900/2900i User Software" CD-ROM into the CD-ROM drive.
If CD-ROM Setup appears, click [Exit].

9 Select [Search for the best driver for your device. (Recommended.)], remove the checkmark from [Removable Media (Floppy, CD-ROM...)], place a checkmark next to [Specify a location].

For Windows 98: Remove the checkmarks from [Floppy disk drives] and [CD-ROM drive], place a checkmark next to [Specify a location].

10 Click [Browse], and then select a folder.
For Windows 98: Select [D:\English\USBPORT\Win98], and then click [OK].
In this case the CD-ROM drive is assumed to be assigned to “D:”. The actual CD-ROM drive letter may be different depending on the computer you are using.
11 Make sure that the correct path is displayed in the [Specify a location] field, and then click [Next].

![Image of Add New Hardware Wizard]

Installation of the USB class driver starts.

12 Click [Next].

![Image of Add New Hardware Wizard]

13 Click [Finish].

![Image of Add New Hardware Wizard]

The computer automatically detects the printer. Please wait a moment.
The [Add New Hardware Wizard] dialog box appears. For Windows 98, click [Next].

14 Select [Specify the location of the driver (Advanced)], then click [Next].

For Windows 98: Select [Search for the best driver for your device. (Recommended)], then click [Next].

A dialog box is displayed that allows you to specify the search location.

15 If the supplied "LBP2900/2900i User Software" CD-ROM is not in the CD-ROM drive, insert the "LBP2900/2900i User Software" CD-ROM into the drive.

If CD-ROM Setup appears, click [Exit].
16 Select [Search for the best driver for your device. (Recommended).], remove the checkmark from [Removable Media (Floppy, CD-ROM...)], place a checkmark next to [Specify a location].

For Windows 98: Remove the checkmarks from [Floppy disk drives] and [CD-ROM drive], place a checkmark next to [Specify a location].

17 Click [Browse], and then select a folder.

Select [D:\English\Win98_Me], and then click [OK].

In this case the CD-ROM drive is assumed to be assigned to "D:'. The actual CD-ROM drive letter may be different depending on the computer you are using.
18 Make sure that the correct path is displayed in the [Specify a location] field, and then click [Next].

19 Click [Next].

20 Enter a new name in the [Printer name] field if you want to change the name of the printer.

If another printer driver has been already installed in the computer, the message [Do you want your Windows-based programs to use this printer as the default printer?] appears. In this case, select [Yes] or [No].
21 Click [Finish].
Windows will begin copying files.

22 Once the installation complete dialog is displayed, click [OK].

23 Click [Finish].

This completes the installation of the USB class driver and printer driver.

**For Windows 2000**

**Installing from CD-ROM Setup**

1 Make sure that the computer and printer are turned off at the power.
2 Open the USB cover.

3 Connect the B-type (square) end of the USB cable to the USB connector on the rear side of the printer, and close the USB cover.
4 Connect the A-type (flat) end of the USB cable to the USB port on the computer.

5 Turn the computer on and start up Windows 2000.

   IMPORTANT
   If the Plug and Play automatic setup wizard appears, click [Cancel] and install the CAPT software using the following procedure.

6 Log on as a user who is a member of the Administrators group.

   NOTE
   Full Control Permissions are required for the installation of the printer driver.

7 Insert the supplied "LBP2900/2900i User Software" CD-ROM into the CD-ROM drive.

   If the CD-ROM is already in the drive, eject the CD-ROM and reinsert it into the drive again.

   The CD-ROM Setup appears automatically.

   IMPORTANT
   If the CD-ROM Setup does not start automatically, select [Run] from the [Start] menu, enter "D:\English\CNAB4MNU.exe", and click the [OK] button. (In this case the CD-ROM drive is assumed to be assigned to "D:". The actual CD-ROM drive letter may be different depending on the computer you are using.)
8 Click [Install].

A dialog box is displayed to confirm the language.

9 Confirm the language and click [Yes].

After the preparation for installation is completed, the CAPT (Canon Advanced Printing Technology) software installer starts up, and the [Setup Wizard] dialog box appears.

10 Click [Next].

The [License Agreement] dialog box is displayed.
11 Confirm the contents of the agreement and select [I accept the terms in the license agreement], and then click [Next].

12 Confirm that there is a checkmark next to [Install Printer Driver through a USB Connection], then click [Next].

13 The message [Installation cannot be stopped once it starts. Do you want to continue?] is displayed. Click [Yes].

NOTE
If the [Digital Signature Not Found] dialog box appears, click [Yes].
When the following window is displayed, turn the printer on.

Press the "I" side of the power switch to turn the printer on.

Installation of the USB class driver (supplied with the OS) and the printer driver starts automatically.

NOTE
If the computer does not automatically recognize the printer, refer to "Installation Problems," on p. 6-27.
A window is displayed to inform you that the installation is complete. Select [Restart my computer now], then click [Exit].

Windows restarts.

This completes the installation of the USB class driver (supplied with the OS) and printer driver.

**Installing with Plug and Play**

1. Make sure that the computer and printer are turned off at the power.

2. Open the USB cover.
3 Connect the B-type (square) end of the USB cable to the USB connector on the rear side of the printer, and close the USB cover.

4 Connect the A-type (flat) end of the USB cable to the USB port on the computer.
5 Press the "I" side of the power switch to turn the printer on.

6 Turn the computer on and start up Windows 2000.

7 Log on as a user who is a member of the Administrators group.

   The [Found New Hardware Wizard] dialog box appears.

   NOTE
   Full Control Permissions are required for the installation of the printer driver.

8 Click [Next].
9 Select [Search for a suitable driver for my device (recommended)], then click [Next].

NOTE
[Unknown] may be displayed as the name of the device.

10 Remove the checkmarks from [Floppy disk drives] and [CD-ROM drives], place a checkmark next to [Specify a location], and then click [Next].
11 Insert the supplied "LBP2900/2900i User Software" CD-ROM into the CD-ROM drive, then click [Browse].

If CD-ROM Setup appears, click [Exit].

12 Select [D:\English\Win2K_XP]. Select [CNAB4STK.INF] and click [Open].

In this case the CD-ROM drive is assumed to be assigned to "D:". The actual CD-ROM drive letter may be different depending on the computer you are using.

13 Make sure that the correct path is displayed in the [Copy manufacturer's files from] field, then click [OK].

A dialog box is displayed when the computer finishes searching for the driver files.
14 Click [Next].

Windows will begin copying files.

When it has finished, the [Completing the Found New Hardware Wizard] dialog is displayed.

**NOTE**

If the [Digital Signature Not Found] dialog box appears, click [Yes].

15 Click [Finish].

Installation of the USB class driver (supplied with OS) and the printer driver starts automatically.
For Windows XP/Server 2003

The screen shots used in this section are from Windows XP.

**Installing from CD-ROM Setup**

1. Make sure that the computer and printer are turned off at the power.

2. Open the USB cover.

![USB cover open](image)
3 Connect the B-type (square) end of the USB cable to the USB connector on the rear side of the printer, and close the USB cover.

4 Connect the A-type (flat) end of the USB cable to the USB port on the computer.
5 Turn the computer on and start up Windows XP/Server 2003.

**IMPORTANT**
If the Plug and Play automatic setup wizard appears, click [Cancel] and install the CAPT software using the following procedure.

6 Log on as a user who is a member of the Administrators group.

**NOTE**
Full Control Permissions are required for the installation of the printer driver.

7 Insert the supplied "LBP2900/2900i User Software" CD-ROM into the CD-ROM drive.

If the CD-ROM is already in the drive, eject the CD-ROM and reinsert it into the drive again.

The CD-ROM Setup appears automatically.

**IMPORTANT**
If the CD-ROM Setup does not start automatically, select [Run] from the [Start] menu, enter "D:\English\CNAB4MNU.exe", and click the [OK] button. (In this case the CD-ROM drive is assumed to be assigned to "D:". The actual CD-ROM drive letter may be different depending on the computer you are using.)

8 Click [Install].

A dialog box is displayed to confirm the language.
9 Confirm the language and click [Yes].

After the preparation for installation is completed, the CAPT (Canon Advanced Printing Technology) software installer starts up, and the [Setup Wizard] dialog box appears.

10 Click [Next].

The [License Agreement] dialog box is displayed.

11 Confirm the contents of the agreement and select [I accept the terms in the license agreement], and then click [Next].
12 Place a checkmark next to [Install Printer Driver through a USB Connection], then click [Next].

If you are using an operating system equipped with Windows Firewall, such as Windows XP Service Pack 2, the following window is displayed. Click [Yes] or [No].

Click [Yes] to configure Windows Firewall to unblock communication with client computers. Select this option if the computer you are currently installing is a print server.

Click [No] to configure Windows Firewall to block communications with client computers.

13 The message [Installation cannot be stopped once it starts. Do you want to continue?] is displayed. Click [Yes].

NOTE
If the [Software Installation] dialog box appears, click [Continue Anyway].
14 When the following window is displayed, turn the printer on.

![USB Connection]

Press the "I" side of the power switch to turn the printer on.

Installation of the USB class driver (supplied with the OS) and the printer driver starts automatically.

NOTE
- If the computer does not automatically recognize the printer, refer to "Installation Problems," on p. 6-27.
- If the [Hardware Installation] dialog box appears, click [Continue Anyway].
15 A window is displayed to inform you that the installation is complete. Select [Restart my computer now], then click [Exit].

Windows restarts.

This completes the installation of the USB class driver (supplied with the OS) and printer driver.

Installing with Plug and Play

1 Make sure that the computer and printer are turned off at the power.

2 Open the USB cover.
3 Connect the B-type (square) end of the USB cable to the USB connector on the rear side of the printer, and close the USB cover.

4 Connect the A-type (flat) end of the USB cable to the USB port on the computer.
5 Press the "I" side of the power switch to turn the printer on.

6 Turn the computer on and start up Windows XP/Server 2003.

7 Log on as a user who is a member of the Administrators group.

   The [Found New Hardware Wizard] dialog box appears.

   NOTE
   Full Control Permissions are required for the installation of the printer driver.

8 Insert the "LBP2900/2900i User Software" CD-ROM into the CD-ROM drive. Select [Install from a list or specific location (Advanced)], then click [Next].

   If CD-ROM Setup appears, click [Exit].
9 Select [Search for the best driver in these locations.], remove the checkmark from [Search removable media (floppy, CD-ROM...)], place a checkmark next to [Include this location in the search].

10 Click [Browse], and then select a folder.
Select [D:\English\Win2K_XP], and then click [OK]. In this case the CD-ROM drive is assumed to be assigned to "D:". The actual CD-ROM drive letter may be different depending on the computer you are using.
11 Make sure that the correct path is displayed in the [Include this location in the search] field, then click [Next].

The installation progress is displayed.

After this, the [Completing the Found New Hardware Wizard] dialog is displayed.

**NOTE**

If the [Hardware Installation] dialog box appears, click [Continue Anyway].

12 Click [Finish].

**IMPORTANT**

If you are using Windows XP Service Pack 2 or another operating system equipped with Windows Firewall as a print server, configure Windows Firewall to unblock communication with the client computers. (See p. 7-8)

This completes the installation of the USB class driver (supplied with OS) and printer driver.
After Completing Installation

When the installation of the CAPT software is complete, an icon and folder will be created for the printer.

■ For Windows 98/Me/2000
  • The icon for the printer is displayed in the [Printers] folder.
  • [Canon Printer Uninstaller] is added to [Programs] under the [Start] menu.
For Windows XP/Server 2003

- The icon for the printer is displayed in the [Printers and Faxes] folder.
- [Canon Printer Uninstaller] is added to [All Programs] under the [Start] menu.
Before using the printer for the first time, be sure to print a test page using the following procedure.

NOTE
The screen shots shown here are taken from Windows XP Home Edition.

1 Open the [Printers and Faxes] or [Printers] folder.

For Windows XP Home Edition: Select [Control Panel] from the [Start] menu, then click [Printers and Other Hardware] ➞ [Printers and Faxes].

The [Printers and Faxes] or [Printers] folder is displayed.
2 Select the icon for the printer, then select [Properties] from the [File] menu.

The [Properties] dialog box for the printer is displayed.

3 Click [Print Test Page] on the [General] sheet.

The printer will begin printing a test page.
4 If the test page prints correctly, click [OK] or [Yes].

NOTE
If test page does not print correctly, refer to Chapter 6 "Troubleshooting".
If you set the printer up as a shared network printer, you will be able to print directly to the printer from any computer on the network.

If you want to use the printer as a shared printer, perform the following configuration. In this section, the computer that is directly connected to the printer is called the print server, and other computers that access the printer over the network are called client computers.
If you want to use a print server, perform the following steps.

<table>
<thead>
<tr>
<th>Item to Configure</th>
<th>Refer to</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Install the printer driver on the print server</td>
<td>p. 3-4</td>
</tr>
<tr>
<td>• For Windows 98/Me</td>
<td></td>
</tr>
<tr>
<td>• For Windows 2000</td>
<td>p. 3-19</td>
</tr>
<tr>
<td>• For Windows XP/Server 2003</td>
<td>p. 3-31</td>
</tr>
<tr>
<td>2 Configure the Print Server</td>
<td>p. 3-48</td>
</tr>
<tr>
<td>• For Windows 98/Me</td>
<td></td>
</tr>
<tr>
<td>• For Windows 2000/XP/Server 2003</td>
<td>p. 3-53</td>
</tr>
<tr>
<td>3 Install the Clients</td>
<td>p. 3-59</td>
</tr>
</tbody>
</table>

**NOTE**
Using this printer on your network requires that both the print server and clients should be using Windows 98/Me or Windows 2000/XP/Server 2003.

**Configuring the Print Server**

**For Windows 98/Me**

The screen shots used in this section are from Windows Me.

- **Preparing the Print Sharing Settings**


     The [Network] dialog box is displayed.
2 Display the [Configuration] sheet, then click [Add].

![Configuration sheet](image)

The [Select Network Component Type] dialog box is displayed.

3 Click the [Service] icon, then click [Add].

![Select Network Component Type](image)

4 Select [File and printer sharing for Microsoft Networks], then click [OK].

![Select Network Service](image)

The [Select Network Component Type] dialog box appears first, then the [Network] dialog box reappears.
5 Click [File and Print Sharing].

6 Make sure that [I want to be able to allow others to print to my printer(s).] is selected, then click [OK].

7 Go to the [Access Control] sheet and select either [Share-level access control] or [User-level access control].
   If you want to specify the users that can print, select [User-level access control].
8 Click [OK], then restart Windows.

■ Printer Sharing Settings

1 From the [Start] menu, select [Settings] → [Printers].
The [Printers] folder is displayed.

2 Right-click the icon for your printer, then select [Sharing] from the pop-up menu.
3 Select [Shared As]. Change the [Share Name] and enter a [Comment] and [Password] as needed.

![Setting Up the Printing Environment](image)

**NOTE**
- If you selected [User-level access control] in Step 7 of the "Network Settings" procedure (See p. 3-50), click [Add] and select the users that can use the printer.
- Do not enter blank or special characters in [Shared As].
- If you enter a password, it is possible that the client computer will not be able to create the printer port.

4 Click [OK].

The printer icon changes to the shared printer icon.
For Windows 2000/XP/Server 2003

The screen shots shown in this section are taken from Windows XP Home Edition.

Preparing the Print Sharing Settings

1. Select [Control Panel] from the [Start] menu, then click [Network and Internet Connections] → [Network Connections].

   For Windows 2000: Select [Settings] → [Network and Dial-up Connections] from the [Start] menu.

   For Windows Server 2003: From the [Start] menu, select [Control Panel] → [Network Connections] → [Local Area Connection] → [Properties], and then proceed to Step 3.

   For Windows 2000: The [Network and Dial-up Connections] folder is displayed.

   For Windows XP: The [Network Connections] folder is displayed.

2. Right-click the [Local Area Connection] icon, then select [Properties] from the pop-up menu.

   The [Local Area Connection Properties] dialog box appears.
3 Check that [File and Printers Sharing for Microsoft Networks] is selected, then click [OK].

![Local Area Connection Properties](image)

### Printer Sharing Settings

**NOTE**

For Windows XP, the printer cannot be shared over a network using the default settings (the settings immediately after installation).
To use the printer sharing settings, you need to run [Network Setup Wizard] and enable printer sharing.
For more details, see the Windows online help.

1 **Open the [Printers and Faxes] or [Printers] folder.**

   For Windows 2000: Select [Settings] ➞ [Printers] from the [Start] menu.
   For Windows XP Home Edition: Select [Control Panel] from the [Start] menu, then click [Printers and Other Hardware] ➞ [Printers and Faxes].

   The [Printers and Faxes] or [Printers] folder is displayed.
2 Right-click the icon for your printer, then select [Sharing] from the pop-up menu.

3 Select [Share this printer]. Update the share name as required.

For Windows 2000: Select [Shared as].
• You can also specify the sharing settings during the local installation.
• Do not enter blank or special characters in [Share name].

4 If you are using Windows 98/Me on the client computer, click [Additional Drivers].

If you are using Windows 98/Me on the client computer, click [OK]. The printer icon changes to a shared icon, and the printer shared settings are now configured.

The [Additional Drivers] dialog box is displayed.
5 Place a checkmark next to [Windows 95, 98 and Me], then click [OK].

For Windows 2000: Place a checkmark next to [Windows 95 or 98], and then click [OK].

For Windows Server 2003: Place a checkmark next to [Windows 95, Windows 98, and Windows Millennium Edition], and then click [OK].

6 Insert the supplied "LBP2900/2900i User Software" CD-ROM into the CD-ROM drive.

If the [Insert Disk] dialog box appears, click [OK].

7 Click [Browse]. If your CD-ROM drive is drive [D:], select [D:\English\Win98_Me], and then click [OK].

Windows will begin copying files.
8 Click [Close].

The printer icon changes to the shared printer icon.

![Printer Icon Change](image)

**IMPORTANT**

Select [Do not share this printer] on the [Sharing] sheet to clear the printer share settings. If you are clearing printer share settings on an operating system equipped with the Windows Firewall, such as Window XP Service Pack 2, you need to use the utility software to clear the settings that were previously registered with Windows Firewall. (See p. 7-10)

### Configuring Windows Firewall Settings

If you are using Windows XP Service Pack 2 or another operating system equipped with Windows Firewall as a print server, you need to configure Windows Firewall to unblock communication with the client computers.

Use the following procedure to check whether you configure Windows Firewall to unblock this communication.

- When you installed the CAPT software from CD-ROM Setup, a [Warning] dialog box was displayed.

![Warning Dialog](image)

- If you clicked [Yes], Windows Firewall was reconfigured to unblock communication with the client computers.
- If you clicked [No], however, Windows Firewall was configured to block communication with the client computers, and you will need to use the following method to clear that block.

1. Select [Control Panel] from the [Start] menu, then click [Network and Internet Connections] ➞ [Windows Firewall].

2. On the [Exceptions] sheet in the [Windows Firewall] dialog box, place a checkmark next to [Canon LBP2900 RPC Server Process], and click the [OK] button.

- If you installed the CAPT software by any method other than CD-ROM Setup, you need to use the CAPT Windows Firewall Utility software to configure Windows Firewall to unblock communication with the client computers. (See p. 7-8)

### Installing the Client

This section describes the procedure for installing the printer driver on the client computers.

There are two ways to install the printer driver: local installation and download installation.

- **Local Installation (See p. 3-60)**
  Installing the printer driver using the supplied CD-ROM.

- **Download and Install**
  This installs the printer driver by downloading it from the print server, without needing to use the supplied CD-ROM. There are two ways to download and install the driver:

  - Installing using the [Add Printer Wizard] (See p. 3-66)
  - Installing using [Windows Explorer] (See p. 3-70)
IMPORTANT

- If you are using Windows 2000/XP/Server 2003, be sure to log on as a user who is a member of the Administrators group when starting up.
- If the client computer is using Windows XP Service Pack 2 or another operating system equipped with Windows Firewall, configure the following settings. If you do not make these settings on the client computer, status information will not display correctly in the Printer Status Window, and some of the printer functions may not operate correctly.

1. Select [Control Panel] from the [Start] menu, then click [Network and Internet Connections] ➞ [Windows Firewall].


NOTE

- Clients can use either Windows 98/Me or Windows 2000/XP/Server 2003.
- If your print server is Windows 98/Me, you cannot download and install on Windows 2000/XP/Server 2003.
- The screen shots shown in this section are taken from Windows XP Home Edition.

Installing from CD-ROM Setup

1. Insert the supplied "LBP2900/2900i User Software" CD-ROM into the CD-ROM drive.

   If the CD-ROM is already in the drive, eject the CD-ROM and reinsert it into the drive again.

   The CD-ROM Setup appears automatically.
IMPORTANT
If the CD-ROM Setup does not start automatically, select [Run] from the [Start] menu, enter "D:\English\CNAB4MNU.exe", and click the [OK] button. (In this case the CD-ROM drive is assumed to be assigned to "D:". The actual CD-ROM drive letter may be different depending on the computer you are using.)

2 Click [Install].

A dialog box is displayed to confirm the language.

3 Confirm the language and click [Yes].

After the preparation for installation is completed, the CAPT (Canon Advanced Printing Technology) software installer starts up, and the [Setup Wizard] dialog box appears.
4 Click [Next].

The [License Agreement] dialog box is displayed.

5 Confirm the contents of the agreement and select [I accept the terms in the license agreement], and then click [Next].
6 If there is a checkmark next to [Install Printer Driver through a USB Connection], remove the checkmark, then click [Next].

![CAPT Printer Driver - Setup Wizard](image)

**NOTE**

Do not place a checkmark next to [Install Printer Driver through a USB Connection].

7 Select [Use Network Printer] for [Port Settings], then click [Settings].

![CAPT Printer Driver - Setup Wizard](image)
8 Select the icon for the printer that is shared on the printer server, then click [OK].

9 Select whether or not to use this printer as the default printer, then click [Next].

10 Click [Start].
If you are using an operating system equipped with Windows Firewall, such as Windows XP Service Pack 2, the following window is displayed. Click [No].

![Warning window]

You should only choose [Yes] if the computer you are currently installing is a print server.

11 The message [Installation cannot be stopped once it starts. Do you want to continue?] is displayed. Click [Yes].

![Warning window]

The installation of the printer driver starts.

12 A window is displayed to inform you that the installation is complete. Select [Restart my computer now], then click [Exit].

![CAPT Printer Driver - Setup Wizard]

Windows restarts.

**IMPORTANT**

If you are using an operating system equipped with Windows Firewall, such as Windows XP Service Pack 2, on the client computer, you need to configure Windows Firewall to unblock communication with the print server. If you do not configure Windows Firewall to unblock communication with the server, the printer status may not be displayed correctly in the Printer Status Window and some functions may not operate properly. (See p. 7-8)
Installing using the [Add Printer Wizard]

1 Open the [Printers and Faxes] or [Printers] folder.

   For Windows XP Home Edition: Select [Control Panel] from the [Start] menu, then click [Printers and Other Hardware] → [Printers and Faxes].

   The [Printers and Faxes] or [Printers] folder is displayed.

2 The [Add Printer Wizard] dialog box is displayed.

   For Windows 98/Me/2000: Double-click [Add Printer].
   For Windows XP Professional/Home Edition: Click [Add a printer].
   For Windows Server 2003: Double-click [Add Printer].

   The [Add Printer Wizard] dialog box is displayed.

3 Click [Next].
4 Select [A network printer, or a printer attached to another computer], then click [Next].

For Windows 98/Me/2000: Select [Network Printer] then click [Next].

5 Select [Browse for a printer], then click [Next].

For Windows 98/Me: click [Browse].
6 Select the directory of the print server, then click [Next].

For Windows 98/Me: Proceed to Step 8.

7 Select whether or not to use this printer as the default printer, then click [Next].
Click [Finish].

IMPORTANT
If you are using an operating system equipped with Windows Firewall, such as Windows XP Service Pack 2, on the client computer, you need to configure Windows Firewall to unblock communication with the print server. If you do not configure Windows Firewall to unblock communication with the server, the printer status may not be displayed correctly in the Printer Status Window and some functions may not operate properly. (See p. 7-8)

NOTE
If the [Digital Signature Not Found] dialog box appears, click [Yes].
Installing using [Windows Explorer]

1. From the [Start] menu, select [All Programs] → [Accessories] → [Windows Explorer].

   For Windows Me/2000: From the [Start] menu, select [Programs] → [Accessories] → [Windows Explorer].
   For Windows 98: From the [Start] menu, select [Programs] → [Windows Explorer].

   The [Windows Explorer] window is displayed.

2. Select the print server from [My Network Places] (from [Network Neighborhood] for Windows 98), then double-click the icon for the printer.

   Alternatively, you can drag and drop the icon for the printer into the [Printers and Faxes] or [Printers] folder.
3 Follow the instructions that appear on the screen.

IMPORTANT

If you are using an operating system equipped with Windows Firewall, such as Windows XP Service Pack 2, on the client computer, you need to configure Windows Firewall to unblock communication with the print server. If you do not configure Windows Firewall to unblock communication with the server, the printer status may not be displayed correctly in the Printer Status Window and some functions may not operate properly. (See p. 7-8)
Uninstalling the CAPT software

The process of removing software to restore the computer to the same state as before the software was installed is referred to as uninstalling. Use the following procedure to uninstall the CAPT software.

**IMPORTANT**
- If the software was installed with administrative permissions on Windows 2000/XP/Server 2003, then it cannot be uninstalled by anyone that does not have administrative permissions. Make sure you log on as a member of the Administrators group before uninstalling.
- If you are using Windows XP Service Pack 2 or another operating system equipped with Windows Firewall, this printer is registered in the [Exceptions] sheet in the [Windows Firewall] dialog box. When you uninstall the CAPT software using the uninstaller, the settings for this printer are also deleted from the [Exceptions] sheet in the [Windows Firewall] dialog box.

1. **Make sure to close all the files and programs listed below:**
   - Help files
   - Printer Status Window
   - Control Panel
   - Other applications

2. **From the [Start] menu, select [All Programs] → [Canon Printer Uninstaller] → [Canon LBP2900 Uninstaller].**

   For Windows 98/Me/2000: From the [Start] menu, select [Programs] → [Canon Printer Uninstaller] → [Canon LBP2900 Uninstaller].

   The [Delete Printer] dialog box is displayed.
3 Select the name of your printer, and then click [Delete].

![Delete Printer dialog box]

A confirmation message is displayed.

**NOTE**

Even if [Canon LBP2900] is not in the list in the [Delete Printer] dialog box, you can delete all of the files and data related to this printer by clicking the [Delete] button.

4 Click [Yes].

![Warning dialog box]

The uninstallation process begins. Please wait a moment.

5 Click [Exit].

![Delete Printer dialog box]

The [Delete Printer] dialog box closes.
NOTE
If you are unable to uninstall the CAPT software, refer to "If Uninstallation Fails," on p. 6-28.
## Printing a Document

This chapter describes the printing procedures and the functions of this printer.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing from an Application</td>
<td>4-2</td>
</tr>
<tr>
<td>Specifying Printing Preferences</td>
<td>4-7</td>
</tr>
<tr>
<td>For Windows 98/Me</td>
<td>4-7</td>
</tr>
<tr>
<td>For Windows 2000/XP/Server 2003</td>
<td>4-10</td>
</tr>
<tr>
<td>Canceling, Pausing and Resuming Printing</td>
<td>4-17</td>
</tr>
<tr>
<td>Using the Printing Functions</td>
<td>4-19</td>
</tr>
<tr>
<td>Tab Sheets in the Printer Driver</td>
<td>4-19</td>
</tr>
<tr>
<td>Preview</td>
<td>4-33</td>
</tr>
<tr>
<td>Printing Multiple Pages on One Sheet</td>
<td>4-34</td>
</tr>
<tr>
<td>Scaling Printer Output</td>
<td>4-36</td>
</tr>
<tr>
<td>Poster Printing</td>
<td>4-38</td>
</tr>
<tr>
<td>Specifying a Custom Paper Size (Non-Standard Paper)</td>
<td>4-39</td>
</tr>
<tr>
<td>Specifying the Finishing Method</td>
<td>4-41</td>
</tr>
<tr>
<td>Specifying the Print Quality</td>
<td>4-44</td>
</tr>
<tr>
<td>Grayscale Settings</td>
<td>4-46</td>
</tr>
<tr>
<td>Working with Profiles</td>
<td>4-47</td>
</tr>
<tr>
<td>Editing Print Jobs</td>
<td>4-52</td>
</tr>
<tr>
<td>Viewing Printer Settings/Restoring the Default Settings</td>
<td>4-54</td>
</tr>
<tr>
<td>Printer Status Window</td>
<td>4-56</td>
</tr>
<tr>
<td>Using the Printer Status Window</td>
<td>4-57</td>
</tr>
<tr>
<td>Displaying the Printer Status Window</td>
<td>4-59</td>
</tr>
<tr>
<td>The Options Menu</td>
<td>4-60</td>
</tr>
<tr>
<td>[Resolve Error]</td>
<td>4-62</td>
</tr>
<tr>
<td>Displaying Printer Status When Using a Print Server</td>
<td>4-63</td>
</tr>
</tbody>
</table>
Printing from an Application

After installing the CAPT software, you can now print jobs on the printer.

This section describes the procedure for printing from an application, taking Adobe Reader 6.0 as an example.

1 Load paper in the multi-purpose tray or manual feed tray.

NOTE
If you are printing on plain paper, heavy paper, label paper, or transparencies, refer to "Printing on Plain Paper, Heavy Paper, Label Paper, and Transparencies," on p. 2-13; if you are printing on index card, refer to "Printing on Index Card," on p. 2-26; if you are printing on envelopes, refer to "Printing on Envelopes," on p. 2-33; and if you are printing on custom paper, refer to "Printing on Custom Paper Sizes (Non-Standard Sizes)," on p. 2-44.

2 Open the PDF file to print with Adobe Reader, and then select [Print Setup] from the [File] menu.
3 Specify the paper size of the document and the printing orientation, then click [OK].

4 Select [Print] from the [File] menu.

The [Print] dialog box is displayed.
5 Select this printer from the [Name] or [Printer Name] list and select your printing preferences.

![Diagram of printer settings]

**NOTE**
The printer name displayed in this dialog box can be changed from the [Printers and Faxes] folder (the [Printers] folder for Windows 98/Me/2000).

6 If you want to specify more detailed printing preferences, click [Properties].

![Diagram of printer properties]

The [Canon LBP2900 Properties] dialog box is displayed.
NOTE

The procedure for displaying the [Document Properties] dialog box may differ depending on the application you are using.

7 Specify the printing preferences in the [Page Setup], [Finishing], [Paper Source], and [Quality] sheets.

![Document Properties dialog box](image)

NOTE

- The settings that are specified here only apply to the currently opened file. Check the contents of the [Document Properties] dialog box each time you print. In particular, it is recommended that you verify the information in the [Page Setup] sheet and the [Paper Source] sheet.
- The default settings for all files can be configured using the following dialog box.
  - For Windows 98/Me: Open the [Printer Properties] dialog box from the [Printers] folder. (See "Opening the [Printer Properties] Dialog Box from the [Printers] Folder," on p. 4-9.)

8 Click [OK].

The [Print] dialog box reappears.

9 Click [OK].

The printer starts printing.
NOTE

- If the document does not print properly, refer to Chapter 6 "Troubleshooting".
- Refer to "Using the Printing Functions," on p. 4-19 for an explanation on using the features of the printer and printer driver. To ensure that a document prints the way you want it to, adjust the printer and printer driver settings.
Specifying Printing Preferences

The CAPT software allows you to configure various printing preferences for the LBP2900/2900i.

You can configure various printer functions on each of the pages of the [Printer Properties] dialog box and [Document Properties] dialog box. Depending on your OS, use the following procedures to open these property dialog boxes.

For Windows 98/Me

If you open the [Document Properties] dialog box from within an application, the settings are only applicable to that particular print job.

If you open the [Printer Properties] dialog box from the [Printers] folder, you can configure the default printer settings for all print jobs.

Opening the [Document Properties] Dialog Box from an Application

This section describes the procedure for opening the [Document Properties] dialog box, taking Adobe Reader 6.0 as an example.


The [Print] dialog box is displayed.
NOTE

The print command is different depending on the application you are using. Refer to the users manual supplied with your application for further details.

2 Confirm the printer name, then click [Properties].

The [Document Properties] dialog box is displayed.
Opening the [Printer Properties] Dialog Box from the [Printers] Folder

1. From the [Start] menu, select [Settings] → [Printers].

   The [Printers] folder is displayed.

2. Select the icon for your printer, then select [Properties] from the [File] menu.
The [Printer Properties] dialog box is displayed.

NOTE
The [Printer Properties] dialog box can also be displayed by right-clicking the icon for the printer and selecting [Properties] from the pop-up menu.

For Windows 2000/XP/Server 2003

If you open the [Document Properties] dialog box from within an application, the settings are only applicable to that particular print job.

If you open the [Document Properties] dialog box from the [Printers and Faxes] or [Printers] folder, you can specify the default settings used by all print jobs.

If you open the [Printer Properties] dialog box from the [Printers and Faxes] or [Printers] folder, you can configure printer options and create "Profiles" of frequently used options.

NOTE
To change settings in the [Printers and Faxes] or [Printers] folders you need to have Full Access Permissions. If you are unable to open the [Document Properties] dialog box from within the [Printers and Faxes] or [Printers] folder, open it from within the application.
Opening the [Document Properties] Dialog Box from an Application

This section describes the procedure for opening the [Document Properties] dialog box, taking Adobe Reader 6.0 as an example.

1 Select [Print] from the [File] menu in the application.

The [Print] dialog box is displayed.

NOTE

The print command is different depending on the application you are using. Refer to the users manual supplied with your application for further details.
2 Confirm the printer name, then click [Properties].

The [Document Properties] dialog box is displayed.
Opening the [Document Properties] Dialog Box from the [Printers and Faxes] or [Printers] Folder

1 Open the [Printers and Faxes] or [Printers] folder.

For Windows 2000: Select [Settings] ➞ [Printers] from the [Start] menu.
For Windows XP Home Edition: Select [Control Panel] from the [Start] menu, then click [Printers and Other Hardware] ➞ [Printers and Faxes].

The [Printers and Faxes] or [Printers] folder is displayed.
2 Select the icon for your printer, then select [Printing Preferences] from the [File] menu.

The [Document Properties] dialog box is displayed.

NOTE
The [Document Properties] dialog box can also be displayed by right-clicking the icon for your printer and selecting [Printing Preferences] from the pop-up menu.
Opening the [Printer Properties] Dialog Box from the [Printers and Faxes] or [Printers] Folder

1. **Open the [Printers and Faxes] or [Printers] folder.**

   For Windows 2000: Select [Settings] ➞ [Printers] from the [Start] menu.
   For Windows XP Home Edition: Select [Control Panel] from the [Start] menu, then click [Printers and Other Hardware] ➞ [Printers and Faxes].

   ![Image of Printer Properties dialog box](image)

   The [Printers and Faxes] or [Printers] folder is displayed.
Select the icon for your printer, then select [Properties] from the [File] menu.

The [Printer Properties] dialog box is displayed.

NOTE
The [Printer Properties] dialog box can also be displayed by right-clicking the icon for the printer and selecting [Properties] from the pop-up menu.
Canceling, Pausing and Resuming Printing

You can use the Printer Status Window to cancel, pause, or resume print jobs.

1 Start printing.

The Printer Status Window appears.

NOTE
The Printer Status Window may not appear depending on the [Display Printer Status Window] setting in the [Preferences] menu. (See "Setting Preferences," on p. 4-60)

2 To delete or pause a print job, click the [ ] (Pause Job) button in the [Current Print Job] tab or [My Job Operation] tab.

When you click the [ ] (Pause Job) button in the [Current Print Job] tab, the following message is displayed and the screen switches to the [My Job Operation] tab.
3 Click the button corresponding to the operation you would like to perform from among the [Job Operation] buttons.

- **Deleting the job**
  - Click [ ] (Delete Job).

- **Pausing the job**
  - Click [ ] (Pause Job).

- **Resuming the job**
  - Click [ ] (Resume Job).
Tab Sheets in the Printer Driver

The [Printer Properties] and [Document Properties] dialog boxes contain the following sheets, which can be used to configure a variety of printer functions. Click on the tab corresponding to a sheet to switch the display to that sheet.

This section describes the types of printing preferences that can be specified in each sheet.

■ For Windows 98/Me
  • [Document Properties] Dialog Box
    - [Page Setup] Sheet
    - [Finishing] Sheet
    - [Paper Source] Sheet
    - [Quality] Sheet
  • [Printer Properties] Dialog Box
    - [General] Sheet
    - [Details] Sheet
    - [Sharing] Sheet
    - [Page Setup] Sheet
    - [Finishing] Sheet
    - [Paper Source] Sheet
    - [Quality] Sheet
    - [Configuration] Sheet

■ For Windows 2000/XP/Server 2003
  • [Document Properties] Dialog Box
    - [Page Setup] Sheet
    - [Finishing] Sheet
    - [Paper Source] Sheet
    - [Quality] Sheet
• [Printer Properties] Dialog Box
  - [General] Sheet
  - [Sharing] Sheet
  - [Ports] Sheet
  - [Advanced] Sheet
  - [Color Management] Sheet
  - [Security] Sheet
  - [Device Settings] Sheet
  - [Profile] Sheet

**NOTE**
For more details on using these sheets, refer to the online help.
You can access the online help using the following procedure. To close any online help that is currently displayed, click somewhere inside the online help window.
- Press the [Tab] key on your keyboard to select the item that you want help with, then press the [F1] key.
- Right-click the item that you want help with, then click [What's This?] from the pop-up menu.
- Click [?] (Help) on the title bar, then move the mouse pointer with attached [?] over the item you want help with and click on it.

**[Page Setup] Sheet**
The [Page Setup] sheet allows you to specify the following printing preferences:
[Page Size]
Open the [Page Size] drop-down list, then select the desired page size by clicking it.

The page sizes that can be selected are as follows:

- Standard paper sizes (sizes from A3 to A5 and from Legal to Executive)
- Index Card
- Envelopes (Envelope C5, Envelope COM10, Envelope DL, Envelope Monarch)
- Custom Paper Size (See p. 4-39)

NOTE
If the paper size specified in [Page Size] is larger than the size that can be loaded in the printer and [Output Size] is set to [Match Page Size], A3 and B4 size pages will be reduced and printed on A4 size paper.

[Output Size]
Open the [Output Size] drop-down list, then select the desired paper size.

The paper sizes that can be selected are as follows:

- Match Page Size
- Standard paper sizes (sizes from A4 to A5 and from Legal to Executive)
- Index Card
- Envelopes (Envelope C5, Envelope COM10, Envelope DL, Envelope Monarch)
- Custom Paper Size (See p. 4-39)

NOTE
- When printing on paper that is the same size as [Page Size], select [Match Page Size].
- If you select a paper size that differs from [Page Size], the print will be automatically reduced or enlarged to fit on the paper.
- When printing data in which multiple paper sizes are specified in the application, set the [Output Size] setting in the printer driver to a specific size to print all of the pages at a uniform size.
- If you can specify the page size, print copies, and orientation in your application, you do not have to specify the settings in the [Page Setup] sheet.

[Copies]
Allows you to specify the number of copies to print.

You can click on the up and down arrows to change the [Copies] setting or type a value directly into the box. The number of copies can be set to between 1 and 999.

[Orientation]
Allows you to select either portrait orientation or landscape orientation.

Click on either [Portrait] or [Landscape] to change the [Orientation].
**[Page Layout] (See p. 4-34)**

- **N Pages per Sheet**
  Multiple pages can be printed on one sheet of paper.
  The number of pages that can be selected is 1, 2, 4, 6, 8, 9, or 16 (Pages per Sheet).
  If you select 2, 4, 6, 8, 9, or 16 (Pages per Sheet), the [Page Order] drop-down list appears, allowing you to specify the page order.

- **Poster**
  Magnifies a single page image and prints it out over several sheets of paper.
  The number of pages that can be selected is 2 x 2, 3 x 3, or 4 x 4.

**[Manual Scaling] / [Page Order] (See p. 4-36)**

- **The [Manual Scaling] setting is displayed if the [Page Layout] is set to 1 page per sheet.**

- **The [Page Order] setting is displayed if the number of pages per sheet is 2, 4, 6, 8, 9 or 16.**

  - Manual Scaling: The scale factor is automatically adjusted if the [Page Size] and [Output Size] are different. If you want to change the scale factor manually, select [Manual Scaling] and enter the numerical scale factor in the adjacent box. The scale factor can be set to between 25 and 200%.

  - Page Order: You can select the page order when printing multiple pages on one sheet of paper.

**[Custom Paper Size] (See p. 4-39)**

- Click [Custom Paper Size] to open the dialog box shown below.

This dialog box allows you to enter the paper length and width when you are printing on custom paper that does not match any of the standard paper sizes.

In Windows 98/Me, up to 30 custom paper sizes can be added. In Windows 2000/XP/Server 2003, the number depends on your system environment.
[Finishing] Sheet

The [Finishing] sheet allows you to specify the following printing preferences.

[Finishing]
You can select the method of finishing the document from the following options:

- Off: Each page is printed repeatedly to give the desired number of copies.
- Collate: The entire document is printed repeatedly to produce the desired number of copies.

[Finishing Details] (See p. 4-41)
Click [Finishing Details] to display the following dialog box.

This dialog box allows you to specify the various options for job processing.

[Advanced Settings] (See p. 4-42)
Click [Advanced Settings] in the [Finishing Details] dialog box to open the following dialog box.
This dialog box allows you to specify detailed finishing settings.

**[Paper Source] Sheet**
You can specify the following printing preferences in the [Paper Source] sheet.

* **[Paper Type]**
  Specifies the type of paper used in the printer.

  Configure this setting as follows:

<table>
<thead>
<tr>
<th>Printer Driver Setting</th>
<th>Paper Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Plain Paper]</td>
<td>Plain Paper (64 to 90 g/m²), Label Paper</td>
</tr>
<tr>
<td>[Plain Paper L]</td>
<td>If the paper curls excessively when you are printing on plain paper (64 to 90 g/m²) with the [Paper Type] setting set to [Plain Paper], try setting the [Paper Type] setting to [Plain Paper L].</td>
</tr>
<tr>
<td>[Heavy Paper]</td>
<td>Heavy Paper (91 to 163 g/m²)</td>
</tr>
<tr>
<td>[Heavy Paper H]</td>
<td>Select this if you want to get improved fixing properties over the results of printing using the [Heavy Paper] setting.</td>
</tr>
<tr>
<td>[Transparency]</td>
<td>Transparencies</td>
</tr>
</tbody>
</table>

* When printing envelopes, index card or custom paper, the printer automatically changes the printing mode to suit the paper type when you change the [Output Size] setting in the [Page Setup] sheet.
* You can only select [Transparency] if the [Output Size] in the [Page Setup] sheet is set to either A4 or Letter size.
**[Quality] Sheet**

The [Quality] sheet allows you to specify the following printing preferences.

- **[Objective]** (See p. 4-44)
  Selecting the appropriate objective for the contents of the job allows you to perform optimum printing.
  - Standard: This mode is best suited to printing documents containing a mixture of text, photographs, and graphics. It produces printouts that match what you see on the screen.
  - Text/Lines: This mode is best suited to printing color text and fine color lines. Color text and fine color lines are printed in solid black.
  - Web Pages: This mode is best suited to printing the images, etc. of a web page. Low-resolution images that would normally print out coarsely or jagged in regular printing modes are printed clearly.

- **[Details]** (See p. 4-45)
  Click [Details] to open the dialog box shown below.

  This dialog box allows you to change the printing settings according to your preferences.
IMPORTANT
Using the toner save mode may decrease print density making printed text look patchy.

■ [Manual Grayscale Settings] (See p. 4-46)
Check this box if you want to customize the grayscale settings. To configure the grayscale settings in detail, click the [Grayscale Settings] button to open the [Grayscale Settings] dialog box.

■ [Grayscale Settings] (See p. 4-46)
Click [Grayscale Settings] to open the dialog box shown below.

This dialog box allows you to specify brightness and contrast used for printing.
[General] Sheet
This sheet displays the printer name and allows you to print a test page.

![Image of General Sheet]

[Details] Sheet (Windows 98/Me only)
This sheet allows you to configure printer port settings, add drivers, modify spooling settings, etc.

![Image of Details Sheet]

Using the Printing Functions 4-27
**[Sharing] Sheet**

This sheet allows you to specify whether or not to share the printer.

**NOTE**
- For Windows 98/Me, the [Sharing] sheet does not appear if [File and printer sharing for Microsoft Networks] has not been added in the network settings. (See p. 3-48)
- For Windows 2000/XP/Server 2003, the [Sharing] sheet does not appear if the network has not been configured. (See p. 3-53)


This sheet allows you to add, delete, and configure the printer port.
[Advanced] Sheet (Windows 2000/XP/Server 2003 only)
This sheet allows you to specify detailed settings, such as the times when the printer is available and the spooling settings.

[Color Management] Sheet (Windows 2000/XP/Server 2003 only)
The [Color Management] sheet is not used by this printer.
This sheet allows you to confirm the access permissions for each user.

NOTE
- On Windows XP Professional, the [Security] sheet is not displayed if the [Use simple file sharing (Recommended)] checkbox is checked in the [View] sheet of the Windows [Folder Options] settings.

[Configuration]/[Device Settings] Sheet
The [Configuration]/[Device Settings] sheet allows you to configure when the Printer Status Windows is displayed, and other settings.
■ [Spooling at Host] (Windows 2000/XP/Server 2003 only)
  You can specify whether spooling is performed at the Host.

■ [Show Icon in the Taskbar] (See p. 4-59)
  When this option is checked, an icon for displaying the Printer Status Window appears in
  the Windows Taskbar.

[Profile] Sheet (Windows 2000/XP/Server 2003 only)
  This sheet allows you to create and add new Profiles and to edit existing Profiles.

- [Profile List]
  Lists the available Profiles.

- [Name]
  Displays the name of the Profile selected in the [Profile List].

- [Comment]
  Displays a comment about the Profile selected in [Profile List].

- [Add] (See p. 4-48)
  Click [Add] to open the dialog box shown below.
This dialog box allows you to enter the [Name], [Icon], [Comment], and printing preferences for a newly added Profile or a Profile that you are editing.

**[Edit] (See p. 4-50)**
Click [Edit] to open the dialog box shown below.

This dialog box allows you to enter the [Name], [Icon], [Comment], and printing preferences for a newly added Profile or a Profile that you are editing.

**[Delete] (See p. 4-50)**
Allows you to delete an added Profile.

**[Import] (See p. 4-50)**
Allows you to import a Profile saved as a file and add it to the printer driver.

**[Export] (See p. 4-51)**
Allows you to save an added or edited Profile as a file.
[Allow Profile Selection]
Allows you to select a Profile from within the [Document Properties] dialog box.

[Allow Setting Edition]
Allows you to add new Profiles that are different from the Profiles previously registered in the [Document Properties] dialog box.

**Preview**

The preview panel on the [Page Setup], [Paper Source], and [Finishing] sheets shows the current printer settings. You can change [Page Layout] and [Finishing] settings by right-clicking on the Preview panel.

The Preview panel functions differently depending on which icon is selected (or ) at the upper left of the Preview panel.

- **When  is selected**
  You can adjust the [Page Layout] setting.

  The [Page Layout] setting changes cyclically between [1 Page per Sheet], [2 Pages per Sheet], and [4 Pages per Sheet] each time you left-click within the document image.

  If you right-click within the Preview panel, you can choose between [1 Page per Sheet], [2 Pages per Sheet], and [4 Pages per Sheet].

- **When  is selected**
  You can adjust the [Finishing] settings.

  If you right-click within the Preview panel, you can choose between [Off] and [Collate].
Printing Multiple Pages on One Sheet

Multiple pages can be printed on one sheet of paper.

1 For Windows 2000/XP/Server 2003, display the [Device Settings] sheet and select [Auto] from [Spooling at Host].
2 Display the [Page Setup] sheet, then set the [Page Layout] setting to the number of pages to print on each sheet of paper.

The number of pages that can be selected is 1, 2, 4, 6, 8, 9, or 16 (Pages per Sheet).

3 The [Page Order] setting is displayed if the number of pages per sheet is 2, 4, 6, 8, 9 or 16. Use this to select the order that pages are printed.
**NOTE**

The options in the [Page Order] drop-down list differ depending on the paper orientation and the number of pages to be printed on each sheet.

4 Confirm the settings, then click [OK].

### Scaling Printer Output

You can choose to scale your document if [Page Layout] is set to [1 Page per Sheet].

The scale factor is automatically adjusted if the [Page Size] and [Output Size] settings are different.

However, the scale factor can also be specified manually.

You can specify a scaling factor of between 25 and 200%.

#### Scaling a Document Automatically

1 Display the [Page Setup] sheet, and set the [Page Size] setting.
2 Specify the paper size in [Output Size].

3 Confirm the settings, then click [OK].

   The scale factor will be set automatically depending on the sizes specified in [Page Size] and [Output Size].

**Scaling a Document Manually**

1 Display the [Page Setup] sheet, and set the [Page Size] setting.

2 Specify the paper size in [Output Size].

3 Place a checkmark next to [Manual Scaling], then enter the scaling factor in the spin box.

4 Confirm the settings, then click [OK].
Poster Printing

You can magnify a single page image and print it out over several sheets of paper. You can then create a large poster-sized printout by taping the multiple sheets of paper together.

1 For Windows 2000/XP/Server 2003, display the [Device Settings] sheet and select [Auto] from [Spooling at Host].
2 Display the [Page Setup] sheet and select [Poster (N x N)] (N = 2, 3, 4) from [Page Layout].

![A layout image of the printout appears in the Preview panel.](image)

3 Confirm the settings, then click [OK].

**IMPORTANT**
- The printing order of each sheet (after being divided into multiple pages) becomes "Upper Left to Right".
- When you perform poster printing, the [Page Order] setting is disabled.

### Specifying a Custom Paper Size (Non-Standard Paper)

It is possible to configure custom paper sizes.

**NOTE**
To specify a custom paper size, you need to open the dialog box shown below.
- For Windows 2000/XP/Server 2003
- For Windows 98/Me
  Open the [Printer Properties] dialog box from the [Printers] folder.
1 Display the [Page Setup] sheet, then click [Custom Paper Size].

![Page Setup dialog box](image)

The [Custom Paper Size Settings] dialog box is displayed.

![Custom Paper Size Settings](image)

2 Configure the following items as needed:

- **[Paper List]:** Displays the names and dimensions of the standard paper sizes and existing custom paper sizes.
- **[Name of Custom Paper Size]:** Enter a name to use for the new custom paper size. You can enter up to 31 characters.
- **[Unit]:** Specify the unit (Millimeter or Inch) to use when entering the dimensions of the custom paper size.
- **[Paper Size]:** Specifies the length and width of the custom paper size (length greater than or equal to width). Paper sizes should be specified in portrait orientation (length greater than or equal to width) and within the user-definable limits.
3 Click [Register].

**NOTE**
In Windows 98/Me, up to 30 custom paper sizes can be added. In Windows 2000/XP/Server 2003, the number depends on your system environment.

4 Confirm the settings, then click [OK].

**Specifying the Finishing Method**
You can specify a variety of options for print processing.

1 Display the [Finishing] sheet, then click [Finishing Details].

The [Finishing Details] dialog box is displayed.
2 Configure the following settings as needed:

[Detect Paper Size in Multi-purpose Tray]:
When this box is checked, a message is displayed and the print job is paused if the [Output Size] setting in the [Page Setup] sheet of the current print job is different from the previous print job.
To print on the paper currently loaded in the printer, click [Resolve Error] in the Printer Status Window.
To print on different paper than the paper currently loaded in the printer, reload the new paper then click [Resolve Error] in the Printer Status Window. However, the first job that you print straight after turning the printer off and on will print onto the currently loaded paper without displaying a message, regardless of the [Output Size] setting.
When this box is unchecked, the job prints on the paper currently loaded in the printer regardless of the [Output Size] setting.

[Rotate Print Data 180 Degrees]:
Rotates the print data by 180 degrees while printing. This function can be used to print on envelopes, index card and other material that can only be fed to the printer in one specific direction.

[Use Skip Blank Pages Mode]:
When this option is checked, blank pages are not output if the job includes blank pages.

3 Click [Advanced Settings] in the [Finishing Details] dialog box.

The [Advanced Settings] dialog box is displayed.
4 Configure the following settings as needed:

[Image Refinement]:
This setting specifies whether or not to apply Image Refinement. When Image Refinement is applied, jagged lines in text and graphics are printed smoothly.

[EMF Spooling]
(Windows 2000/XP/Server 2003 only):
Specifies whether to spool print data in EMF (metafile) format. If this option is selected, print data is spooled in EMF format.

5 Confirm the settings, then click [OK].

The [Finishing Details] dialog box reappears.
Specifying the Print Quality

You can perform optimum printing by simply selecting the appropriate choice from the [Objective] list.

1 Display the [Quality] sheet, then select the [Objective] setting.

[Standard]: This mode is best suited to printing documents containing a mixture of text, photographs, and graphics. This lets you produce printouts that are relatively close to what you see on the screen.

[Text/Lines]: This mode is best suited to printing color text and fine color lines. Color text and fine color lines are printed in solid black.

[Web Pages]: This mode is best suited to printing the images, etc. of a web page. Low-resolution images that would normally print out coarsely or jagged in regular printing modes are printed clearly.

For more detailed settings, click the [Details] button.
The [Detailed Settings] dialog box is displayed.

2 Configure the following settings as needed:

[B & W Halftones]: Select the method for reproducing subtle gradations (halftones) in black-and-white data. [Pattern 1]: Prints using gradation that makes gray and color text appear sharp, while keeping photographic images and diagrams smooth. This mode produces relatively stable printing results. [Pattern 2]: Choose this setting if text, diagrams, tables, graphs, etc. appear exceedingly light or disappear when using [Pattern 1]. In some cases, however, diagrams, tables and graphs may appear even lighter or less smooth than [Pattern 1] using this setting. [None [Solid]]: Prints all colors in black, except for white.

[Print Colored Text and Lines in Black]: Check this box when the color text or thin lines in CAD data etc. drop out or appear broken when printed. You should be able to print thin lines clearly.

[Enable Image Correction]: When image data such as photographic images are enlarged by an application when printed, the printed images can appear rough or jagged. Select this setting to smooth the images when printing this kind of low-resolution data.

[Toner Density]: Adjusts the density of printed toner. Adjust the density by dragging the [Toner Density] slider left or right.

[Use Toner Save]: By using this function, you can reduce the toner consumption of the printer by thinning out the data that is printed.

3 Confirm the settings, then click [OK].
Grayscale Settings

You can customize the grayscale settings.

1 Display the [Quality] sheet, place a checkmark next to [Manual Grayscale Settings], and then click [Grayscale Settings].

The [Grayscale Settings] dialog box is displayed.
2 **Configure the following settings as needed:**

- **[Brightness]:** Adjusts the brightness level used for printing. Drag the [Brightness] slider left or right to adjust the brightness.
- **[Contrast]:** Adjusts the contrast level used for printing. Drag the [Contrast] slider left or right to adjust the contrast.

3 **Confirm the settings, then click [OK].**

The [Quality] sheet reappears.

---

**Working with Profiles**

Profiles make it possible to save or import all the printing preferences specified in the [Page Setup], [Finishing], [Paper Source], and [Quality] sheets at once. It is also possible to add, edit and choose between profiles.

Use the following procedure to save the printing preferences as a [Profile].

Make sure that any one of the [Page Setup], [Finishing], [Paper Source] and [Quality] sheets is displayed, then perform the following procedure.

**NOTE**

- If you are using Windows 98/Me, up to 50 profiles can be created. However, if [Users can customize their preferences and desktop settings. Windows switches to your personal settings when you log on.] is selected in the [User Profiles] sheet of the Windows password settings (double-click [My Computer] ➞ [Control Panel] ➞ [Passwords]), then you can create up to 50 profiles for each user.
- For Windows 2000/XP/Server 2003, up to 50 Profiles can be added for each user account.
- If you change the name of the printer, any saved profiles will become unreadable. If you restore the printer name to the original value, you will be able to read the profiles again.
- Profile data will not be erased even if you uninstall the printer. You will be able to use the profiles again after you reinstall the printer driver.
- The Profile information files saved on Windows 98/Me cannot be used on Windows 2000/XP/Server 2003 and vice versa.
- Selecting a Profile does not change the [Page Size] setting.
Adding a Profile

1. Configure the printer settings that you want to register using each of the [Page Setup], [Finishing], [Paper Source], and [Quality] sheets.

2. Click [ ] (Add Profile).

   The [Add Profile] dialog box is displayed.

3. Enter the name of the Profile in the [Name] field.

   You can select an icon for the profile using the [Icon] setting. If you have any notes you want to make about the profile, enter them in the [Comment] field.

   **NOTE**
   
   You can enter up to 31 characters in the [Name] field and 255 characters in the [Comment] field.
● Confirming the Printer Settings

- Click [View Settings].

- Click [OK] to return to the [Add Profile] dialog box.

4 Click [OK].

The Properties dialog box reappears.

Check that the name of the Profile has been added to the [Profile] list.
Editing/Deleting a Profile

You can change or save Profile information or delete it from the [Profile List].

1. Click [ ] (Edit Profile).

   The [Edit Profile] dialog box is displayed.

2. Edit the Profile information.
● Editing a Profile

- You can change the [Name], [Icon], and [Comment] settings.
- You can change the order of the selected profile by clicking [ ] and [ ].
- When [Import] is clicked, the Profile information is imported from the previously saved file.
- Click [Export] to save the data from the currently selected profile to a file. If you save a profile to disk, you will be able to use it again even after you delete it from the list of profiles.
- If the [Apply Settings from Application] checkbox is ticked, the [Page Size], [Orientation] and [Copies] selected in the application will be used for printing. Even if you change these settings in the profile, the values from the application will still be used.

● Deleting a Profile

- Click [Delete] to delete a profile from the list.

**IMPORTANT**

You can only delete custom profiles. The pre-installed default profiles cannot be deleted. You are also unable to delete a profile if it is currently selected on any of the property sheets.
Editing Print Jobs

PageComposer allows you to combine 2 or more print jobs into a single job for printing, or modify the printer settings of combined jobs for printing. You can also edit jobs from different applications and preview print jobs.

Make sure that any one of the [Page Setup], [Finishing], [Paper Source], or [Quality] sheet is displayed in the [Document Properties] dialog box, then perform the following procedure:

1. **Set the [Output Method] to [Edit and Preview].**

![Image of PageComposer settings dialog box showing Output Method set to Edit and Preview]

2. **The message that the output method is going to be switched to the [Edit and Preview] mode is displayed. Click [OK].**

![Image of Printer Information dialog box showing message about changing output method]
3 Specify the printing preferences in each sheet, then click [OK].

![Screenshot of Canon LBP-2900 Properties dialog box]

The [Print] dialog box reappears.

4 Click [OK].

Click on the [Print] button depending on the application software that you are using. The [Canon PageComposer] dialog box is displayed and the job is displayed on a list.

5 Repeat Step 1 to 4 for each of the jobs that you want to edit.

6 In the [Canon PageComposer] dialog box, you can edit the jobs in the list.

NOTE
• For details on adjusting settings in the [Canon PageComposer] dialog box, refer to the Canon PageComposer online help.
• If you select [Edit and Preview] mode in the [Printer Properties] dialog box and select [ ] (Lock), the [Canon PageComposer] dialog box will appear every time you print.
Viewing Printer Settings/Restoring the Default Settings

You can view a summary of the printing preferences specified in the [Page Setup], [Finishing], [Paper Source], [Quality], and [Configuration]/[Device Settings] sheets, or restore the settings to their default values.

Make sure that any one of the [Page Setup], [Finishing], [Paper Source] and [Quality] sheets is displayed, then perform the following procedure.

NOTE
A preview is displayed on each sheet. You can use the preview to verify the printed image.

Viewing Printer Settings

1. Click [View Settings].

The [View Settings] dialog box is displayed.
You can click on the [Page Setup], [Finishing], [Paper Source], [Quality], or [Configuration]/[Device Settings] tabs to view a list of printing preferences for each sheet.

2 Click [OK].

The previous sheet reappears.

**Restoring the Default Settings**

Click [Restore Defaults] to restore the printer settings to their default values.

The [Restore Defaults] button only restores to default the settings that are displayed on the same sheet or dialog box as the button.

The settings in the [Page Setup], [Finishing], [Paper Source], [Quality] and [Configuration]/[Device Settings] sheets cannot be restored all at once to the default settings.
Printer Status Window

The Printer Status Window shows status information about the LBP2900/2900i (such as operating status and job information) using messages, animations, sounds, and icons.

NOTE
In order to use the sounds, your computer must be equipped with a PCM synthesizer, and have the driver for the PCM synthesizer installed.
Using the Printer Status Window

The functionality of the Printer Status Window is the same on both Windows 98/Me and Windows 2000/XP/Server 2003.

Refer to the online help for more details on using the Printer Status Window.

Menu Bar

[Job] Menu
Used to pause, resume and cancel print jobs. If a job is paused for some reason, you can resume the job by selecting [Resolve Error]. The buttons appear grayed out if you do not have access permissions to the current print job.

[Options] Menu
Allows you to change the preferences for the Printer Status Window, and clean the fixing rollers on the printer.

[Help] Menu
Displays the online help.
■ Other Functions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Displays an icon representing the current printer status.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message Area</td>
<td>Displays the current printer status using a short message.</td>
</tr>
<tr>
<td>Message Area (Auxiliary)</td>
<td>Displays additional information when an error occurs, etc.</td>
</tr>
<tr>
<td>Animation Area</td>
<td>Displays a graphical representation of the current printer status. The background color is normally blue, but changes to orange when the printer requires some kind of attention, and to red during a warning.</td>
</tr>
<tr>
<td>Refresh Button</td>
<td>Obtains the current printer status and refreshes the Printer Status Window display.</td>
</tr>
<tr>
<td>Resolve Error Button</td>
<td>Allows you to resume a job when the job is paused for some reason.</td>
</tr>
<tr>
<td>[Current Print Job] Tab</td>
<td>Progress Bar: Indicates the progress of the current job by showing the number of pages printed and changing the background color.</td>
</tr>
<tr>
<td>[Pause Job] Button</td>
<td>Pauses the job temporarily.</td>
</tr>
<tr>
<td>Job Information Area</td>
<td>Displays the document name, user name, and computer name for the job.</td>
</tr>
<tr>
<td>[My Job Operation] Tab</td>
<td>Job Status Message Area: Displays a message about the status of the job.</td>
</tr>
<tr>
<td>Job Operation Buttons</td>
<td>Used to pause, resume and cancel print jobs. The buttons appears grayed out if you do not have access permissions to the current print job.</td>
</tr>
<tr>
<td>Job Information Area</td>
<td>Displays the [Document Name], [User Name], [Computer Name], and status of the job.</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Indicates how the printer is connected (Local or Network). Descriptions of each of the menu items are displayed here as you navigate through the menus.</td>
</tr>
</tbody>
</table>
Displaying the Printer Status Window

The Printer Status Window can be opened in the following two ways.

- Click [ ] (Display Printer Status Window) in locations such as the [Page Setup] sheet in the [Printer Properties] dialog box.

- Check the [Show Icon in the Taskbar] box in the [Configuration]/[Device Settings] sheet in the [Printer Properties] dialog box. A Printer Status Window icon is then shown in the Windows Taskbar, and you can click on this icon, then click [Canon LBP2900] to open the window.
The Printer Status Window is automatically displayed during printing and if an error occurs. If [Display Printer Status Window] is not set to [When Starting Printing] in the [Preferences] of the [Options] menu in the Printer Status Window, the Printer Status Window will not be displayed during printing. (See "Setting Preferences," on p. 4-60.)

### The Options Menu

This menu allows you to change the preferences for the Printer Status Window and clean the fixing rollers on the printer.

#### Setting Preferences

The Preferences menu item allows you to display the Printer Status Window automatically, specify the sound settings, and make the Printer Status Window monitor the printer status.

##### [Display Printer Status Window] Group

- **When Starting Printing (Default Value)**
  The Printer Status Window appears automatically each time printing starts.

- **Only when Errors Occur**
  The Printer Status Window appears automatically only when an error occurs during printing.

- **Not Display Automatically**
  The Printer Status Window will not automatically appear, even if printing starts or an error occurs.

- **Always Display on Top**
  The Printer Status Window is always on top of all the other windows on the desktop.

##### [Monitor Printer Status] Group

- **Only while Displaying Printer Status Window (Default Value)**
  The Printer Status Window monitors the printer status only while it is displayed.

- **Only while Printing**
  The Printer Status Window only monitors the printer status during printing.

- **Always**
  The Printer Status Window always monitors the printer status.

##### [Tone Settings] Group

- **Enabled All (Default Value)**
  A sound is played whenever a message is displayed.

- **Enable only when Error Occurs**
  A sound is played only when an error occurs.

- **Disabled**
  No sounds are played.
1 Select [Preferences] from the [Options] menu.

The [Preferences] dialog box is displayed.

2 Confirm the settings, then click [OK].

NOTE
For detailed information on using the Printer Status Window, refer to the online help.
[Cleaning]
You should clean the printer whenever you replace the toner cartridge or when you see black spots appearing on the front or back of the paper. Refer to "Cleaning," on p. 5-14 for more details.

[Refresh]
Selecting [Refresh] from the [Options] menu obtains the latest printer status and refreshes the Printer Status Window display.

You can also refresh the display by clicking [ ] (Refresh) in the Printer Status Window.

[Resolve Error]
If a job is paused for some reason, you can resume the job by selecting [Resolve Error] from the [Job] menu. However, resuming a job by selecting [Resolve Error] may cause unexpected print results. You cannot use [Resolve Error] in any of the following circumstances:

• When the job is paused due to printer errors such as paper jams or paper-out
• When another user's job is paused ([Resolve Error] is available in the print server if the printer is shared on a network)

You can perform the same action by clicking [ ] (Resolve Error) in the Printer Status Window.

IMPORTANT
If a message that says "Insufficient Disk Space" is displayed, delete any unnecessary files, then select [Resolve Error].
### Displaying Printer Status When Using a Print Server

The status of a network printer can be displayed on the client's Printer Status Window as well as on the print server's.

If the print server is not started yet, the Printer Status Window is not displayed on the client computer.

**• Printer Status at the Print Server**

- Printer Status Window Display and Job Operation

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Information Area</td>
<td>[Pause Job] Button</td>
<td></td>
</tr>
<tr>
<td>Displays the first job</td>
<td>Enabled*1</td>
<td>Pause Job:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Pauses all the jobs</td>
</tr>
<tr>
<td></td>
<td>Displays the first job*2</td>
<td>Resume Job:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Resumes all the jobs</td>
</tr>
<tr>
<td></td>
<td>Enabled</td>
<td>Delete Job:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Deletes the first job</td>
</tr>
</tbody>
</table>

*1: The [My Job Operation] tab is displayed when you click the [Pause Job] button.
*2: If a job has been printed from the print server, that job is displayed.

- Plays sounds.

- If the print server is running on Windows 2000/XP/Server 2003, the status is not displayed when no one is logged on. (You still can print now.)

**• Printer Status at the Client**

- Printer Status Window Display and Job Operation

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Information Area</td>
<td>[Pause Job] Button</td>
<td></td>
</tr>
<tr>
<td>Displays the first job</td>
<td>When your job is</td>
<td>Pause Job:</td>
</tr>
<tr>
<td></td>
<td>displayed in Job</td>
<td>Pauses all your jobs</td>
</tr>
<tr>
<td></td>
<td>Information Area:</td>
<td>Resume Job:</td>
</tr>
<tr>
<td></td>
<td>Enabled*</td>
<td>Resumes all your jobs</td>
</tr>
<tr>
<td></td>
<td>When another</td>
<td>Delete Job:</td>
</tr>
<tr>
<td></td>
<td>user's job is</td>
<td>Deletes your first job</td>
</tr>
<tr>
<td></td>
<td>displayed in Job</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Information Area:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Disabled</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Displays your first job</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Enabled</td>
<td></td>
</tr>
</tbody>
</table>

*: The [My Job Operation] tab is displayed when you click the [Pause Job] button.
- You cannot use the [ ] (Resolve Error) button when another user's job is paused.
- While another user's job is being printed, the progress bar is displayed in gray.
- Sounds are only played on the clients that match the user name.

NOTE
To display the printer status when printing a job over the network, a network environment that uses one of the following protocols is required.
- TCP/IP
- NetBEUI
The printer status cannot be displayed only if you are using the IPX/SPX protocol.
Routine Maintenance

This chapter describes the procedures for maintaining the printer such as replacing the toner cartridge and taking care of the printer.

- Replacing the Toner Cartridge .................................................. 5-2
  - Before Replacing the Toner Cartridge ...................................... 5-2
  - Replacing the Toner Cartridge ................................................. 5-7
  - Cleaning .................................................................................. 5-14
  - Precautions for Handling the Toner Cartridge .......................... 5-16
  - Storing Toner Cartridges ....................................................... 5-18

- Clean the outside of the printer .................................................. 5-19

- Moving the Printer ........................................................................ 5-21
  - Moving the Printer .................................................................. 5-22

- Handling the Printer ..................................................................... 5-26
  - Precautions for Handling the Printer ....................................... 5-26
  - Precautions for Storing the Printer ......................................... 5-27
Replacing the Toner Cartridge

This section describes how to replace and handle the toner cartridge and precautions on storing it.

Contact the store where you purchased the printer to obtain replacement toner cartridges.

**IMPORTANT**

Even when the toner cartridge is nearing the end of its life, there are no messages displayed on the computer. If white stripes appear lengthways along the paper, or if the printed text becomes faint or patchy, you may need to replace the toner cartridge. When replacing toner cartridges, only use toner cartridges that are specifically designed for this printer.

**NOTE**

The lifetime of the toner cartridges for this printer (Canon Genuine Parts) is approximately 2000 sheets of A4 prints. This page count is for standard printing (page coverage: approx. 5%, print density: factory default setting). The level of toner consumption varies depending on the type and content of documents printed. Because documents that contain few areas of white space, such as figures, tables and graphs, consume larger amounts of toner, toner cartridge life will be reduced if you print large amounts of this kind of document.

**Before Replacing the Toner Cartridge**

Toner cartridges are consumable parts. If there is not enough toner in the toner cartridge, white stripes will appear lengthways on the paper and printed text will appear faint or patchy. If you experience any of these symptoms, try the following actions before replacing the toner cartridge. This may allow you to print for a while longer until the toner is completely spent.

**CAUTION**

Be careful to avoid staining your clothes or hands with toner. If you do get any toner on your clothes or hands, wash it off immediately with cold water. If you rinse using hot water the toner may become fixed, creating a stain that cannot be removed.
O IMPORTANT

Never touch any of the high voltage parts inside the top cover. Doing so may damage the printer.

1 Open the top cover.

Grasp the groove on the right side of the top cover and open the cover until it stops.
2 Lift the toner cartridge in the direction of the arrows 1, then pull it out 2.

IMPORTANT
• If you touch the inner drum with your hand or scratch it, the printing quality will be degraded. Do not touch or open the protective shutter of the drum under any circumstances. Be careful not to hold or touch any parts other than as directed. Doing so may damage the toner cartridge.
• Do not expose the toner cartridge to direct sunlight or strong light.

3 Hold the toner cartridge as shown in the figure, and roll it gently from side to side 5 or 6 times to evenly distribute the toner inside.

Be careful not to spill the toner.

IMPORTANT
• If toner is not distributed evenly, the printing quality may be reduced. Make sure you perform this step.
• Rotate the toner cartridge gently. If you do not rotate the cartridge gently, toner may spill out.
• Be careful not to hold or touch sensitive areas such as the sensor or electrical contacts. Doing so may damage the toner cartridge.
4 Align the protrusions on the left and right ends of the toner cartridge with the toner cartridge guides in the main printer, and push the cartridge all the way to the back ①, then pull it down towards you ②.
5 Close the top cover.

**IMPORTANT**
- If you cannot close the top cover, check that the toner cartridge is installed properly in the printer. If you close the top cover forcefully, the printer may be damaged.
- Do not leave the top cover open for a long time after installing the toner cartridge.

If the printing remains patchy even after following these steps, you should replace the toner cartridge with a new cartridge.

### Replacing the Toner Cartridge

Use the following procedure to replace the toner cartridge with a new cartridge.

You should clean the printer after you replace the toner cartridge. Refer to "Cleaning," on p. 5-14 for details on cleaning the printer.

**WARNING**
Do not put spent toner cartridges into a fire. Any toner remaining in the toner cartridge may ignite, causing burns or fire.

**CAUTION**
Be careful to avoid staining your clothes or hands with toner. If you do get any toner on your clothes or hands, wash it off immediately with cold water. If you rinse using hot water the toner may become fixed, creating a stain that cannot be removed.

**IMPORTANT**
- Only use the toner cartridge designed for this printer.
Never touch any of the high voltage parts inside the top cover. Doing so may damage the printer.

1. **Open the top cover.**

   Grasp the groove on the right side of the top cover and open the cover until it stops.
2 Lift the toner cartridge in the direction of the arrows ①, then pull it out ②.

3 Take the new toner cartridge out of the protective bag.

As there is a notch cut into the protective bag near the arrow, you can tear open the bag by hand. However, if you are unable to tear open the bag by hand, you should use scissors to cut the bag open to avoid damaging the toner cartridge.
**IMPORTANT**

• Do not throw away the toner cartridge protective bag. You will need this cover when you remove the toner cartridge for printer maintenance, etc.

• If you touch the inner drum with your hand or scratch it, the printing quality will be degraded. Do not touch or open the protective shutter of the drum under any circumstances. Be careful not to hold or touch any parts other than as directed. Doing so may damage the toner cartridge.

![Drum Protective Shutter](image1)

• Do not expose the toner cartridge to direct sunlight or strong light.

![Sunlight](image2)

4 Hold the toner cartridge as shown in the figure, and roll it gently from side to side 5 or 6 times to evenly distribute the toner inside.

![Toner Cartridge Rolling](image3)

**IMPORTANT**

• If the toner is not distributed evenly, you may get poor printing quality. Make sure you perform this step.

• Rotate the toner cartridge gently. If you do not rotate the cartridge gently, toner may spill out.
• Be careful not to hold or touch sensitive areas such as the sensor or electrical contacts. Doing so may damage the toner cartridge.

5 Place the toner cartridge on a flat surface, then slowly pull out the sealing tape (approx. 50 cm in length) while supporting the toner cartridge.

Pull the sealing tape out directly in the direction of the arrow.

CAUTION
If you pull on the sealing tape with excessive force or stop pulling midway, toner may spray from the tape. If toner gets into your eyes or mouth, wash it out immediately with cold water and consult a doctor.

IMPORTANT
• Do not bend the tape or pull it up or down. If you do, the sealing tape may break in the middle, and you won’t be able to fully remove it.

• Keep pulling on the tape until it is fully removed from the cartridge. If any sealing tape is left inside the toner cartridge, you may experience printing problems.
• When pulling out the sealing tape, be careful not to hold the drum protective shutter with your hands.

![Drum Protective Shutter](image)

• After removing the packing materials, install the toner cartridge in the printer as soon as possible.
• Dispose of the sealing tape according to local regulations.
6 Align the protrusions on the left and right ends of the toner cartridge with the toner cartridge guides in the main printer, and push the cartridge all the way to the back ①, then pull it down towards you ②.
7 Close the top cover.

![Image of printer with top cover open]

**IMPORTANT**
- If you cannot close the top cover, check that the toner cartridge is installed properly in the printer. If you close the top cover forcefully, the printer may be damaged.
- Do not leave the top cover open for a long time after installing the toner cartridge.

You should now clean the printer. (See "Cleaning," on p. 5-14)

---

### Cleaning

You should clean the printer after you replace the toner cartridge.

1 **Load a sheet of A4 (or Letter) size white paper into the multi-purpose tray or manual feed tray.**

2 **Open the Printer Status Window.**

Refer to "Displaying the Printer Status Window," on p. 4-59 for details on opening the Printer Status Window.

3 **Select [Cleaning] from the [Options] menu.**
4 Click [OK].

The message "Cleaning" appears in the Printer Status Window, and cleaning begins.

Cleaning is finished when the paper ejects from the printer and the message disappears.

NOTE
• Cleaning takes approximately 3 minutes.
• Cleaning cannot be interrupted. Wait until the cleaning is finished.

Precautions for Handling the Toner Cartridge

The toner cartridge is constructed from precision mechanical parts. Handling the cartridge roughly can damage it or cause deterioration of printing quality. Whenever you are installing or removing toner cartridges, take care of the following handling precautions.

WARNING
Do not put spent toner cartridges into a fire. Any toner remaining in the toner cartridge may ignite, causing burns or fire.

CAUTION
Be careful to avoid staining your clothes or hands with toner. If you do get any toner on your clothes or hands, wash it off immediately with cold water. If you rinse using hot water the toner may become fixed, creating a stain that cannot be removed.
IMPORTANT

• If you touch the inner drum with your hand or scratch it, the printing quality will be degraded. Do not touch or open the protective shutter of the drum under any circumstances. Be careful not to hold or touch any parts other than as directed. Doing so may damage the toner cartridge.

![Drum Protective Shutter](image)

• Do not expose the toner cartridge to direct sunlight or strong light.

![Electrical Contacts](image)

• Be careful not to hold or touch sensitive areas such as the sensor or electrical contacts. Doing so may damage the toner cartridge.

![Electrical Contacts](image)

• Whenever you are handling the toner cartridge, hold it as shown in the diagram, and keep the surface marked with the arrow facing up. Do not stand it on its end, or turn it upside down.
- Do not attempt to disassemble or modify the toner cartridge.
- If you expose a toner cartridge to rapid changes in temperature, droplets of water (condensation) may form on the interior and exterior of the cartridge. If a new toner cartridge that has been stored in a cool location is going to be installed in a warm area, leave the cartridge for at least one hour without opening the protective bag to allow the cartridge to adjust to the surrounding temperature before opening the bag.
- Be sure to use new toner cartridges within the expiration date indicated on the package.
- Keep toner cartridges away from products that generate magnetic waves, such as the computer or monitor.
- Toner cartridges are magnetic parts. Do not bring toner cartridges near floppy disks, disk drives, or other magnetic-sensitive devices. Doing so may cause data corruption.

## Storing Toner Cartridges

Be careful of the following points when storing a new toner cartridge or handling a toner cartridge that has been taken out of the printer for maintenance or moving the printer.

### IMPORTANT
- Do not take a new toner cartridge out of the protective bag until it is ready to be used.
- If you take the toner cartridge out of the printer to remove a paper jam or service the printer, place the toner cartridge into the original protective bag, or wrap it in a thick cloth immediately.
- Do not stand it on its end, or turn it upside down. Store the cartridge in the same direction as when it is installed in the printer.
- Do not store the toner cartridge in a place exposed to direct sunlight.
- Do not store the toner cartridge in a hot or humid place, or a place where the temperature and humidity can change significantly.
  - Storage Temperature Range: 0 to 35°C (32 to 95°F)
  - Storage Humidity Range: 35 to 85%RH (non-condensing)
- Do not store the toner cartridge in a place where corrosive gases, such as ammonia, are generated, or where a considerable amount of salt is contained in the air, or where there is a lot of dust.
- Keep toner cartridges out of the reach of small children.
- Do not store toner cartridges near floppy disks, disk drives, or other magnetic-sensitive devices.

### Condensation

Even when the humidity is within the storage range, water droplets may form on the inside or outside of the toner cartridge due to temperature differences with the surrounding air. This condensation will have a bad effect on the performance of the toner cartridge.
Clean the outside of the printer

If dirt and dust builds up on the outside of the main unit after you use the printer for a long period of time, you should clean the printer. To avoid damage to the printer and electrical shocks while cleaning, observe the following precautions when cleaning.

**WARNING**

- Turn the printer off and remove the plug from the wall when you are cleaning the printer. Failure to do so may cause fire or electrical shock.
- Do not use alcohol, benzene, thinners or any other inflammable substance. If an inflammable substance comes into contact with the electrical unit inside the printer it may ignite or cause an electrical shock.

**IMPORTANT**

- Be careful not to use a cleaning agent other than water or a mild detergent mixed with water as it may deform or crack the plastic materials in the printer.
- When using a mild detergent, be sure to dilute it with water.
- This printer does not need to be lubricated. Do not lubricate the printer.

1. **Turn the printer and computer off ①, remove the USB cable ②, and disconnect the power plug from the power outlet ③.**
2 Firmly wring a soft cloth dampened with water or a mild detergent diluted with water, and wipe off the dirt.

If you use a mild detergent for cleaning, be sure to wipe away the detergent with a soft cloth dampened with water.

3 After wiping off the dirt, wipe the printer with a dry cloth.

4 Once the printer is completely dry, plug the power plug into the power outlet and reconnect the USB cable.
Moving the Printer

When changing the location of the printer or moving the printer for maintenance, be sure to use the following procedure.

⚠️ WARNING
When you are moving the printer, always turn the printer off, unplug the power plug, and remove the USB cable. If you move the printer without unplugging the cables, the electrical cord and USB cable may be damaged, causing a fire or electrical shock.

⚠️ CAUTION
• The printer weighs approximately 6.3 kg when the toner cartridge is not installed. Take care to carry the printer without hurting your back.
• Never hold the printer by the front panel, ventilation slots, rear panel, or anywhere else other than the specified locations. Doing so may cause the printer to fall, resulting in personal injury.
Moving the Printer

Use the following procedure to move the printer.

1. Turn the printer and computer off ①, remove the USB cable ②, and disconnect the power plug from the power outlet ③.

2. Remove the power cord.

3. Clear out any paper that is loaded in the printer, and push the rear paper guide in to the position shown in the diagram.
IMPORTANT

If you try to close the multi-purpose tray while the rear paper guide is sticking out of the tray, you may damage the printer. Always check to make sure that rear paper guide is pushed all the way back into the multi-purpose tray before you close the multi-purpose tray.

4 Close the multi-purpose tray.

5 If the paper output tray is open, close it.
6 Grasp the left and right side of the printer with your hands, as shown in the diagram, and firmly hold onto the printer when you carry it.

7 Put the printer down carefully at the installation site.

⚠️ CAUTION
Put the printer down slowly and carefully. You may be injured if your hands, etc. are pinched by the printer.

8 Open the output tray.
9 Open the multi-purpose tray.

10 Load the Paper

Refer to "Printing on Index Card," on p. 2-26 for information on loading index card.
Refer to "Printing on Envelopes," on p. 2-33 for information on loading envelopes.
Refer to "Printing on Custom Paper Sizes (Non-Standard Sizes)," on p. 2-44 for information on loading custom paper sizes.

11 Connect the power cord.

12 Plug the power plug into the AC power outlet.

13 Connect the USB cable.

● Transporting the Printer

When transporting the printer for reasons such as relocating, remove the toner cartridge and store the printer and parts in the packages that they came in with the protective materials attached in order to prevent them from being damaged while being transported.
If the original package and packing materials are not available, find an appropriate box and packing materials and pack the printer and the parts appropriately.
Handling the Printer

This printer uses a variety of electronic components and delicate optical components. Read the following section carefully, and take care when handling the printer.

**IMPORTANT**

Information on handling the printer is also described in "Important Safety Instructions," on p. xiv.

**Precautions for Handling the Printer**

Observe the following precautions to allow your printer to consistently produce high-quality printing.

**IMPORTANT**

- Do not place any heavy objects on top of the printer, output tray, or other part of the printer. Doing so may damage the printer.

- If you try to close the multi-purpose tray while the rear paper guide is sticking out of the tray, you may damage the printer. Always check to make sure that rear paper guide is pushed all the way back into the multi-purpose tray before you close the multi-purpose tray.

- Do not leave the top cover open for any longer than you need to. Exposure to direct sunlight or strong light can degrade the printer performance.
- Do not shake the printer while it is printing. Doing so may cause the print quality to deteriorate.

- Do not open the top cover of the printing while it is printing. Doing so may damage the printer.
- Open and close the output tray, multi-purpose tray, and the top cover of the printer gently. The printer may be damaged if you are rough.
- If you want to spread a blanket on the printer to prevent dust from entering the printer, turn the power off and allow the printer to cool down sufficiently before covering the printer.
- If you do not plan to use the printer for a long period of time, unplug the power cord from the AC power outlet.
- Do not use or store the printer in a room where chemicals are used.
- The area around the output tray becomes very hot during printing and directly after printing. When you are collecting paper from the output tray or clearing a paper jam, be careful not to touch the area around the output tray.

**Precautions for Storing the Printer**

If you do not plan to use the printer for a long period of time, store it in the following environment:

- Storage Temperature Range: 0 to 35°C (32 to 95°F)
- Storage Humidity Range: 10 to 80%RH (non-condensing).
This chapter describes the remedies for problems such as paper jams or poor print quality.

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Troubleshooting Map</td>
<td>6-2</td>
</tr>
<tr>
<td>Paper Jams</td>
<td>6-3</td>
</tr>
<tr>
<td>Service Call</td>
<td>6-18</td>
</tr>
<tr>
<td>When a Fixing Unit Error Appears</td>
<td>6-19</td>
</tr>
<tr>
<td>When a Scanner Error or Service Error Appears</td>
<td>6-20</td>
</tr>
<tr>
<td>Print Quality Problems</td>
<td>6-22</td>
</tr>
<tr>
<td>Paper Problems</td>
<td>6-25</td>
</tr>
<tr>
<td>When Nothing Prints</td>
<td>6-26</td>
</tr>
<tr>
<td>Installation Problems</td>
<td>6-27</td>
</tr>
<tr>
<td>If Uninstallation Fails</td>
<td>6-28</td>
</tr>
<tr>
<td>Uninstalling the USB Class Driver</td>
<td>6-30</td>
</tr>
<tr>
<td>Problems During Local Installation</td>
<td>6-34</td>
</tr>
<tr>
<td>Problems Installing a Shared Printer</td>
<td>6-34</td>
</tr>
<tr>
<td>Miscellaneous Problems</td>
<td>6-35</td>
</tr>
</tbody>
</table>
If you have any problems while you are using the printer, use the flow chart shown below to determine the cause of the problem.

The printer driver cannot be used

Yes

The printer driver is not properly installed

— Chapter 6: Installation Problems (p. 6-27)

No

Cannot Print

Yes

The power cord is not connected

— Chapter 1: Turning the Printer On and Off (p. 1-15)

No

No

An error is displayed in the Printer Status Window

Yes

Follow the directions displayed in the Printer Status Window to resolve the problem

— Chapter 4: Printer Status Window (p. 4-56)

No

The printer is not connected to the computer

— Chapter 1: Connecting to a Computer (p. 1-12)

No

No

The printing quality is poor

Yes

The toner density is set too light

— Chapter 4: Specifying the Print Quality (p. 4-44)

No

The toner is running out

— Chapter 5: Replacing the Toner Cartridge (p. 5-2)

No

The installation environment is bad

— Getting Started Guide

No

No

No

Paper Problems

— Chapter 6: Paper Problems (p. 6-25)

Miscellaneous Problems

— Chapter 6: Print Quality Problems (p. 6-22)
The following message is displayed in the Printer Status Window when a paper jam occurs during printing.

![Printer Status Window with paper jam message]

**WARNING**

There is a high-voltage unit inside this product. When you are clearing paper jams or inspecting the interior of the printer, make sure that no necklaces, bracelets, or other metallic objects come into contact with the inside of the printer. If this does happen, it may cause burns or an electrical shock.

**CAUTION**

- Be careful to avoid staining your clothes or hands with toner while you are clearing a paper jam. If you get any toner on your hands or clothes, wash it off immediately with cold water. Do not rinse with hot water, as this can fix the toner, creating a stain that cannot be removed.
- When you are clearing jammed paper from inside the printer, remove the paper gently so that toner that is on the jammed paper does not spray out of the printer. This could lead to toner getting in your eyes or mouth. If toner gets into your eyes or mouth, wash it out immediately with cold water and consult a doctor.
- When removing jammed paper, take care not to cut your hands with the edges of the paper.
• The area around the fixing unit inside the printer becomes hot during use. If you are inspecting the inside of the printer while you are clearing a paper jam, etc., take care not to touch the area around the fixing unit. Doing so can cause burns.

• Keep your hands or clothing away from the roller in the output area after removing jammed paper completely. Even if the printer is not printing, sudden rotation of the roller may catch your hands or clothing, resulting in personal injury.

**IMPORTANT**

- Never touch any of the high voltage parts inside the top cover. Doing so may damage the printer.

- If you tug too hard on jammed paper, the paper can tear and the internal components may be damaged. When you pull out jammed paper, pull it out in the correct direction depending on the location of the jam.

- If paper is torn, be sure to find and remove any remaining pieces of paper.

- If you clear the jammed paper without opening the top cover, the error message may not clear. In this case, open and close the top cover once.
• Do not touch the transfer roller under any circumstances. Doing so may cause the print quality to deteriorate.

![Transfer Roller](image)

• Do not touch the paper feed roller under any circumstances. Doing so may cause the paper feed mechanism to malfunction.

![Paper Feed Roller](image)

• The area around the output tray becomes very hot during printing and directly after printing. When you are collecting paper from the output tray or clearing a paper jam, be careful not to touch the area around the output tray.

![Output Tray](image)
1 Open the top cover.

Grasp the groove on the right side of the top cover and open the cover until it stops.

**IMPORTANT**

Even if you can see the jammed paper from the output tray, do not pull on the paper. Make sure you open the top cover and remove the toner cartridge before attempting to clear the jam.
2 Lift the toner cartridge in the direction of the arrows ①, then pull it out ②.

**IMPORTANT**
- If you touch the inner drum with your hand or scratch it, the printing quality will be degraded. Do not touch or open the protective shutter of the drum under any circumstances. Be careful not to hold or touch any parts other than as directed. Doing so may damage the toner cartridge.
• Do not expose the toner cartridge to direct sunlight or strong light.

• Be careful not to hold or touch sensitive areas such as the sensor or electrical contacts. Doing so may damage the printer.

3 Place the toner cartridge into the protective bag.
4 Remove any paper from the multi-purpose tray.

Pull out the rear paper guide ①, and then remove the paper ②.

**IMPORTANT**
Even if the paper is jammed in the multi-purpose tray, do not clear the jam, but continue with the following steps.
5 Removing the jammed paper.

- If you can see the leading edge of the paper inside the printer
  - Gently pull the paper up to clear the jam.
  - If the jam is difficult to clear, pull the paper out from the multi-purpose tray or manual feed tray.
**IMPORTANT**

If you are pulling jammed paper out from the multi-purpose tray or manual feed tray, excess toner may stain the next sheet of paper that you print on.

- **If you can see the tail edge of the paper inside the printer**
  - Hold the paper by both edges and slowly feed it downwards to clear the paper out.
If the paper is difficult to pull out, pull on the leading edge of the paper as shown in the diagram ①, then remove the paper from the output tray side ②.

**IMPORTANT**
If you are pulling jammed paper out from the output tray side, excess toner may stain the next sheet of paper that you print on.
If you cannot see the leading edge or the tail edge of the paper

- Pull out the back end of the paper as shown in the diagram ①, then hold the paper by both edges and feed it slowly down to clear the paper out of the printer ②.
If the paper is difficult to pull out, pull on the leading edge of the paper as shown in the diagram ①, then remove the paper from the output tray side ②.

**IMPORTANT**

If you are pulling jammed paper out from the output tray side, excess toner may stain the next sheet of paper that you print on.
6 Load the paper so that the paper meets the rear paper guide.

If the paper jam occurred while feeding from the manual feed tray, load paper into the manual feed tray.

7 Take the toner cartridge out of the protective bag.
8 Align the protrusions on the left and right ends of the toner cartridge with the toner cartridge guides in the main printer, and push the cartridge all the way to the back \( \text{①} \), then pull it down towards you \( \text{②} \).
9 Close the top cover.

![Diagram of printer with top cover open]

**IMPORTANT**
- If you cannot close the top cover, check that the toner cartridge is installed properly in the printer. If you close the top cover forcefully, the printer may be damaged.
- Do not leave the top cover open for a long time after installing the toner cartridge.
If the printer has some kind of error such that it can no longer function properly, a service call is displayed as follows.

<table>
<thead>
<tr>
<th>Service Call</th>
<th>Cause</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Fixing Unit Error Screen" /></td>
<td>The fixing unit is malfunctioning.</td>
<td>Follow the procedure (see &quot;When a Fixing Unit Error Appears,&quot; on p. 6-19) and contact the store where you purchased the printer.</td>
</tr>
<tr>
<td><img src="image2" alt="Scanner Error Screen" /></td>
<td>The scanner is malfunctioning.</td>
<td>Follow the procedure (see &quot;When a Scanner Error or Service Error Appears,&quot; on p. 6-20), then turn the power off and on.</td>
</tr>
</tbody>
</table>
When a Fixing Unit Error Appears

If a fixing unit error is displayed, follow the procedure below then contact the store where you purchased the printer.

1. **Turn the printer and computer off**, remove the USB cable, and disconnect the power plug from the power outlet.

   ![Diagram showing how to turn off the printer and disconnect the USB cable and power plug.]

   **IMPORTANT**
   If a fixing unit error appears, do not turn the printer on again after you have turned it off.

2. **Contact your local authorized Canon dealer.**

   Describe the problems you are experiencing when you contact the dealer.

---

<table>
<thead>
<tr>
<th>Service Call</th>
<th>Cause</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The printer is malfunctioning.</td>
<td>Follow the procedure (see &quot;When a Scanner Error or Service Error Appears,&quot; on p. 6-20), then turn the power off and on.</td>
</tr>
</tbody>
</table>
When a Scanner Error or Service Error Appears

If a scanner error or service error appears, cycle the power of the printer using the following procedure. This may clear the message.

1. **Turn the power off, wait for at least 10 seconds, then turn the printer on again.**

   ![Power Switch](image)

   If the message does not reappear, continue using the printer as normal. If the message reappears, proceed to the next step.

2. **Note down the error code displayed in the Printer Status Window.**

   ![Printer Status Window](image)
3 Turn the printer and computer off ①, remove the USB cable ②, and disconnect the power plug from the power outlet ③.

4 Contact your local authorized Canon dealer.

When you contact your Canon dealer, please describe the problems that occurred and the error code that you noted down.
Print Quality Problems

If any problem occurs while you are using the printer, take the following measures depending on the symptoms.

### IMPORTANT
- If a message appears in the Printer Status Window, follow the directions given in the message.
- In the case of a paper jam, refer to "Paper Jams," on p. 6-3.
- If a problem occurs that is not described in this section, none of the remedies solve the problem, or you cannot determine the cause of the problem, contact your local authorized Canon dealer.

### White Stripes Appear. (Printed Text is Faint or Patchy)

**Cause**  The toner cartridge is running out of toner.

**Remedy**  Remove the toner cartridge and gentle rock it from side to side 5 or 6 times, then reinsert the cartridge. If the same problem persists, replace the toner cartridge with a new cartridge. (See “Replacing the Toner Cartridge,” on p. 5-2.)

### The overall printing is faint.

**Cause 1**  The [Toner Density] setting is not appropriate.

**Remedy**  Drag the [Toner Density] slider in the printer driver toward [Dark].
In order to change the [Toner Density] setting, click the [Details] button in the [Quality] sheet to open the [Detailed Settings] dialog box.

**Cause 2**  [Use Toner Save] is selected.

**Remedy**  Remove the checkmark from [Use Toner Save] in the printer driver.
In order to change the [Use Toner Save] setting, click the [Details] button in the [Quality] sheet to open the [Detailed Settings] dialog box.

### The overall printing is dark.

**Cause 1**  The [Toner Density] setting is not appropriate.

**Remedy**  Drag the [Toner Density] slider in the printer driver toward [Light].
In order to change the [Toner Density] setting, click the [Details] button in the [Quality] sheet to open the [Detailed Settings] dialog box.
Print Quality Problems

6-23

Troubleshooting

Cause 2  The printer is exposed to direct sunlight or strong light.
Remedy   Move the printer to a location that is not exposed to direct sunlight or strong light. Alternatively, separate the printer from the source of the strong light.

One portion of a page does not print.

Cause 1  The scale factor is incorrect.
Remedy 1 Clear the checkmark from [Manual Scaling] in the printer driver. When this checkbox is cleared, the scaling factor is automatically determined based on the [Page Size] and [Output Size] settings.
In order to update the [Manual Scaling] setting, open the [Page Setup] sheet.

Remedy 2 Place a checkmark next to [Manual Scaling] in the printer driver and specify an appropriate scale factor according to the paper size you are using.
In order to update the [Manual Scaling] setting, open the [Page Setup] sheet.

Cause 2  The paper is loaded in the wrong position.

Cause 3  Data was printed from an application with the margin settings set outside the printable area of the printer.
Remedy   The printable area of the printer is bounded by margins of 4 mm at the top, 6 mm at the bottom, and 5 mm on the left and right (for index card and envelopes, the top, bottom, left and right margins are all 10 mm). Make sure you have made sufficiently large margins in your data.

The front or back of printouts is stained with black dots.

Cause    The fixing unit is dirty
Remedy   Perform cleaning. (See "Cleaning," on p. 5-14.)

The printing position is misaligned.

Cause    The [Top Margin] and [Paper Position] settings in the application are configured incorrectly.
Remedy   Update the [Top Margin] and [Paper Position] settings in the application. (See Instruction manual for the application.)
### The next page is printed from halfway through the previous page.

<table>
<thead>
<tr>
<th>Cause</th>
<th>The [Line Spacing] or [Lines/Page] settings in the application are not configured correctly.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remedy</td>
<td>Update the [Line Spacing] and [Lines/Page] in the application so that data fits onto one page and print again. (See Instruction manual for the application.)</td>
</tr>
</tbody>
</table>

### Nothing is printed on the paper.

<table>
<thead>
<tr>
<th>Cause 1</th>
<th>The toner cartridge was installed with the sealing tape still attached.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remedy</td>
<td>Remove the toner cartridge, pull away the sealing tape, and reinstall the cartridge. (See &quot;Replacing the Toner Cartridge,&quot; on p. 5-2)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Cause 2</th>
<th>Multiple sheets of paper are feeding at the same time.</th>
</tr>
</thead>
</table>

### The paper comes out completely black.

<table>
<thead>
<tr>
<th>Cause</th>
<th>The drum in the toner cartridge has deteriorated.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remedy</td>
<td>Replace the toner cartridge with a new one. (See &quot;Replacing the Toner Cartridge,&quot; on p. 5-2.)</td>
</tr>
</tbody>
</table>

### Printed pages have white specks.

<table>
<thead>
<tr>
<th>Cause 1</th>
<th>The paper is inappropriate.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remedy</td>
<td>Replace the paper with one of the usable paper types and print again. (See &quot;Paper Requirements,&quot; on p. 2-2.)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Cause 2</th>
<th>The paper is damp because it was stored in poor conditions.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remedy</td>
<td>Replace the paper with new paper and print again.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Cause 3</th>
<th>The drum in the toner cartridge has deteriorated.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remedy</td>
<td>Replace the toner cartridge with a new one. (See &quot;Replacing the Toner Cartridge,&quot; on p. 5-2.)</td>
</tr>
</tbody>
</table>
Paper comes out wrinkled.

**Cause 1**  Paper is loaded in the multi-purpose tray or manual feed tray at an angle.


**Cause 2**  The paper is damp.

**Remedy**  Replace the paper with paper from a new ream.

The paper curls.

**Cause 1**  The paper is inappropriate.

**Remedy**  Replace the paper with paper that can be used with this printer. (See "Paper Requirements," on p. 2-2.)

**Cause 2**  The [Paper Type] setting does not match the loaded paper.

**Remedy**  Set the [Paper Type] in the printer driver to [Plain Paper L].

In order to change the [Paper Type] setting, open the [Paper Source] sheet.

White dust is attached to the printed transparencies.

**Cause**  You printed the transparencies just after continuously printing on another type of paper.

**Remedy**  If you print transparencies after printing continuously on normal paper, paper dust may adhere to the transparencies when they are output. If this is the case, use a soft cloth to wipe off the paper dust.
When Nothing Prints

Check the following items if nothing prints when you print from an application:

1. **Check if any error messages are displayed in the Printer Status Window.**
   
   If there is an error message displayed in the Printer Status Window, follow the directions given in the message. If there are no error messages, proceed to the next step.

2. **Print a test page.**
   

   - **If the test page prints correctly**
     
     You can print from the CAPT software. To check the application software, check that all of the printer settings are configured appropriately.

   - **If the test page does not print**
     
     Uninstall the CAPT software, then reinstall it and print another test page. (See "Uninstalling the CAPT software," on p. 3-72.)
If you cannot install the "USB Class Driver" and "LBP2900/2900i Printer Driver" properly, use the following procedure to check for problems.

1. **Uninstall the USB Class Driver**
   - Chapter 6: Uninstalling the USB Class Driver (p. 6-30)

2. **Uninstall using the uninstaller**
   - Chapter 3: Uninstalling the CAPT Software (p. 3-72)

3. **Reinstall the software**
   - Chapter 3: Installing the CAPT Software (p. 3-4)

4. **Erase [Canon Printer Uninstaller] from [All Programs] on Windows 98/Me/2000 in the [Start] menu**

5. **Uninstall using the uninstaller**
   - Chapter 3: Uninstalling the CAPT Software (p. 3-72)

6. **Reinstall the software**
   - Chapter 3: Installing the CAPT Software (p. 3-4)

7. **Erase [Canon LBP2900] from [Add or Remove Programs] on Windows 98/Me/2000**
   - Chapter 6: If Uninstallation Fails (p. 6-28)

8. **Uninstall using the uninstaller**
   - Chapter 3: Uninstalling the CAPT Software (p. 3-72)

9. **Reinstall the software**
   - Chapter 3: Installing the CAPT Software (p. 3-4)

10. **Yes**
    - Continue with troubleshooting

11. **If you could not uninstall**
    - Chapter 6: If Uninstallation Fails (p. 6-28)

12. **Yes**
    - Continue with troubleshooting

13. **No**
    - Chapter 3: Installing the CAPT Software (p. 3-4)

14. **Yes**
    - Continue with troubleshooting

15. **No**
    - Continue with troubleshooting
If Uninstallation Fails

If you cannot uninstall the CAPT software using the uninstaller that was created during installation, use the following procedure to uninstall the CAPT software from [Add or Remove Programs] ([Add/Remove Programs] for Windows 98/Me/2000).

1. From the [Start] menu, select [Control Panel], and then click [Add or Remove Programs].

   For Windows 98/Me/2000: From the [Start] menu, select [Settings] ➞ [Control Panel], and then click [Add/Remove Programs].

2. Select [Canon LBP2900] in the [Add or Remove Programs] dialog box, then click [Change/Remove].

   For Windows 2000: Select [Canon LBP2900] in the [Add/Remove Programs] dialog box, then click [Change/Remove].
   For Windows 98/Me: Select [Canon LBP2900] in the [Add/Remove Programs] dialog box, then click [Add/Remove].

NOTE

If [Canon LBP2900] does not appear in the [Add or Remove Programs] dialog box (the [Add/Remove Programs] dialog box for Windows 98/Me/2000), perform (see “Uninstalling the USB Class Driver,” on p. 6-30) then reinstall the CAPT software.
3 Select the name of your printer, then click [Delete].

4 Click [Yes].

The uninstallation process begins. Please wait a moment.

5 Click [Exit].

The [Delete Printer] dialog box closes.

6 Restart Windows.
Uninstalling the USB Class Driver

Uninstalling the USB class driver is required when you cannot install the CAPT software properly after uninstalling it once or when you cannot uninstall the CAPT software.

1. **Make sure that the computer is connected to the printer with the USB cable and that the printer is turned on.**

2. **From the [Start] menu, select [Control Panel], and then click [Add or Remove Programs].**
   
   For Windows 98/Me/2000: From the [Start] menu, select [Settings] → [Control Panel], and then click [Add/Remove Programs].

3. **Make sure that [Canon LBP2900] does not appear in the [Add or Remove Programs] dialog box, and then click [X].**
   
   For Windows 98/Me/2000: Make sure that [Canon LBP2900] does not appear in the [Add/Remove Programs] dialog box, and then click [X].

   ![Add or Remove Programs dialog box]

   **NOTE**

   If [Canon LBP2900] is displayed in the [Add or Remove Programs] dialog box (the [Add/Remove Programs] dialog box for Windows 98/Me/2000), refer to (See "If Uninstallation Fails," on p. 6-28.) for the procedure for deleting [Canon LBP2900] from the [Add and Remove Programs] dialog box (the [Add/Remove Programs] dialog box for Windows 98/Me/2000).
4 From the [Start] menu, select [Control Panel], and then click [Performance and Maintenance] → [System].

For Windows 98/Me/2000: From the [Start] menu, select [Settings] → [Control Panel], and then double-click the [System] icon.
For Windows Server 2003: From the [Start] menu, select [Control Panel] → [System].
5 Click [Hardware] → [Device Manager], and then double-click [Universal Serial Bus controllers].

For Windows 98/Me: Display the [System Properties] dialog box, click the [Device Manager] tab, and then double-click [Universal Serial Bus controllers].

6 Select [USB Printing Support], then select [Uninstall] in the [Action] menu.

On Windows 98 select [Canon LBP2900]; and on Windows Me select [Canon CAPT USB Device]; and then click [Remove].
**IMPORTANT**

- You cannot install the printer driver properly if the USB class driver is listed under [Other Devices]. Depending on your OS, select [Canon LBP2900], [Canon CAPT USB Device] or [Unknown Device] and delete it.
- Do not delete any other devices or device drivers. If you delete the wrong thing by mistake, Windows may not be able to startup properly.
- If the USB Class Driver is not installed properly, [USB Printing Support] (on Windows 2000/XP/Server 2003), [Canon CAPT USB Device] (on Windows Me), or [Canon LBP2900] (on Windows 98) will not be displayed.

7 When the [Confirm Device Removal] dialog box appears, click [OK].

8 Click [X].

[Device Manager] closes.

9 Disconnect the USB cable from the computer, then restart Windows.

After Windows restarts, reinstall the CAPT software. (See "Installing the CAPT Software," on p. 3-4.)
Problems During Local Installation

When you install the printer driver from CD-ROM, the printer is not automatically detected even when it is turned on.

**Cause 1** The USB cable has already been connected and the printer is turned on before installing the printer driver.

**Remedy** Turn the printer off then turn it back on again.

**Cause 2** The printer is turned off.

**Remedy** Turn the printer on.

**Cause 3** The USB cable is not connected properly.

**Remedy** Make sure that the printer and computer are connected properly with the USB cable.

**Cause 4** An inappropriate USB cable is being used.

**Remedy** Use a USB cable that matches the USB interface on the printer. The USB interface on this printer is USB 2.0 High-Speed (Windows 2000/XP/Server 2003 only), USB Full-Speed (USB 1.1 equivalent).

**Cause 5** You cannot install from CD-ROM Setup.

**Remedy** Install using Plug and Play. (See "Installing with Plug and Play," on p. 3-10, p. 3-25 or p. 3-37)

Problems Installing a Shared Printer

You cannot find the print server to connect to.

**Cause 1** The print server has not been started up.

**Remedy** Start up the print server.

**Cause 2** The printer is not configured as a shared printer.

**Remedy** Configure the printer as a shared printer using the [Printer Properties] dialog box on the print server.

**Cause 3** You do not have permissions to access the print server or printer.

**Remedy** Ask your network administrator to change the user permissions.
### Miscellaneous Problems

The LBP2900/2900i does not function properly.

<table>
<thead>
<tr>
<th>Cause 1</th>
<th>The LBP2900/2900i is not configured as the default printer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remedy</td>
<td>Set it to the default printer.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Cause 2</th>
<th>The CAPT software may not be installed properly.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remedy</td>
<td>To check whether the CAPT software is installed correctly or not, try printing from an application. If the printing does not work properly, uninstall the CAPT software and then reinstall it (see &quot;Uninstalling the CAPT software,&quot; on p. 3-72, &quot;Installing the CAPT Software,&quot; on p. 3-4).</td>
</tr>
</tbody>
</table>

You cannot use Adobe Type Manager (ATM) Fonts.

<table>
<thead>
<tr>
<th>Cause</th>
<th>You cannot use Adobe Type Manager (ATM) fonts with this printer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remedy</td>
<td>Only use fonts that can be used with this printer.</td>
</tr>
</tbody>
</table>

CD-ROM Setup does not appear automatically.

<table>
<thead>
<tr>
<th>Cause 1</th>
<th>The [Always Display when CD-ROM is Inserted] option is not selected in CD-ROM Setup.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Cause 2</th>
<th>[Auto insert notification] is not selected. (Windows 98/Me only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remedy</td>
<td>Display the properties for the CD-ROM drive from [Device Manager] and select [Auto insert notification] in the [Settings] sheet.</td>
</tr>
</tbody>
</table>

The error message [File not found on CD-ROM.] appears when CD-ROM Setup starts up.

<table>
<thead>
<tr>
<th>Cause</th>
<th>The program is loaded from the hard disk.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remedy</td>
<td>Search for the file [CNAB4MNU.EXE] using the search function of your computer, delete the CNAB4MNU.EXE file from the hard disk, and then start up CD-ROM Setup from the supplied CD-ROM &quot;LBP2900/2900i User Software&quot;.</td>
</tr>
</tbody>
</table>

**Cause 1**  
The [Output Size] setting of the current print job is different from the [Output Size] setting of the previous job.

**Remedy**  
To print on the paper currently loaded in the printer, click [ ] (Error Recovery) in the Printer Status Window. To print on different paper than the paper currently loaded in the printer, reload the new paper then click [ ] (Error Recovery) in the Printer Status Window.

**Cause 2**  
[Detect Paper Size in Multi-purpose Tray] is selected.

**Remedy**  
If you clear the checkmark from the [Detect Paper Size in Multi-purpose Tray] checkbox, printing continues on the paper that is currently loaded in the printer without displaying a message, regardless of the [Output Size] setting. You can adjust the [Detect Paper Size in Multi-purpose Tray] setting in the [Finishing Details] dialog box by clicking [Finishing Details] in the [Finishing] sheet.

If you are using the printer sharing function on your computer, it takes a long time for the Printer Status Window to obtain the printer status.

**Cause**  
If you are using Windows XP Service Pack 2 or another operating system equipped with Windows Firewall as a print server, communication with the client computers is blocked by Windows Firewall.

**Remedy**  
Start the print server and configure Windows Firewall to unblock communications with the client computers. (See "Windows Firewall," on p. 7-8)

When you are using the printer sharing function from the computer, the printer status does not display correctly in the Printer Status Window.

**Cause**  
The client computer is installed with an operating system equipped with Windows Firewall, such as Windows XP Service Pack 2, and Windows Firewall is blocking communication with the print server.

**Remedy**  
Configure Windows Firewall to unblock communication with the server. (See "Windows Firewall," on p. 7-8)
Appendix

This chapter describes the printer specifications and index.

Specifications ................................................................. 7-2
   Hardware Specifications ........................................... 7-2
   Software Specifications ............................................. 7-3

Printer Dimensions .......................................................... 7-4

Optional Accessories .......................................................... 7-5
   Network Adapter ......................................................... 7-5

NetSpot Device Installer .................................................. 7-7

Windows Firewall ............................................................. 7-8
   Configuring Windows Firewall to unblock communication with client computers ............. 7-9
   Configuring Windows Firewall to block communication with client computers ............... 7-10
   Configuring Windows Firewall to unblock communication with the server ................. 7-12

Index ................................................................. 7-13

Locating the Serial Number ............................................... 7-16
## Hardware Specifications

<table>
<thead>
<tr>
<th>Type</th>
<th>Desktop Page Printer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing method</td>
<td>Electrophoto Method (On-demand fixing)</td>
</tr>
<tr>
<td>Print speed</td>
<td></td>
</tr>
<tr>
<td>Plain Paper (64 to 90 g/m²)</td>
<td>LBP2900 When printing A4 continuously 12 pages/min. * The printing speed drops in steps depending on the paper size, paper type, number of pages printed, and fixing mode settings. (This is a safety feature that prevents damage due to overheating.)</td>
</tr>
<tr>
<td></td>
<td>LBP2900i When printing A4 continuously 11 pages/min. * The printing speed drops in steps depending on the paper size, paper type, number of pages printed, and fixing mode settings. (This is a safety feature that prevents damage due to overheating.)</td>
</tr>
<tr>
<td>Warm-up time</td>
<td>0 seconds (10 seconds or less when the printer is on)</td>
</tr>
<tr>
<td>First print time</td>
<td>9.3 seconds or less (20°C (68°F), A4 size) * Time from when print data is received.</td>
</tr>
<tr>
<td>Paper Sizes</td>
<td></td>
</tr>
<tr>
<td>Multi-Purpose Tray</td>
<td>A4, B5, A5, Legal, Letter, Executive, Envelope C5, Envelope COM10, Envelope DL, Envelope Monarch, Custom Paper Size (width 76.2 to 215.9 mm, height 127.0 to 355.6 mm) Paper capacity: Approx. 150 sheets (64 g/m²)</td>
</tr>
<tr>
<td>Manual Feed Tray</td>
<td>A4, B5, A5, Legal, Letter, Executive, Envelope C5, Envelope COM10, Envelope DL, Envelope Monarch, Index Card, Custom Paper Size (width 76.2 to 215.9 mm, height 127.0 to 355.6 mm) Paper capacity: 1 sheet</td>
</tr>
<tr>
<td>Paper Output</td>
<td>Facedown</td>
</tr>
<tr>
<td>Output capacity</td>
<td>Output tray: Approx. 100 sheets (64 g/m²)</td>
</tr>
</tbody>
</table>
## Software Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing software</td>
<td>CAPT (Canon Advanced Printing Technology)</td>
</tr>
<tr>
<td>Printable area</td>
<td>The area on the page excluding a 4 mm top margin, 6 mm bottom margin, 5 mm left margin and 5 mm right margin (for index card and envelopes, the top, bottom, left and right margins are all 10 mm).</td>
</tr>
</tbody>
</table>
Printer Dimensions

Printer

Front View
Multi-Purpose Tray

Front View
Output Tray

132 250.5 (mm)
369.8 63.9 (mm)
281.1 216.7 (mm)
Optional Accessories

The LBP2900/2900i can be used directly over a network by installing the optional network adapter (AXIS1650).

For details about the AXIS1650, refer to the Axis Communications homepage (http://www.axis.com).

Network Adapter

You can use the optional network adapter by connecting it to the LBP2900/2900i using a USB cable. The network adapter connects to the computers using peer to peer networking. You can also connect to the printer via a print server.
NOTE

- If you are using the network adapter, you should use the "NetSpot Device Installer" utility software to initialize the default settings of the printer connected to the network.
- Refer to the instruction manual provided with the network adapter for details on the network adapter.
- Contact the store where you purchased your LBP2900/2900i for inquiries on purchasing the network adapter.
NetSpot Device Installer

The supplied CD-ROM includes "NetSpot Device Installer", which is a utility that initializes the settings of a printer connected to the network, as well as the printing software (CAPT). The NetSpot Device Installer does not need to be installed on your computer, but is simply used to initialize the network connection settings of the printer.

For detailed information on the NetSpot Device Installer, refer to the users manual included with the network adapter (AXIS 1650).

NOTE

Depending on the CD-ROM supplied, NetSpot Device Installer may not be included. If NetSpot Device Installer is not included on the supplied CD-ROM, you can download it from the Canon website.
Windows Firewall

Windows Firewall is a feature of Windows XP Service Pack 2 and other operating systems that protects your computer by blocking unauthorized access over the network.

If using the printer with an operating system equipped with Windows Firewall, you need to set Windows Firewall to unblock communications.

You need to perform the following procedure on the print server (the computer that is directly connected to the printer) and the clients (the computers that accesses the printer via the network).

<table>
<thead>
<tr>
<th>Setting</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Setting</strong></td>
<td><strong>See</strong></td>
</tr>
<tr>
<td><strong>Print server</strong></td>
<td></td>
</tr>
<tr>
<td>■ Installing the CAPT software from CD-ROM Setup: Click [Yes] on the [Warning] dialog box that is displayed during installation, and follow the instructions to configure Windows Firewall to unblock communication with client computers.</td>
<td>p. 3-31</td>
</tr>
<tr>
<td>■ Installing the CAPT software using the [Add Printer Wizard] or [Windows Explorer]: Use the [CAPT Windows Firewall Utility] to configure Windows Firewall to unblock communication with client computers.</td>
<td>p. 7-9</td>
</tr>
<tr>
<td><strong>Clients</strong></td>
<td></td>
</tr>
<tr>
<td>Configure Windows Firewall to unblock communication with the print server.</td>
<td>p. 7-12</td>
</tr>
</tbody>
</table>

**WARNING**

If you want to copy the [CAPT Windows Firewall Utility] to your hard disk to run it, copy all of the files (CNAB4FW.EXE, CAPTRGFW.DLL, CNAB4FW.INI) from the [WF_UTIL] folder on the supplied "LBP2900/2900i User Software" CD-ROM to your hard disk.
Configuring Windows Firewall to unblock communication with client computers

1 Insert the supplied "LBP2900/2900i User Software" CD-ROM into the CD-ROM drive.
   If CD-ROM Setup appears, click [Exit].

2 Select [My Computer] from the [Start] menu, then right-click on the CD-ROM icon and select [Open] from the popup menu.

3 Double-click [English], then [WF_UTIL], then [CNAB4FW.EXE].
   The [CAPT Windows Firewall Utility] starts.

   IMPORTANT
   You can also start the utility by selecting [Run] from the [Start] menu, then entering "D:\English\WF_UTIL\CNAB4FW.EXE" and clicking [OK]. (In this case the CD-ROM drive is assumed to be assigned to "D:". The actual CD-ROM drive letter may be different depending on the computer you are using.)

4 Click [Unblock].

   NOTE
   You cannot click [Unblock] if the firewall is already configured to unblock communication with client computers.
5 Click [OK].

NOTE

To verify that the Windows Firewall block has been properly cleared, select [Control Panel] from the [Start] menu, then click [Network and Internet Connections] ➞ [Windows Firewall]. Confirm that there is a checkmark next to [Canon LBP2900 RPC Server Process] on the [Exceptions] sheet in the [Windows Firewall] dialog box.

Windows Firewall is now configured to unblock communication with client computers.

Configuring Windows Firewall to block communication with client computers

1 Insert the supplied "LBP2900/2900i User Software" CD-ROM into the CD-ROM drive.

If CD-ROM Setup appears, click [Exit].
2 Select [My Computer] from the [Start] menu, then right-click on the CD-ROM icon and select [Open] from the popup menu.

3 Double-click [English], then [WF_UTIL], then [CNAB4FW.EXE].
   The [CAPT Windows Firewall Utility] starts.

   **IMPORTANT**
   You can also start the utility by selecting [Run] from the [Start] menu, then entering "D:\English\WF_UTIL\CNAB4FW.EXE" and clicking [OK]. (In this case the CD-ROM drive is assumed to be assigned to "D:". The actual CD-ROM drive letter may be different depending on the computer you are using.)

4 Click [Block].

   **NOTE**
   You cannot click [Block] if the firewall is already configured to block communication with client computers.

5 Click [OK].

   Windows Firewall is now configured to block communication with client computers.
Configuring Windows Firewall to unblock communication with the server

1. Select [Control Panel] from the [Start] menu.

2. Click [Network and Internet Connections], then click [Windows Firewall].

3. On the [Exceptions] sheet in the [Windows Firewall] dialog box, place a checkmark next to [File and Printer Sharing], and click the [OK] button.

Windows Firewall is now configured to unblock communication with the server.
Index

A
Add Printer Wizard, 3-66
Administrator Permissions, 3-27, 3-39
[Advanced] Sheet, 4-29
AXIS1650, 7-5

C
Canceling, Pausing and Resuming Printing, 4-17
CAPT (Canon Advanced Printing Technology), 3-4
Cleaning
   Fixing Unit, 5-14
   Printer, 5-19
Client, 3-47, 3-59
[Color Management] Sheet, 4-29
Component Names, 1-4
[Configuration] Sheet, 4-30
Copies, 4-21
Custom Paper Size, 2-44, 4-22, 4-39

D
[Details] Sheet, 4-27
[Device Settings] Sheet, 4-30
Dimensions, 7-4

E
Editing Print Jobs, 4-52
Envelopes, 2-4, 2-6, 2-33

F
Finishing Method, 4-41
[Finishing] Sheet, 4-23
Firewall, 7-8
Fixing Unit, 6-4

G
[General] Sheet, 4-27
Grayscale Settings, 4-46

H
Heavy Paper, 2-3, 2-5, 2-13

I
Important Safety Instructions, xiv
Index Card, 2-4, 2-6, 2-26
Installation
   For Windows 2000, 3-19
   For Windows 98/Me, 3-4
   For Windows XP/Server 2003, 3-31
Installation Problems, 6-27
Installing the CAPT Software, 3-4
Installing the Client, 3-59

L
Label Paper, 2-3, 2-5, 2-13
Loading Paper
   Custom Paper Size, 2-44
   Envelopes, 2-33
Heavy Paper, 2-13
Index Card, 2-26
Label Paper, 2-13
Plain Paper, 2-13
Transparency, 2-13
Local Installation, 3-47

M

Manual Feed Tray, 1-5, 2-19, 2-26, 2-37, 2-50
Manual Scaling, 4-22
Multi-Purpose Tray, 1-5, 2-14, 2-34, 2-44

N

NetSpot Device Installer, 7-7
Network Adapter, 7-5
Network Printer, 3-67

O

Online Help, 4-20
Optional Accessories, 7-5
Output Tray, 1-5
Output Tray Capacities, 2-12
Output Tray Types, 2-11

P

Page Layout, 4-22
Page Order, 4-22
[Page Setup] Sheet, 4-20
Page Size, 4-21
Paper
  Printable Area, 2-5
  Storage, 2-7
Paper Feed Roller, 6-5
Paper Guides, 1-5
Paper Indicator, 1-8
Paper Jams, 6-3
Paper Key, 1-8
Paper Output, 2-11
Paper Problems, 6-25
Paper Size
  Setting, 2-23, 2-42, 2-55
Paper Sizes
  Abbreviations, 2-5
  List, 2-2
Paper Source Capacities, 2-10
[Paper Source] Sheet, 4-24
Paper Source Types, 2-9
Paper Sources, 2-9
Paper Type
  Setting, 2-24
Paper Types
  List, 2-3
Paper You Cannot Use, 2-6
Plug and Play
  Windows 2000, 3-25
  Windows 98/Me, 3-10
  Windows XP/Server 2003, 3-37
[Ports] Sheet, 4-28
Poster Printing, 4-38
Power
  Cord, 1-9
  Power Indicator, 1-16
  Socket, 1-6, 1-10
  Turning Off, 1-16
  Turning On, 1-15
Power Indicator, 1-8
Preview, 4-33
Print Quality, 4-44
Print Quality Problems, 6-22
Print Server, 3-47, 3-48
Printer
  Cleaning, 5-19
  Component Names, 1-4
  Moving, 5-21
  Precautions for Handling, 5-26
  Storage, 5-27
Printer Dimensions, 7-4
Printer Driver
  Installation, 3-4
  Pages, 4-19
  Uninstallation, 3-72
Printer Port, 4-27
Printer Properties, 4-9, 4-15
Printer Status Window
[Cleaning], 4-62
Component Names, 4-57
Displaying, 4-59
Displaying Printer Status When Using a Print Server, 4-63
Options Menu, 4-60
Preferences, 4-60
[Refresh], 4-62
[Resolve Error], 4-62
Printing, 2-13, 2-26, 2-33, 2-44, 4-2
Printing Multiple Pages on One Sheet, 4-34
Printing Orientation, 4-21
Printing Preferences, 4-7
Problems
  Installation, 6-27
  Other, 6-35
  Print Quality, 6-22
  When Nothing Prints, 6-26
[Profile] Sheet, 4-31

Q
[Quality] Sheet, 4-25

R
Rating Label, 1-6
Rear Paper Guide, 1-5
Restoring the Default Settings, 4-54

S
Scaling, 4-36
[Security] Sheet, 4-30
Serial Number, 7-16
Service Call Display, 6-18
Sharing Settings, 3-51, 3-54
[Sharing] Sheet, 4-28
Small Paper Guide, 1-5
Sounds, 4-56
Specifications, 7-2

Storing Printouts, 2-8
System Requirements, 3-3

T
Test Page, 3-44
Toner Cartridge
  Before Replacing, 5-2
  Cleaning, 5-14
  Handling, 5-16
  Replacement, 5-7
  Storage, 5-18
  Toner Cartridge, 5-2
Toner Cartridge Guide, 1-7, 6-16
Top Cover, 1-5
Transfer Roller, 1-7, 6-5
Transparency, 2-3, 2-5, 2-13
Troubleshooting Map, 6-2

U
Uninstallation, 3-72
Usable Paper, 2-2
USB
  Cable, 1-13, 3-5, 3-11, 3-20, 3-26, 3-32, 3-38
  Class Driver, 3-9, 3-15, 3-24, 3-36, 6-30
  Connecting, 1-12
  Connector, 1-6, 1-13, 3-5, 3-11, 3-20, 3-26, 3-32, 3-38
  Cover, 1-6
  Port, 1-12

V
Ventilation Slots, 1-6
Viewing Printer Settings, 4-54

W
Windows Firewall, 7-8
Working with Profiles, 4-47
Locating the Serial Number

The printer serial number consists of four-alphabetic characters and a six-digit number.

**IMPORTANT**

The labels are required for a service engineer to check the serial number for service or maintenance. Do not peel off the serial numbers.

■ Printer Base

■ Packing Box